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Basic Knowledge

Basic Knowledge

This section provides a general overview how to operate the telephone.
Here, you will find a description of the symbols and text shown on the unit
display as well as the keys on the device In addition, you get an overview of
the contents of the individual menus.

Topics

— Device Overview (page 18)

— Introduction to the Operation (page 31)

— Configuration Software COMfortel Set (page 42)
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Basic Knowledge
Device Overview

Device Overview

The device has a display and a variety of keys (some with LED). The device
may be operated using key control.

Functions of Keys and LEDs

The following figure shows the keys and LEDs of the basic unit.

A B C

D

E

Q F

P G
o)

N H

M |

L J

K
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A Microphone key with LED
Switches the microphone off (mute) and on again.

B Keypad
Enables number dialling as well as entering digits and letters.

C Telephone book key
Opens the telephone book.

D Casing LED
The LED provides information about the telephone's operating
mode and missed calls depending on the key definition.

E Function keys with LED
They are programmable.
The LED indicates the status depending on the key definition.

F Message key with LED
Opens the caller list, the answering machine list and the list of
voice memos.
The LED signals existing (new) entries.

G Redial key
Opens the redial list.
Scrolls through the redial list.
When the receiver is off the hook, dials the previously dialled
phone number.

H Query key
Initiates a query call.

| Delete key
Deletes the last character before the cursor.
Holding the key (2 seconds) deletes the entire entry.

J Back key
Switches back in the previous menu or the previous level.

K Directional pad
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Device Overview

Enables key-based navigation and operation.
The arrow keys are used to select the desired elements.
The OK key is then used to activate the desired element.

L Menu key
Opens the main menu.
M Home key
Closes the opened menu. Incorrectly exited settings are not
saved.
N Hook key
Initiates/Ends headset calls or calls in hands-free calling mode.
O Minus key
Decreases the volume of the ringer, the receiver or
loudspeaker depending on the operating mode.
P Plus key
Increases the volume of the ringer, the receiver or loudspeaker
depending on the operating mode.
Q Loudspeaker key with LED
Switches loudspeaker listening on during a call.
Holding the key (2 seconds) switches hands-free calling on.
Casing LED

The casing LED provides information about the telephone's operating mode
and missed calls.

If you find the LED signalling disruptive or bothersome, it can be switched
off. A variety of settings are possible:

20
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LED Signalling during Configuration: Show Alerting, Calls and Entries
in the Caller List

¢ Red: The telephone is on a call.

* Red (blinking): New entries in the caller list are present.

* Red (flashing) + alternating pauses): The telephone is being called.

* Off: The telephone is neither being called, nor is it on a call, and there
are no new messages.

LED Signalling during Configuration: Show Alerting and Calls
¢ Red: The telephone is on a call.
* Red (flashing) + alternating pauses): The telephone is being called.

e Off: The telephone is neither being called, nor is it on a call.

LED Signalling during Configuration: Always off
» Off: LED is switched off.

Notes:

In the telephone you can adjust the casing LED in the menu settings >
signalling > casing LED.

In COMfortel Set you can adjust the casing LED in the menu Settings/
functions > Signalling/ringer > Casing LED.

Symbols

The symbols and the functions they execute are listed at the end according
to the states and menus in which they can occur.
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Symbols in the Idle State

Symbol Function

- Pressing the OK key switches unsuccessful power dialling off
early.

oy Pressing the OK key enables calling line identity restriction
(CLIR) for the next call(s).

Active setting: Number is presented.

" Pressing the OK key disables calling line identity restriction
(CLIR) for the next call(s).

Active setting: Number is suppressed.

& Pressing the OK key switches an enabled telephone lock (PIN
entry is required)

— Pressing the OK key enables pickup.
E Pressing the OK key enables the call list.

Symbols in Dial Preparation Menu

Symbol Function
< Pressing the arrow key left moves the cursor to the left.
¥ Pressing the arrow key right moves the cursor to the right.

& Pressing the delete key deletes the last character before the
cursor.

Holding the delete key (2 seconds) deletes the entire entry.

DK Pressing the OK key accepts the entry and dials.
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Menu Symbols for Callers and Calls

Symbol Function

5

B

The communication partner is currently inactive/waiting
(splitting).
The communication partner is currently active (splitting).

The communication partner is currently inactive. (conference
call).

The communication partner is currently active. (conference call).

Pressing the OK key selects the function shown in the lower line
of the display.

Pressing the arrow key down scrolls to the next function in the
lower line of the display.

Pressing the arrow key up scrolls to the previous function in the
lower line of the display.

Loudspeaker listening is enabled.
Hands-free calling is enabled.

The microphone is switched off (mute).
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Menu Navigation Symbols

Symbol
o

Function

Pressing the back key switches back in the previous menu or
the previous level.

Pressing the arrow key down scrolls down to the next entry or to
the next function.

Holding the arrow key allows quicker scrolling.

Pressing the arrow key up scrolls up to the previous entry or the
previous Function.

Holding the arrow key allows quicker scrolling.

Pressing the OK key selects an entry or a function for further
editing.

Symbols for Selection

Symbol
o

] 4

Function

Pressing the OK key selects and accepts the function indicated
in clear text behind the symbol. The function is currently not
enabled.

Pressing the OK key selects and accepts the function indicated
in plain text behind the symbol. The function is currently
enabled.

Pressing the arrow key left or right selects the currently empty
check box.

Pressing the arrow key left or right clears the currently selected
check box.

Pressing the OK key accepts the changes.
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Symbols in Telephone Number and Text Entry Menus

Symbol Function
£ Pressing the arrow key left moves the cursor to the left.
¥ Pressing the arrow key right moves the cursor to the right.

& Pressing the delete key deletes the last character before the
cursor.

Holding the delete key (2 seconds) deletes the entire entry.
Ok Pressing the OK key accepts the entry.

R-z  Pressing the arrow key up or down Switches the setting for
upper and lower case spelling during letter entry.

Active setting: If the next letter is upper case, then the letters are
automatically displayed in lower case.

R-2 Pressing the arrow key up or down Switches the setting for
upper and lower case spelling during letter entry.

Active setting: All letters are upper case.

a-z  Pressing the arrow key up or down switches the setting for
upper and lower case spelling during letter entry.

Active setting: All letters are lower case.
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Symbols in Define Keys Menu

Svmbol Function

&=

Hi

tl

Pressing the arrow key right or links initiates entry/change of
the phone number.

Pressing the arrow key right or links initiates entry/change of
the name.

Pressing the arrow key right or links initiates entry/change of
the call macro.

Pressing the arrow key right or links switches between various
options.

Pressing the arrow key right or links initiates entry/change of
the phone number to be forwarded.

Selecting l_l save and pressing the OK key accepts the
changes.

Confirmation symbols

Symbol Function

26

] 4

Pressing the OK key confirms the displayed question with "Yes".

Or: Confirms the display of a change and switches into the idle
state.

Pressing the OK key confirms the displayed question with "No".
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Symbols in Telephone Book Menu

Symbol Function

] 4

P s B

Hi

Usr

Pressing the OK key accepts the phone number for subsequent
dialling into the dial preparation or opens an expanded display of
the contact shown.

Pressing the OK key accepts the business number for subse-
quent dialling into the dial preparation.

Pressing the OK key accepts the private number for subsequent
dialling into the dial preparation.

Pressing the OK key accepts the mobile number for subsequent
dialling into the dial preparation.

Pressing the OK key shows the comment.

Pressing the OK key accepts the call macro for subsequent
dialling into the dial preparation.

Pressing the OK key accepts the fax number (only contacts of
the PBX) for subsequent dialling into the dial preparation.

Pressing the OK key accepts the user defined number (only
contacts of the PBX) for subsequent dialling into the dial prepa-
ration.
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Menu Symbols in Telephone Number Lists

Pressing the delete key deletes individual entries from the

Pressing and holding the delete key (2 seconds) deletes the

Pressing the OK key accepts the phone number for subsequent

Symbol Function
b
caller, call and redial lists.
entire caller, call and redial lists.
2
dialling into the dial preparation.
Symbols in Restriction Menu
Symbol Function

[=1=1=]

L Lale]

L1 In}

Pressing the OK key initiates a change to the restriction for the
next function.

There is currently no restriction.

Pressing the OK key initiates a change to the restriction for the
next function.

The function is currently restricted for guests.

Pressing the OK key initiates a change to the restriction for the
next function.

The function is currently restricted for guests and users.

Pressing the OK key initiates a change to the restriction for the
next function.

The function is currently restricted for guests, users and subad-
ministrators.
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Symbols for Voice Mail/lFax Box

Symbol Function

Be B2 E2

Pressing the OK key switches the voice mailbox on.
Pressing the OK key switches the voice mailbox off.
Pressing the OK key switches the voice mailbox off.

Display: There are new messages in the message list of the
voice mailbox.

Pressing the arrow key down scrolls to next (older) recording.

During playback: Skips the recording currently being played
back.

Pressing the arrow key up scrolls to the previous (more recent)
recording.

During playback: Repeats the previous recording or the one
currently being played back.

Voice mailbox only:

Pressing the arrow key right starts the playback of the
recording.

Pressing the arrow key right again Interrupts the playback of the
recording.

Fax box only:
Pressing the arrow key right sends a telefax again.

Pressing the arrow key left goes back to the start of the
recording.

Pressing the delete key deletes the recording.

Holding the delete key (2 seconds) deletes all messages from
the message list.

The recording is a new message or voice memo.
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Symbol Function

30

£

] 4

]

The recording is an old message or voice memo or one that has
already been played back.

Voice mailbox only:

Pressing the OK key accepts the phone number for subsequent
dialling into the dial preparation.

Fax box only:
Pressing the OK key sends a telefax as e-mail.
Pressing the OK key opens a current announcement for editing.

Display in the list of announcements: The announcement is
switched on for the call acceptance of the voice mailbox.

Pressing the OK key switches the announcement for the call
acceptance of the voice mailbox off.

Display in the list of announcements:The announcement is
switched off for the call acceptance of the voice mailbox.

Pressing the OK key switches the announcement for the call
acceptance of the voice mailbox on.
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Introduction to the Operation

The telephone has a graphic display; each line has 16 characters (when
entering phone numbers, the font size is changed to display more
characters).

On both sides, there is room for up to four symbols which show the available
functions.

The appearance of the display depends on the state of the telephone.

Only those functions are offered that are usable in the respective state. If not
all of the information can be displayed due to lack of space, only the most
important functions are displayed.

In the Idle State

The following information is shown on the display while the telephone is in
the idle state:

A B C D
[ N

Bl Wed G1.Jan

l[information]

[internal number]

A Calendar week

B Weekday
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C Time
D Date

E Information and status information
— Current settings that affect telephoning, for example call
allowance account empty
— Current settings that limit reachability, for example, do-not-
disturb, call forwarding immediately, follow-me, ringer off
— No connection to the PBX
— Missed caller and scheduled calls
— Power dialling enabled

F The internal number of the subscriber in the PBX

Your system telephone shows possible functions in the idle state on the
display. Press the arrow keys to scroll through the various functions.
Press the OK key to initiate the function currently displayed.

Main Menu

Press the Menu key to open the main menu with various menus.

MET U Cg)
» functions
P information N
P define keys v
" settin ==

Press the arrow keys to scroll through the selection list.
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Press the OK key to go to the next menu.

In the functions menu, you can activate/deactivate or execute
functions in the PBX and the telephone (for example, do-not-disturb or
the telephone lock).

The information menu is only used to display information (for example,
versions, accumulated charges and the status of certain important
functions/settings). No changes can be made here.

In the define keys menu, you can assign functions on the PBX and the
telephone to programmable function keys (for example, do-not-disturb
or speed dialling).

In the settings menu, you can configure the telephone.

In the answer.machine menu, you can configure and operate the local
answering machine.

In the diagnosis menu, you can perfom diagnosic functions.

In the voice mailbox menu, you can configure and operate a voice
mailbox in the PBX.

In the submenus, you can scroll through the selection lists pressing the
arrow keys just as you can in the main menu. Press the OK key to again

go to the next menu.

To go back to the preceding menu level, press the back key. To go back into

the idle state, press the home key. In addition, the telephone automatically
switches back into the idle state if no keys are pressed within a period of 30
seconds.

Important:

Some functions are not offered until the function is available on the PBX
and has been configured, and if necessary, an authority level has been
granted for the use of this function.
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Introduction to the Operation

The functions and settings available in the menus functions, define
keys, settings and voice mailbox can be restricted by the adminis-
trator to prevent unauthorised use. The release and display of these
disabled functions in to the selection list requires entering the corre-
sponding PIN after selecting additional. The release remains intact
during the settings that now follow. The release is revoked if no keys are
pressed within a time period of 60 seconds. You can actively disable the
release by selecting log out in the menu settings > blocking >
additional.

Function Keys

You can use COMfortel Set and the telephone to assign functions to freely
programmable function keys.

Using COMfortel Set to Assign Function Keys

1.

34

Open the page Function keys > Assign function keys.

The position of the selected function keys is marked in red at the top of
the display.

Right-click the function key you want to assign and select the corre-
sponding function.

The current assignment of the key will be displayed.

Make the settings if necessary and available.
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Notes:

The options switch off, switch on and switch over are available. The
options switch off, switch on and switch over determine, if applicable, if
the function, depending on the status, can be switched (switch over) with
the key, or if it is only possible to switch on or off.

When printing the lettering label, the key name will be adopted for the
lettering field.

If there are additional settings, they will be listed in the description of the
function key.

Using the Telephone to Assign Function Keys

1.

2.

Press the Menu key and open the define keys menu.
Press the function key that you want to define.

Select the required function.
The key settings are shown, if available.
Make the settings if necessary. Press the upper or lower arrow key to

switch over between the different options or to open a menu for entering
a phone number or a text.

Notes:

The options switch off, switch on and switch over are available. The
options switch off, switch on and switch over determine, if applicable, if
the function, depending on the status, can be switched (switch over) with
the key, or if it is only possible to switch on or off.
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If there are additional settings, they will be listed in the description of the
function key.

5. Tap on B save and press the OK key.

Menu Options in Telephone Number and Text Entry Menus

To enter a phone number or text, the telephone opens one of the following
menus.

[function] o [function] N
name A-z number

= TEI::‘I A "’IJ_':-T ENElE .

bert_ ok ASoHEI-Br08 ok

Using the keypad dial, you can enter the digits, characters and letters you
need. In the text entry menu, press the digit keys want a more times until
the desired character appears. The assignment is listed in the table at the
end.

Press the arrow keys to switch between uppercase and lowercase letters.
The symbol indicates the current settings.

Press the arrow keys to move the cursor to the left and right. Press the
delete key to delete the last character before the cursor.

Press the OK key to accept the entry.
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Key |Assignment for uppercase Assignment for lowercase
letters letters

1 1-/@ + 1-/1@ +

2 ABC2AEAC abc2aaxaaaacg

3 DEF3E def3ééeéé

4 GHI4 ghid4iiii

5 JKL5 jkl15

6 MNOG6O®O mno6oefioood

7 PQRST7R pqrs71DB

8 TUVs8U tuv8uuuady

9 WXYZ9 wxyz9

0 Space 0., :” “? ¢ Vi _ Space 0., : " “? ¢ Vi _

POl Er e A =) (O [1<=> e A=)

# #% & §£S$ € #% &§L£S €

Menu Options During Incoming Calls

The following information is displayed during an incoming call:

Ch @1 Wed 81.Jan B3:8

)
|

E

r'—[': al 1-5-1"]

|

e

L call target| ————B
[function] Ok=—C
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A

B

Caller, call waiting or call type (for special calls, for example, alarm calls,
wake-up calls)

Note:

If the phone number is entered in the telephone book of your system
telephone or in the central telephone book (short-code numbers) on the
PBX, as soon as the telephone detects the phone number, it will show
the associated name in the display instead of the phone number. The
prerequisite for displaying the phone number is that the exchange line
subscriber has not suppressed the display of his phone number or that
he has approved transmission of the phone number.

If the phone number is not available, "anonymous" is displayed.

If the name of the caller is not in the telephone book, a search for the
name can be performed using the online name search function on a
server in the Internet (see Advanced Information for the PBX). If the
phone number is transmitted for an incoming call, the PBX automatically
looks for the corresponding entry. When an entry is found, it is shown on
the display of the system telephone.

Internal call destination (subscriber or group)/external call destination

C Possible Functions for Incoming Calls

Your system telephone shows possible functions during an incoming call in
the lower line of the display. Press the arrow keys to scroll through the
various functions. Press the OK key to initiate the function currently
displayed.

38
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Menu Options during Outgoing Calls

The following information is displayed during an outgoing call:

Chl @1 Wed 81.Jan B2:84

#—[zcr or group]———A
l—'[uzall tar-:;et]—-‘*——a
[advice] — C

[function] ok0—D

A Subscriber or group (if "logged in as outgoing" in a group)

B call destination

Note:

If the phone number dialled has been assigned a name in the telephone
book of the system telephone, this will be displayed as soon as the
telephone detects the phone number. The phone number is simply
overwritten by the name.

If less than nine digits have been entered, they are displayed in a larger
font to facilitate legibility (during dialling/during the call). If the phone
number dialled has been assigned a name in the telephone book of the
system telephone, and this name comprises fewer than nine characters,
this name is also displayed in a larger font.

C Note (for example, busy, do-not-disturb, no exchange line authori-
sation)

D Possible Functions for Outgoing Calls
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Your system telephone shows possible functions during an outgoing call in
the lower line of the display. Press the arrow keys to scroll through the
various functions. Press the OK key to initiate the function currently
displayed.

Menu Options during Calls

The following information is displayed during a call:

Ch a1 lWed 81.Jan B2:08
[-: all partn er] — A

A
D——Icharges][duration]~——B

[function] ok=—cC

Communication partner
Duration in minutes:seconds (as of 59:59, in hours:minutes)

Possible Functions during a Call

o o ®w »r

Costs (for outgoing external calls)

Your system telephone shows possible functions during calls in the lower
line of the display. Press the arrow keys to scroll through the various
functions. Press the OK key to initiate the function currently displayed.

Menu Options during Query Calls

The following information is displayed during a query call:
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cChl 81 Wed @1.Jdan 62: 388
[call type]l——A
¥/[call partner 1]—a——B
b [call partner 2]l——1+C
[function] ok—=—D

Call type (splitting or conference call)
Communication partner 1

Communication partner 2

o o © »

Possible Functions for Query Calls

Press the OK key to select the active communication partner (function
switch curr. num). During splitting, the other communication partner who
had been active up until now is put on hold in the backgrounds listening to
hold music. During a conference call, the status of the call does not change
at first. Pressing the OK key during a conference call only activates the
communication partner (function switch curr. num) in relation to carrying
out the next function.

Your system telephone shows possible functions during query calls in the
lower line of the display. Press the arrow keys to scroll through the various
functions. Press the OK key to initiate the function currently displayed.
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Configuration Software COMfortel Set

The configuration software COMfortel Set lets you easily set up the system
telephone on your computer.

Installing COMfortel Set

Requirements:

* Installation file (comfortelset.exe) saved on a data storage medium (PC)

Note: You can find the required installation file on the Internet
(Auerswald: www.auerswald.de/service, FONtevo:
support.fontevo.com).

1. Start installation file (comftelset.exe) on the PC.

The software installation is started.

2. Follow the instructions displayed on the screen.
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Starting COMfortel Set

In order to start COMfortel Set, double-click the program shortcut on your
computer desktop.

Alternatively, proceed as described below.

1. Click Start > Auerswald > COMfortel Set x.xx.xx.

You are asked whether you want to open a configuration file or a
telephone configuration.

2. If you want to instead create a new configuration, click Cancel.

Exiting COMfortel Set

1. Open the menu File > Quit.

If you have opened a configuration, you are asked whether you want to
save the configuration beforehand.

2. If you have already saved the configuration, click No.

Configuring the Language of the Configuration Software
1. Open the menu Options > Language....

2. Select the desired language from the list field and click on OK.
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3.

Quit COMfortel Set and restart it.

Configuring Interface Used

Requirements:

44

Existing PC connection to a PC interface on the PBX or a connected
system telephone

Open the menu Options > Interface....

In the Interface list field, select one of the following options:

IP network: Enable the existing connection via the Ethernet interface
on the PBX for carrying out the transmission.

USB: Enable the existing connection via the USB interface on the PBX
for carrying out the transmission. (No other action is required.)

Note: For an indirect PC connection to the system telephone to be
configured, the selection IP network is significantly faster than via other
selections.

In the IP address entry field, enter the IP address of the PBX (only
applies to the option IP network). Possible entries:

IP address with areas from 0 to 255 (example: 192.168.0.240)

in the IP port (default: 7002) entry field, enter the configuration port for
system telephones on the PBX (only applies to the option IP network).
Possible entries:
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1 to 65535

5. Click OK.

Opening Configuration

You can open the configuration of the telephone or a configuration file saved
on the hard disk.

Note: Since the administrator may block parts of the system telephone,
you may not be able to make all settings on a telephone if you are logged
in as a user or a sub-administrator (see chapter Settings > Protection
from Unauthorised Access.

Opening the Telephone Configuration

Requirements:

* An existing PC connection configured correctly in COMfortel Settoa PC
interface on the PBX or another connected system telephone

* MSN configured for the system telephone
¢ Knowledge of the required PIN

1. Click Open or open the menu File > Open.

2. Click Telephone.
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The Connection routes dialogue with the devices connected via the
interface configured above opens.

3. Select the telephone whose configuration you want to open and click
OK.

The PIN entry dialogue opens.

Note: For operation on the PBXs COMpact 3000 analogue/ISDN/VolIP,
COMpact 5010 VolP, COMpact 5020 VolP, COMpact 4000, COMpact
5000/R, COMpact 5200/R, COMpact 5500R and COMmander 6000/R/
RX access to the telephone is only possible via the 6-digit PIN assigned
in the PBX. You need to first select which PIN you want to enter based
on the authority level: the Admin PIN, one of the subadmin PINs or the
user PIN that belongs to the telephone.

4. Enter the associated PIN and click OK.

The configuration is loaded from the telephone. This may take a while.

Opening a Configuration File

Requirements:

¢ Configuration file (*.cf2) saved on the hard disk

In order to open one of the files previously saved with this program, open
the menu File > Related files and select the file.

Alternatively, proceed as described below.

1. Click Open or open the menu File > Open.
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2. Click File.

A dialogue for selecting the file with the configuration data opens.
3. Switch to the directory where the file is located and select the file.

4. Click Open (this text is dependent on the operating system used).

Creating a New Configuration

If you want to, for example, to create a configuration for a telephone before
the required connection to the PBX or to the PC has been established, you
can open an empty configuration as described in the following.

1. Click New or open the menu File > New.
2. Inthe upper list field, select the telephone typeCOMfortel 1200.

3. Inthe lower list field, select the PBX type and click on OK.
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Saving Configuration

The configuration can be saved on one or more telephone(s) or as a file on
the PC.

Saving Configuration on one or more Telephones

Requirements:

3.

48

An existing PC connection configured correctly in COMfortel Settoa PC
interface on the PBX or another connected system telephone

MSN configured for the system telephone(s)

For simultaneous saving on several telephones: COMfortel Set as of
version 3.12.0

Click Save or open the menu File > Save.

Click Telephone.

The Connection routes dialogue with the devices connected via the
interface configured above opens.

Note: To select several end devices, hold the Ctrl or Shift key during
selection. Double-clicking the folder symbol displays additional devices.

Select the telephone on which you want to save the configuration and
click OK.

The PIN entry dialogue opens.
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Note: For operation on the PBXs COMpact 3000 analogue/ISDN/VoIP,
COMpact 5010 VolP, COMpact 5020 VolP, COMpact 4000, COMpact
5000/R, COMpact 5200/R, COMpact 5500R and COMmander 6000/R/
RX access to the telephone is only possible via the 6-digit PIN assigned
in the PBX. You need to first select which PIN you want to enter based
on the authority level: the Admin PIN, one of the subadmin PINs or the
user PIN that belongs to the telephone.

4. Enter the associated PIN and click OK.

5. Please select the sections of the configuration to be transmitted
(settings/functions, function keys, telephone book and/or answering
machine).

The configuration has sucessfully been transmitted to all selected
devices.

Saving Configuration File on PC

Important:

Note the following legal notes before creating the data backup.

The data backup contains the following legally protected components:
- Configuration of the telephone

- Names of internal subscribers

- Address book of the telephone
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- Connection data sets containing destination, source and time infor-
mation of a telecommunication connection

Before the data backup is created, all telephone users must be informed
that these data will be forwarded and must also be informed about who
will use the received data. It is absolutely necessary to store the data
safely and in accordance with the legal requirements.

If you want to make the data backup available to your specialised dealer
or to the manufacturer for error analysis, you must make sure that the
legal requirements are fulfilled.

1. Click Save or open the menu File > Save.

Hinweis: To export the configuration for another telephone, open
COMfortel Set and select the menu Service > Export....

2. Click File.

3. Accept the legal notes and confirm with OK.

A file location dialogue opens.
4. Select the directory in which you want to save the file.

5. Enter a name for the *.cf2 file and click Save (this text is dependent on
the operating system used).

Close the Configuration

1. Open the menu File > Close.
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You will be asked whether you want to save the configuration
beforehand.

2. If you have already saved the configuration, click No.

Using Print Functions

1. Click Print or open the menu File > Printing.
2. Select or clear the Assign function keys check box.

3. Select or clear the Telephone book check box and click on OK.

If you have selected the Assign function keys check box, a print
preview dialogue for viewing the lettering labels opens.

Note: If you have cleared the Assign function keys check box, proceed
to the penultimate step.

4. If you want to configure the colour settings for the lettering labels, click
Colour selection.

a) Click Change next to one of the following options:

Colour of the text for level 1: Enables changes to the colour
of the text at level 1.

Colour of the text for level 2: Enables changes to the colour
of the text at level 2.
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Background colour: Enables changes to the background
colour.

b) Change the colour as you like, and click OK.

c) Click OK.

5. In the list field under the Colour selection button, select one of the
following options:
centre justified text: Enables centre justified text.

left-aligned: Enables left-aligned text.

Note: In the factory settings, the text is centre justified.

6. Click OK.

The print dialogue for the operating system opens.

7. Click OK (this text is dependent on the operating system used).

Operating Instructions for COMfortel Set

The operating instructions for COMfortel Set contain the following topics:
* Navigation
¢ Entry and Selection Fields

e Creating and Deleting Table Entries
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Navigating in COMfortel Set

After opening a configuration, the current areas are displayed in a directory
tree. To show the organisation of the topics clearly, most topics have been
consolidated under a main topic.

Click the desired main topic or the plus sign next to the main topic to open
the underlying list of topics. Then click the topic you want.

The topic you have chosen opens on the page to the right.

You can select sub-topics directly on some pages by clicking tabs.

Entry and Selection Fields

Note: The menu bar is not required for processing the page. All entries
and changes are made using the mouse or keyboard directly in the
pages.

An empty field normally indicates that a name or number
is to be entered. Click within the field in question and use
the keyboard to enter a number or desired text.

In order to change an existing entry, double-click the entry
to be overwritten. The field then becomes blue and can
either be overwritten directly or the existing text can be
deleted using the delete/backspace key.
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deutsch ;I For functions that offer more than just being switched on

and off but only have a few options to choose from, the
field already contains a default setting. To change this,
click the opened list field to make a selection.
 Ifthis is a single field with an arrow pointing downward,
open the list field by clicking the field.
* Ifthere are multiple fields in a table column (without an
arrow pointing downward), open the list field by
double-clicking the field.

For some functions, a small circular button (radio button)
is located next to the setting options listed. The selected
setting is indicated by a black dot inside the circle. The
setting is changed by clicking an empty circle. Selecting
this setting option simultaneously deactivates any other
previous selection.

A square check box indicates a switching function. An
empty check box means "off" and "no"; a check mark on
the other hand, means "on" and "yes". The switchover is
done by simply clicking the box.

Creating and Deleting List Entries

To create new list entries, fill the empty entry fields in the lower table row.
Additional rows are then added to the list.

To delete an entry, an entire line can be deleted. To do this, double-click in
an field in the line to be deleted. The field is then selected as indicated by
the colour change. Right-clicking opens a menu. Click Delete. You can
delete multiple fields by dragging your mouse with the left mouse button
pressed to select multiple fields.
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Help

Via the help you can access the entire Advanced Information for the system
telephone.

Opening the Help Topic-Relevantly

Below the directory tree, there is a window containing left to several help
topics. The offered help topics refer to the currently open configuration

page.

¢ Click the link to go to the desired help topic.

The corresponding help page opens. You can navigate back and
forward within the selected topic by clicking the | * and | = | symbols.

* Press the key F1.

The help opens and displays the description of the configuration
software.

Note: You can always access the entire Advanced Information for the
system telephone via the navigation.

Navigating via the Table of Contents

Click the Table of Contents (this text is dependent on the operating system
used) tab to go to the table of contents (the tab is highlighted in yellow)
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The table of contents will be displayed on the left-hand side of the help
window as a directory tree.

By clicking one of the topics in the table of contents, you can open the
belonging help page on the right-hand side of the help window.

The @ symbol indicates that further topics are available under a specific
topic. Click this symbol to expand the subordinate topics. You can close the
subordinate topics again by clicking the L1 symbol.

Note:

The table of contents area and the selected page are separated by a
vertical line or a scroll bar. To enlarge the area (this automatically makes
the other areas smaller), click and hold the cursor above the separator
line and slide the line to the location you want. This setting only applies
to the help window currently open.

The currently opened topic is highlighted in the table of contents

(for example, with a grey background). Scrolling through the table of
contents may cause this highlighting to disappear. By clicking the | ©
symbol in the help window, you can display the currently open help page

in the table of contents again.

Navigating via Expanding Texts

Some help texts contain expanding texts that flip down. Expanding text is
indicated by a blue font and is underlined. In addition, the g symbol is shown
behind the expanding text.

You can expand the text by clicking the g symbol or the line. You can close
the text again by clicking the  symbol or the line.
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Navigating via the Index

Click the Index (this text is dependent on the operating system used) tab to
go to the index (the tab is highlighted in yellow)

The index will be displayed on the left-hand side of the help window.

By clicking a letter of the alphabet, you can go directly to the keywords under
this letter.

By clicking the desired keyword, you can open the belonging help page on
the right-hand side of the help window.

Note:

The index area and the selected page are separated by a vertical line or
a scroll bar. To enlarge the area (this automatically makes the other
areas smaller), click and hold the cursor above the separator line and
slide the line to the location you want. This setting only applies to the
help window currently open.

By clicking the | ¥ symbol in the help window, you can display the

currently open help page in the table of contents.

Navigating by Browsing

By clicking the | * | symbol, you can go to the next page of the instruction.

By clicking the | * | symbol, you can go to the previous page of the
instruction.
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Navigating via the Back Button

Clicking the <¢== symbol takes you back to the previously opened help
page.

Note: You may have to scroll back to the beginning of the currently
displayed help page in order to access the symbol.

Navigating via Links

Some help texts contain left to subordinate topics or to more detailed infor-
mation. A link is indicated by a blue font and is underlined.

By clicking a link, you can go to the belonging help page.

Navigating via Breadcrumbs

The path you took to get to the currently open page is displayed above the
help text. The path consists of the titles of the topics superordinate to the
current topic. The superordinate topics are shown in a blue font and the
current topic is shown in a grey font.

By clicking a superordinate topic, you can go to the belonging help page.

Searching in the Help

You can search the entire help for one or several terms.

1. Click the Search tab (this text is dependent on the operating system
used).
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The tab is activated (it is highlighted in yellow). The left area of the help
window contains a input field for the keywords and a button for starting

the search.

2. Enter the desired term in the entry fields.

Note:

The character * can be used as a placeholder (wildcard) in a search. A
search using teleph* results, e.g., in hits for telephone, telephoning and
telephone book.

If you enter several terms, the Help texts which contain all these
keywords will be displayed irrespective of the sequence and context.

3. Click Search (this text is dependent on the operating system used).

Help is searched; this may take some time. Afterwards, the topics that
contain the search term are listed. The sequence within this list is deter-
mined by the number of hits and the importance of the search term
found. The higher the value displayed under in %, the more important
the help text is to the search.

4. Click the desired Title within the list.

The corresponding help page will be opened on the right-hand side of
the help window.

Note:

Some browsers also highlight the identified search terms within the help
text.
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The search area and the selected page are separated by a vertical line
or a scroll bar. To enlarge the area (this automatically makes the other
areas smaller), click and hold the cursor above the separator line and
slide the line to the location you want. This setting only applies to the
help window currently open.

By clicking the |© symbol in the help window, you can display the

currently open help page in the table of contents.

Printing from within the Help

You can print the currently displayed help page using the print function of the
help.

1.

Note:

If the displayed help page includes expanding texts, expand all texts you
want to print.

If you want to print only part of the displayed help page, mark the corre-
sponding text by clicking and drawing with the left mouse key. After-
wards, select Selection as print area in the print dialogue box.

In the help window, click the £ | symbol.

The print dialogue box opens.

2. Select the desired printer.

3. Click Print.
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Symbols in the Help Window

4_. Clicking the symbol takes you back to the previously opened

help page.

> Clicking the symbol takes you to the next page of the
instruction.

< Clicking the symbol takes you back to the previous page of the
instruction.

A Clicking the symbol displays the opened help page in the table
of contents.

> Display: The expanding text is currently closed.
You can open the text by clicking the symbol or the line.

kL

Display: The expanding text is currently shown.

You can hide the text by clicking the symbol or the line.
Clicking the symbol opens the print dialogue box.
Display: Subordinate topics are closed.

Clicking the symbol opens the subordinate topics.

Display: Subordinate topics are shown.

E #®@&

Clicking the symbol closes the subordinate topics.

Display: The topic does not have any subordinate topics.

Clicking the symbol opens the corresponding help page.
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This section describes the various types of telephoning that your telephone
provides.

Topics

— Incoming Calls (page 63)

— Call Waiting Calls (page 68)

— Outgoing Calls (page 73)

— Calls (page 83)

— Query Calls (page 86)

— Transferring (page 91)

— Conference Calls (page 97)

— Hands-free Calling (page 101)
— Loudspeaker Listening (page 104)
— Headset Calls (page 106)
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Incoming Calls

The following call types apply to incoming calls:

e Alarm calls

e External calls

e Internal calls

e Group calling (a call directed to a group)
¢ InterCom calls

* External callback calls

* Internal callback calls

e Door calls

e Call deblocker calls (calls enabled despite do-not-disturb)
* Wake-up calls

e Other calls

Options During an Incoming Call

During an incoming call, the following actions are possible:
Accept an Incoming Call

If you receive a call and would like to talk with the caller, you can accept the
incoming call as you would normally by picking up the receiver.
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Reject an Incoming Call

If you receive a call but you do not want to talk to the caller, you can reject
the incoming call. The caller receives a busy signal — in as far as no other
telephones are called (for example, in a group call).

Forward an Incoming Call

If you receive a call but you do not want to talk to the caller yourself, you can
the forward the incoming call to any internal or external destination number.

Put an Incoming Call on Hold

If you receive a call but would like to postpone accepting the call for a while,
you can put the incoming call on hold. The caller hears the hold music.

Switch off the Ringer

If you receive a call but you want to postpone accepting the call for a while,
you can switch off the ringer. The call will continue to try to get through and
you can accept it at any time.

Accepting Incoming Calls

When you receive a call, proceed as described in the following.

* Pick up the receiver or press the hook key.

You are connected with the caller.
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Note:

If you are not present once in a while or cannot accept the call for any
other reason, the phone number of the caller is saved in the caller list (in
as far as the phone number is available and the call type is to be entered
in the caller list).

Calls made from the telephone or from the PBX (wake-up calls, alarm
calls, door calls, scheduled calls) are displayed in plain text and, if
necessary, can be confirmed with OK (alarm calls are confirmed after
first picking up the receiver).

Rejecting Incoming Calls

When you receive a call, proceed as described in the following.

1. Select reject and confirm with OK.

The caller receives a busy signal —in as far as no other telephones are
called (for example, in a group call).
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Hold incoming calls

When you receive a call, proceed as described in the following.

1. Select hold incoming and confirm with OK.

You will hear the internal dial tone. The caller on hold hears the hold
music.

2. Select back and confirm with OK.

You are connected with the caller.

Forwarding Incoming Calls

Important: Only available for operation on the PBXs COMpact 3000
analogue/ISDN/VolP, COMpact 5010 VolP, COMpact 5020 VolIP,
COMpact 4000, COMpact 5000/R, COMpact 5200/R, COMpact 5500R
and COMmander 6000/R/RX.

When you receive a call, proceed as described in the following.

¢ Enterthe destination number (or press a speed dialling key) and confirm
with OK.
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Important: If you must prefix e.g. an exchange line access number

when entering/selecting a phone number, depends on the exchange line
request (automatic, direct exchange line telephone, internal telephone)
that was configured in the PBX (see Advanced Information of the PBX).

Note: If you want to select the phone number in the telephone book, first
you have to select call deflection and confirm with OK

The subscriber is called.
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Call Waiting Calls

During a call, you are made aware of another call (external or internal
subscriber, alarm or someone at the door) by a call waiting signal (tone).

Options During a Call Waiting Call

During a call waiting call, the following actions are possible:

Reject a Call Waiting Call

If you receive another call while you are already on a call and you do not
want to speak with the second caller, or you do not want to interrupt the first
call, you can reject the call waiting call. The caller receives a busy signal —
in as far as no other telephones are being called (for example, in a group
call).

Accept the Call Waiting Call

If you receive another call while you are already on a call and you want to
speak to the second caller, or you want to end the current call, you can
accept the call waiting call. After accepting, you are connected with the other
caller. Your previous communication partner hears the hold music.

Forward Call Waiting

If you receive another call while you are already on a call and personally do
not want to talk with the second caller, or you do not want to interrupt the
current call, you can forward the call waiting call to any internal or external
destination number.
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Switch off the Call Waiting Tone

If you receive another call while you are already on a call but you want to
postpone accepting the second call for a while, you can switch off the call
waiting tone. The second call will continue to try to get through and you can
accept it at any time.

Rejecting Call Waiting Calls

Requirements:

* Call waiting enabled

When call waiting signals an incoming call, proceed as described in the
following.
1. Select reject and confirm with OK.

The caller receives a busy signal — in as far as no other telephones are
being called (for example, in a group call).

Accepting Call Waiting

Requirements:

* Call waiting enabled
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When call waiting signals an incoming call, proceed as described in the
following.

1. Select accept and confirm with OK.

You are connected with the caller. Your previous communication partner
hears the hold music.

Note: If you first hang up the receiver to end the current call, your
telephone then rings and you can accept the incoming call as you would
normally.

Forwarding Call Waiting

Important: Only available for operation on the PBXs COMpact 3000
analogue/ISDN/VolP, COMpact 5010 VolP, COMpact 5020 VolIP,
COMpact 4000, COMpact 5000/R, COMpact 5200/R, COMpact 5500R
and COMmander 6000/R/RX.

Requirements:

* Call waiting enabled

When call waiting signals an incoming call, proceed as described in the
following.

1. Select call deflection and confirm with OK.
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2. Enter the destination number or press the telephone book key to
select the phone number you want in the telephone book.

Important: If you must prefix e.g. an exchange line access number

when entering/selecting a phone number, depends on the exchange line
request (automatic, direct exchange line telephone, internal telephone)
that was configured in the PBX (see Advanced Information of the PBX).

3. Confirm with OK.

The subscriber is called.

Note: If the destination number is saved on the programmable function
key (speed dialling key), you can forward the call by simply pressing this
key and then confirming with OK. The previous function selection via the
display is no longer applicable.

Switching off Call Waiting Tone

Requirements:

¢ Call waiting enabled

When call waiting signals an incoming call, proceed as described in the
following.

1. Select call wait.off and confirm with OK.
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The second call will continue to try to get through and you can accept it
at any time.
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Outgoing Calls

Outgoing calls are calls that you have initiated yourself.

Options for Outgoing Calls

An outgoing call can be initiated in two ways:

Dialling the Telephone Number

If you have already picked up the receiver before dialling, the phone number
that you have entered is dialled immediately.

Dialling the Telephone Number with Dial Preparation

Dial preparation — first dialling and then picking up the receiver — makes it
possible to check the phone number entered and, if necessary, to correct it
before the connection is established.

Dialling the Telephone Number on Direct Exchange Line Access

If your system telephone has been configured as a direct exchange access
point using the configuration manager on the PBX, you will hear an external
dial a tone directly after picking up the receiver.

Initiating External Calls with Number Presentation Suppression

If you prefer that the person you are calling does not see your phone
number, you can use calling line identity restriction.
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Additional Options

Initiating Targeted Exchange Line Access (A — Function Key
Exchange Line) (page 163)

Initiating a Targeted VolP Access Point (page 172)

Dialling from Telephone Book (page 112)

Dialling from Redial List (page 127)

Dialling from Call List (page 132)

Dialling from Caller List (page 137)

Picking up Receiver and Dialling Telephone Number

1.

Pick up the receiver or press the hook key.

2. Dial a phone number.

74

Important: If you must prefix e.g. an exchange line access number

when entering/selecting a phone number, depends on the exchange line
request (automatic, direct exchange line telephone, internal telephone)
that was configured in the PBX (see Advanced Information of the PBX).

Note: As soon as you have dialled the first digit, you can cancel dialling
with OK and starting again.

Once you have finished dialling the phone number, the subscriber is

cal

led.
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Dialling Telephone Number with Dial Preparation

1. Dial a phone number.

Important: If you must prefix e.g. an exchange line access number

when entering/selecting a phone number, depends on the exchange line
request (automatic, direct exchange line telephone, internal telephone)
that was configured in the PBX (see Advanced Information of the PBX).

Note: You can make corrections, if necessary, while entering the phone
number.

2. Pick up the receiver or press the hook key.

Note: If you want to exit the menu without dialling the phone number
entered, press the home key.

Initiating External Calls with Calling Line Identity Restriction

Requirements:

* CLIR2 feature (case-to-case calling line identity restriction) activated at
the network provider

* Number presentation activated in the PBX

1. Select & and press the OK key. Alternatively, press a function key
configured for switching on the calling line identity restriction.
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The display will show darkened eyeglasses &" as an indication that
calling line identity restriction has been enabled.

2. Dial a phone number.

3. Pick up the receiver or press the hook key.

The subscriber is called.

Calling line identity restriction remains enabled until it is switched out.

Dialling Telephone Number on Direct Exchange Line Access

Requirements:

* Telephone is configured as a direct exchange access point via the PBX

In order to dial an external number on a direct exchange line access point,
pick up the receiver and enter the external number without the exchange
line access number.

In order to carry out other call types (for example, internal or short-code),
proceed as described in the following.

1. Pick up the receiver or press the hook key.

You will hear the external dial tone.

2. Select internal and confirm with OK.

You will hear the internal dial tone.

3. Dial an internal number.
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Once you have finished dialling the phone number, the subscriber is
called.

Note: If you want to use dial preparation or, for example, make an entry
in the telephone book or configure a speed dialling key, you must press
the star key twice beforehand for internal and short-code calls.

Options for Unsuccessful Calls

The following options are available for unsuccessful call:

Initiating Callback on Busy

If you cannot get through to a busy subscriber despite repeated attempts,
you can initiate a callback on busy. The PBX supports the service attribute
"Automatic callback on busy (CCBS)". This service attribute is required for
an external call.

If you have initiated a callback, as soon as the other subscriber has hung up
the receiver to end the call, the PBX (for an internal call) or public exchange
(for an external call) calls you. If you then pick up the receiver, the other
subscriber is called. If the other subscriber picks up the receiver, the
connection for the call is established. This deletes the callback procedure in
the PBX/public exchange.
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Initiating Callback on No Response

If the person being called does not pick up the receiver, you can configure
callback on no response in order to reach this person without having to call
him repeatedly. The function can be used for both internal and external calls.
The service attribute "Callback on no response (CCNR)" is supported by the
PBX. This service attribute is required for external calls.

If you have initiated a callback, as soon as the other subscriber has hung up
the receiver to end the call, the PBX or public exchange calls you. If you then
pick up the receiver, the other subscriber is called. If the other subscriber
picks up the receiver, the connection for the call is established. This deletes
the callback procedure in the PBX/public exchange.

Initiating Priority Call for Do-not-disturb

If, for example, a person must absolutely be reached in an emergency
despite the do-not-disturb function, the do-not-disturb function can be
circumvented by a priority call from an internal telephone.

Additional Options
— Performing Power Dialling (page 217)

Initiating Callback on Busy

Requirements:

e For external calls: The given technical requirements for a callback on
busy (for instance, not all network providers provide callback on a Point-
to-Point connection)
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If the connection you are calling is busy, proceed as described in the

following.
1. Select recall.
2. Press the OK key.

If callback is configured, you receive the message recall activated.

Hang up the receiver.

Note: When operated on the PBXs COMpact 3000 analogue/ISDN/
VolP, COMpact 5010 VolP, COMpact 5020 VolP, COMpact 4000,
COMpact 5000/R, COMpact 5200/R, COMpact 5500R and COMmander
6000/R/RX: If you want to delete the callback, press the delete key in
the redial list.

As soon as the connection is no longer busy, you are called by the public
exchange/PBX for a period of 20 seconds.

Pick up the receiver to the carry out the callback.

Note:

If you do not pick up the receiver within the 20 seconds during which the
public exchange/PBX calls you, the callback instruction is deleted.

If you want to cancel the callback, select reject and press the OK key.

If you pick up the receiver, the subscriber is called.
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Note:

You also have the option of letting the public exchange call you as soon
as one of the B-channels on the previously called ISDN connection is
available. If the person for which you have set up callback is telephoning
on the other B-channel, callback will remain unsuccessful.

A callback is tried up to 45 minutes by the public exchange/PBX. If the
called person did not finish his call until then, the callback will be deleted
automatically.

Initiating Callback on No Response

Requirements:

Ifn
in t

1.

2.

80

For external calls: The given technical requirements for a callback on no
response (for instance, not all network providers provide callback on a
Point-to-Point connection)

For external calls: the service attribute CCNR (Callback on no
response) enabled with the network provider

0 one answers on the connection you are calling, proceed as described
he following.

Select recall and confirm with OK.

If callback is configured, you receive the message recall activated.

Hang up the receiver.
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Note: When operated on the PBXs COMpact 3000 analogue/ISDN/
VolP, COMpact 5010 VolP, COMpact 5020 VolP, COMpact 4000,
COMpact 5000/R, COMpact 5200/R, COMpact 5500R and COMmander
6000/R/RX: If you want to delete the callback, press the delete key in
the redial list.

As soon as the connection is used, the public exchange/PBX or for
external callback calls you for period of 20 seconds.

3. Pick up the receiver to the carry out the callback.

Note:

If you do not pick up the receiver within the 20 seconds during which the
public exchange/PBX calls you, the callback instruction is deleted.

If you want to cancel the callback, select reject and confirm with OK.

A callback on an external subscriber is tried up to 45 minutes by the
public exchange. If the called person did not finish his call until then, the
callback will be deleted automatically.

If you pick up the receiver, the subscriber is called.

Initiating Priority Call for Do-not-disturb

Requirements:

* Type of do-not-disturb configured to All (PBX) on the telephone of the
person being called
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If the internal telephone you are trying to call is busy because it is set to do-
not-disturb, proceed as described in the following.

¢ When operated on the PBXs COMpact 3000 analogue/ISDN/VolP,
COMpact 5010 VolP, COMpact 5020 VolP, COMpact 4000, COMpact
5000/R, COMpact 5200/R, COMpact 5500R and COMmander 6000/R/
RX: Wait ten seconds.

¢ When operated on the PBXs COMpact 2206 USB and COMpact 4410

USB: Select priority call and tap on .

The subscriber is now called.
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Calls

The system telephone allows you to make internal and external calls on the
PBX. Internal calls are toll-free.

Options during a Call

During a call, the following actions are possible:

Sending DTMF Signals

During an existing connection, you can use the keypad to send DTMF
signals (tones used in DTMF dialling) to operate an answering machine
remotely, for example. The digits dialled are shown on the display.

Mute

If you want to discuss something with another person in the room without
your communication partner on the telephone being able to hear, you can
temporarily mute the call.

Additional Options

— Initiating a Query Call (page 86)

— Transferring (page 91)

— Performing Pickup during Call (page 214)
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Sending DTMF Signals

During a call, proceed as described in the following.

e Enter the digits and characters. Possible entries:
Digits and the characters * and #

The digits and characters dialled are shown on the display and you hear
the corresponding tones.

Muting a Call

During a call, proceed as described in the following.

1. Press the microphone key.

The microphone on the receiver, device or headset is switched off. The
[E symbolis shown in the display and the LED of the microphone key
lights up in red.

2. If you want to switch the microphone on again, press the microphone
key again.
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Ending a Call

After your communication partner ends the call, your telephone goes into
the idle state. If you wait to hang up the receiver for a few seconds, you will
hear the busy signal on the receiver and then also on the loudspeaker of the
base system, in case the receiver was accidentally hung up incorrectly.

During a call, proceed as described in the following.

* Hang up the receiver.

Note: If you want to end a current call and then immediately make a new
call, press the hook key instead and start dialling the next number within
30 seconds.
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Query Calls

During a query call, you are talking with one subscriber while your previous
communication partner is on hold on the PBX in the background listening to
hold music.

A query call is initiated either by calling a query call subscriber, using pickup
during a call, or by accepting a call signalled by call waiting.

Initiating a Query Call

During a call, proceed as described in the following.

1. Select queryl/transfer and confirm with OK.

You will hear the internal dial tone. Your current communication partner
is kept on hold on the PBX and is listening to hold music.

2. Enter a phone number.

Important: If you must prefix e.g. an exchange line access number
when entering/selecting a phone number, depends on the exchange line
request (automatic, direct exchange line telephone, internal telephone)
that was configured in the PBX (see Advanced Information of the PBX).
Exception: With the PBXs COMpact 2206 USB and COMpact 4410 USB
in any case external numbers are entered with a leading exchange line
access number.

The subscriber is called.
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Note:

If the phone number of the query call subscriber is located in the
telephone book of the telephone, you can initiate a query call by dialling
directly out of the telephone book (also without previously selecting
query/transfer).

If the phone number of the query call subscriber is saved on one of the
programmable function keys (speed dialling key), you can initiate the
query call by simply pressing this key (without previously selecting
query/transfer).

Ending a Query Call

If you make a query call and the number is busy but there is no response,
proceed as described in the following.

Important: Do not hang up the receiver as this will disconnect any calls
waiting or will initiate an unannounced transfer of the call to another
internal telephone.

1. Select back and confirm with OK.

Note: If you want to try this with another phone number, select dial
again. You can then dial a new phone number, without having to explain
to the person waiting on the other line that you are trying again.
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You are now reconnected with the person waiting on the other line.

Options during a Query Call

The following actions are possible during a query call:

Splitting

You can use at the splitting function to switch between your two communi-
cation partners.

Ending One of the Two Calls

When you end a query call and would like to continue talking with one of the
communication partners, you can specifically end the call with the other
communication partner separately. Of course, one of your communication
partners can simply hang up so that you can continue talking with the other
communication partner alone.

Connecting Both Communication Partners

If you want to let your communication partners speak with each other, you
can connect them together.

Additional Options

— Initiating Conference Calls (page 97)
— Sending DTMF Signals (page 84)

— Muting a Call (page 84)
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Toggling Between Conversations

Requirements:

¢ Initiated query call

During a query call, proceed as described in the following.

¢ Select switch curr. num and confirm with OK to change the communi-
cation partner.

The active communication partner is indicated by M , and the waiting
communication partner by F .

You continue to conduct a query call. The other communication partner
is now active.

Ending One of the Two Calls

Requirements:

e Initiated query call

If one of your two communication partners hangs up the receiver, you
remain connected with the other one.

Or, during a query call, proceed as described in the following.

1. Change the communication partner, if necessary: Select switch curr.
num and confirm with OK.
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The active communication partner is indicated by M , and the waiting
communication partner by F .
2. Select curr. call canc. and confirm with OK.

You then conduct an individual call with the communication partner who
had previously been on hold.

Connecting Both Communication Partners

Requirements:

e Initiated query call

* To connect two external communication partners, the following is
required: Authorisation in the PBX for Transfer of external calls to
external

To connect both communication partners, hang up the receiver during a
query call.

Alternatively, proceed as described below.

1. Select conn. both calls.

2. Confirm with OK.

Both communication partners are connected with each other.

90 COMfortel 1200 - Firmware V2.2 - COMfortel Set V3.16 - Advanced Information V07 02/2019



Telephoning
Transferring

Transferring

A communication partner can be transferred or connected to an internal or
external subscriber.

Options for Transferring a Call

During an existing call, the following options are available for transferring a
call:

Transfer with Announcement

In order to transfer a call, first initiate a query call, announce the call and
then connect both communication partners.

Transfer without Announcement

If you want to transfer an external communication partner to another internal
subscriber, you do not have to wait until the subscriber being called via the
query call accepts the call; you can hang up the receiver while this call is
being made. The internal subscriber will continue to be called.

Placing the Communication Partner in the Waiting Loop

If the internal subscriber to which you want to transfer an communication
partner is busy, you can place the communication partner in the waiting loop
of this subscriber.

Note: If, for example, you have accepted a call signalled by call waiting
and have therefore established a query call, you can place this call in the
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waiting loop in the same manner. The communication partner to be
transferred must be the active communication partner.

Calling a Third Internal Subscriber and Transferring to an Active
Communication Partner

Assuming that you have gained an additional communication partner from
a call, for example, from accepting a call signalled by call waiting, and this
second communication partner would like to now be transferred to
somebody else. You can now initiate a third call that connects the second
and third communication partners with each other and then continue
telephoning with your first communication partner.

Transfer with Announcement

Requirements:

¢ Initiated query call

¢ To connect two external communication partners, the following is
required: Authorisation in the PBX for Transfer of external calls to
external

During a query call, proceed as described in the following.

1. Select conn. both calls and confirm with OK.

Both communication partners are connected with each other.
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Transfer without Announcement

Requirements:

Internal transfer destination

During a call, proceed as described in the following.

1.

Select queryl/transfer and confirm with OK.

You will hear the internal dial tone. Your current communication partner
is kept on hold on the PBX and is listening to hold music.

Dial an internal number.

The subscriber is called.

Hang up the receiver.
The internal subscriber will continue to be called. If the subscriber
accepts the call, the connection is established.

If the subscriber being called does not accept the call, the call is trans-
ferred back to your telephone 60 seconds later (your telephone rings).

Note: In order to carry out an open query call, dial the internal basis
phone number + park position and hang up, instead of dialling the
internal number (see Advanced Information of the PBX). To make this
operation more convenient, you can save the internal basis phone
number + park position on one or more programmable function keys
(speed dialling key). The LEDs for the speed dialling keys then indicate
whether a park position is available or busy.
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Placing Communication Partner in Waiting Loop

Requirements:

* Internal transfer destination

Note: With some PBXs the function is limited to external callers (see
Advanced Information of the PBX).

If the internal telephone to which you are trying to transfer a call is busy,
proceed as described in the following.

1. Select waiting loop and confirm with OK.

2. Hang up the receiver.

The communication partner continues to listen to hold music.

As soon as the internal subscriber hangs up the receiver, this commu-
nication partner is called. Once he accepts the call, he is connected with
the subscriber in the waiting loop.

Note:

If the internal subscriber does not answer the call within 60 seconds, or
the line remains busy during the three minute waiting time, the call will
be transferred back to you.

If you pick up the receiver, you will be reconnected with the communi-
cation partner. You can then place him in the waiting loop again. If you
do not pick up the call within 60 seconds, the connection is disconnected
completely (for example, if your line was busy even for a short time).
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Calling a Third Subscriber and Transferring to an Active
Communication Partner

Requirements:

Initiated query call

During a query call, proceed as described in the following.

1.

Change the communication partner, if necessary: Select switch curr.
num and confirm with OK.

The active communication partner is indicated by & , and the waiting
communication partner by F .

Select transf. act. call and confirm with OK

Dial the phone number of the subscriber to be called.

As soon as to the person being called picks up the receiver, conduct a
third call.

Important: If you must prefix e.g. an exchange line access number
when entering/selecting a phone number, depends on the exchange line
request (automatic, direct exchange line telephone, internal telephone)
that was configured in the PBX (see Advanced Information of the PBX).
Exception: With the PBXs COMpact 2206 USB and COMpact 4410 USB
in any case external numbers are entered with a leading exchange line
access number.

4. Select transfer and confirm with OK.

Both previously active communication partners are connected.
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Then return to conducting an individual call with your first communi-
cation partner.
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Conference Calls

During a conference call, you are talking with two subscribers simultane-
ously.

Initiating Conference Calls

Requirements:

* A query call you initiated yourself

During a query call, proceed as described in the following.

1. Select conference and confirm with OK.

You are making a conference call.

Options during a Conference Call

The following actions are possible during a conference call:

Initiating Splitting

When you end a conference call and would like to talk to each of the
conference call partners separately one after the other, you can specifically
put one of the conference call partners on hold in the background.
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Ending a Call with a Conference Call Partner

When you end a conference call and would like to continue talking with one
of the conference call partners, you can specifically end the call with the
other conference call partner separately. Of course, one of your conference
call partners can simply hang up so that you can continue talking with the
other conference call partner alone.

Connecting both Conference Call Partners

If you want to leave a conference call that you initiated yourself and your
conference call partners would like to continue talking with each other, you
can connect both parties.

Ending a Conference Call Completely

If you initiated the conference call yourself, you can end the conference call
completely.

Additional Options
— Sending DTMF Signals (page 84)
— Muting a Call (page 84)

Initiating Toggling Between Conversations during a Conference
Call

Requirements:

* A conference call that you initiated yourself
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During a conference call, proceed as described in the following.

1.

Change the conference partner, if necessary: Select switch curr. num
and press the OK key.

The conference partner, with whom you want to talk, is indicated by &,
and the other conference partner by I+ .
Select splitting and confirm with OK.

You are making a query call with the selected conference partner.

Ending a Call with a Conference Call Partner

Requirements:

A conference call that you initiated yourself

During a conference call, proceed as described in the following.

1.

Change the conference partner, if necessary: Select switch curr. num
and confirm with OK.

The conference partner, with whom you want to end the call, is indicated
by R/, and the other conference partner by I+ .
Select terminate and confirm with OK.

You are conducting an one-on-one call with the other conference call
partner.

COMfortel 1200 - Firmware V2.2 - COMfortel Set V3.16 - Advanced Information V07 02/2019 99



Telephoning
Conference Calls

Connecting both Conference Call Partners

Requirements:

* A conference call that you initiated yourself

¢ To connect two external communication partners, the following is
required: Authorisation in the PBX for Transfer of external calls to
external

During a conference call, proceed as described in the following.

1. Select conn. both calls and confirm with OK.

Both conference call partners are connected with each other.

Ending Conference Call Completely

Requirements:

* A conference call that you initiated yourself

During a conference call, proceed as described in the following.

* Hang up the receiver.

The conference call is disconnected completely.
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Hands-free Calling

During hands-free calling, the loudspeaker and microphone on the device
are switched on. This option allows you to talk on the telephone even if you
have no hands free. In addition, other people in the room can participate in
the call.

Initiating Call in Hands-free Calling Mode

* When your phone rings, press the hook key or the loudspeaker key to
initiate the call.

You are conducting a call in hands-free calling mode. The following
symbol is shown in the display:

¢ If you want to call someone, dial the phone number and press the hook
key or the loudspeaker key to initiate the call.

You are conducting a call in hands-free calling mode. The following
symbol is shown in the display: ]

Note: During headset operation, you can only use the loudspeaker key
since the hook key is being used to initiate and end the headset call.
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Ending up Call in Hands-free Calling Mode

During hands-free calling mode, proceed as described in the following.

* Press the hook key.

Switching on Hands-free Calling During a Call

During a normal call or a call in loudspeaker listening mode using the
receiver, proceed as described in the following.

* Press and hold the loudspeaker key for approx. 2 seconds. You can
then hang up the receiver.

You are conducting a call in hands-free calling mode. The following
symbol is shown in the display:

Switching off Hands-free Calling and Returning to Normal
Calling

During hands-free calling mode, proceed as described in the following.

¢ Pick up the receiver.

You are conducting a normal call.
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* If you have already picked up the receiver or a headset is connected,
press the loudspeaker key.

You are conducting a normal call or a headset call.
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Loudspeaker Listening

During loudspeaker listening, the receiver loudspeaker as well as the
loudspeaker in the device are switched on. This allows other people in the
room to listen in on the call. The call is continued using the receiver micro-
phone (no hands-free calling).

Switching on Loudspeaker Listening during a Call

During a normal call using the receiver, proceed as described in the
following.

* Press the loudspeaker key.

You are conducting a call in loudspeaker listening mode. The following
symbol is shown in the display: ]

Switching off Loudspeaker Listening and Returning to Normal
Calling
During loudspeaker listening mode, proceed as described in the following.

* Press the loudspeaker key.

You are conducting a normal call.
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Ending a Call in Loudspeaker Listening Mode

During loudspeaker listening mode, proceed as described in the following.

* Hang up the receiver.
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Headset Calls

A headset enables you to participate in calls when you have no hands free.
This is a very useful feature, especially in certain professional areas
(for example, in a call centre).

Initiating Headset Calls

Requirements:

* Headset operation enabled

* When your telephone rings, press the hook key to initiate the call.

You are making a headset call.

* If you want to call someone, dial the phone number and press the hook
key to initiate the call.

You are making a headset call.

Ending a Call in Headset Operation

Requirements:

* Headset operation enabled
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During a headset call or other call in headset operation, proceed as
described in the following.

* Press the hook key.
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Telephone Book and Lists

This section describes the telephone book and the current caller and calls
lists in the telephone.

Topics

— Telephone Book (page 109)
— Redial List (page 125)

— Call List (page 130)

— Caller List (page 135)
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Telephone Book

The telephone book is used for storing useful or frequently dialled phone
numbers along with the associated names. If a phone number that is
entered in the telephone book is transmitted during a call, the assigned
name is displayed instead of the phone number is displayed.

In the telephone book, entries (phone numbers, call macros and comments)
can be stored. Up to four entries can be assigned to a name (contact).

In addition, internal numbers (subscriber, groups, door, emergency call) as
well as contacts/short-code numbers on the PBX are displayed. If one of
these entries does not have a name, the system telephone generates a
name for the telephone book (for example, int. TN45, KW-A 05306...). The
entries cannot be changed in the telephone book of the system telephone;
they can only be changed using the configuration manager of the PBX. All
of the contacts are displayed in alphabetical order.

Opening the Telephone Book

Proceed as follows:

¢ Using the telephone

1. Press the telephone book key.

2. Scroll to the desired contact.
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3.

Note:

In order to find the desired contact more quickly, you can enter the first
letter into the keypad.

If there is no contact for the letter entered (display "no hits") or the
contact in question is not present, you can delete the letters entered by
pressing the delete key and enter another letter.

If there are multiple contacts for the beginning letter entered, you can
enter additional letters to narrow the selection further.

The following information about the contact is shown on the display:

P hone book ‘g

[ name ]

[number] —

w >

Name (contact)

Phone number (for multiple entries for this contact, the phone number
last dialled or entered)

Select one of the following options:

¥ Pressing the back key switches back in the previous menu.

Dk Pressing the OK key accepts the phone number for subsequent

dialling into the dial preparation or opens an expanded display of the
contact shown.

Note: If the displayed contact is an internal subscriber or a contact/short-
dial number of the PBX, the expanded display is not available: These
internal PBX contacts have only one number. Exception: If used for
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operation on the PBXs COMpact 4000, COMpact 5000/R, COMpact
5200/R, COMpact 5500R and COMmander 6000/R/RX (with Firmware
6.0A or later) contacts of the PBX may have up to four numbers. These
may be displayed and selected in the expanded display.

If you have opened the extended display, the following information
about the contact in the display is shown:

P hone book ‘s

[name] A

C—+ & lnumber] — B
} [number] v
[number] Ok

A Name (contact)
B Existing entry

Type of entry: business number ( & ), private number ( s ), mobile
number (=% ), fax number ( ¥a: , only contacts of the PBX), user defined
number ( Usr , only contacts of the PBX), call macro ( Ml )

4. Select one of the following options:
> Pressing the back key switches back into the list view.

& Pressing the OK key accepts the business number into the dial
preparation.

Pressing the OK key accepts the private number into the dial prepa-
ration.

"% Pressing the OK key accepts the mobile number into the dial prepa-
ration.

Fax  Pressing the OK key accepts the fax number (only contacts of the
PBX) into the dial preparation.
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Usr  Pressing the OK key accepts the user defined number (only contacts
of the PBX) into the dial preparation.
HI  Pressing the OK key accepts the call macro into the dial preparation.

#» Pressing the OK key shows the comment.

5. If you want to leave the menu, press the home key.

Dialling from Telephone Book

Proceed as follows:

* Using the telephone

1. Press the telephone book key.

2. Scrollto the desired contact or enter the first letter of the desired contact
into the keypad.
The default number is displayed. If there are multiple entries for a

contact, this will be the phone number last dialled or entered.

3. If you want to dial a different number than the default number
associated with the contact, press the OK key to open the expanded
display. Then scroll to the desired phone number.

4. Pick up the receiver or press the hook key.

Note: The phone number now dialled becomes the default number at
the end of the call.
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Configuring a Contact

The telephone book provides space for 1600 entries (phone numbers,
macros and comments). Up to four entries can be assigned to a name
(contact).

Proceed as follows:

¢ Using COMfortel Set

1. Open the page Telephone book and click the New tab.
2. Enter the name of the contact in the Name entry field.

3. If you want to be signaled by a specific ringtone when a contact calls,
select the ringtone in question in the Ringtone list field.
4. In the Kind list field, select one of the following options:

business: Defines the phone number to be entered as a business
number.

mobile (business): Defines the phone number to be entered as a busi-
ness mobile number.

private: Defines the phone number to be entered as a private number.

mobile (private): Defines the phone number to be entered as a private
mobile number.

fax: Defines the phone number to be entered as a fax number.

user-specified: Defines the phone number to be entered as a user-
defined number.

5. Inthe Type list field, select one of the following options:
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internally: Defines the phone number to be entered as an internal
number.

externally: Defines the phone number to be entered as an external
number.

6. Inthe Telephone no entry field, enter the phone number.

7. Click Take over.

Note: If you want to discard your entries of the new contact and create
a another contact instead, click New. All entries of the correspronding
contact which have not been saved yet are discarded.

Editing a Contact
A contact that has already been configured, can be edited later.

Proceed as follows:

¢ Using COMfortel Set

1. Open the page Telephone book and click the Edit tab.

2. Click one of the following options to navigate to the contact that you
want to edit.
Start of the list: Jumps to the first contact in the telephone book.

Previous contact: Jumps to the previous contact in the telephone
book.
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Next contact: Jumps to the next contact in the telephone book.

End of the list: Jumps to the last contact in the telephone book.

Note:

Alternatively, you can double-click a phone number for the contact to be
edited directly on the page Telephone book (Telephone book tab).
After this, the menu for editing the contacting question opens automati-
cally.

Only contacts configured on the telephone can be edited or deleted. The
internal numbers as well as the telephone book/short-code numbers on
the PBX can only be changed using the configuration manager on the
PBX.

3. If you want to be signaled by a specific ringtone when a contact calls,
select the ringtone in question in the Ringtone list field.
4. In the Kind list field, select one of the following options:

business: Defines the phone number to be entered as a business
number.

mobile (business): Defines the phone number to be entered as a busi-
ness mobile number.

private: Defines the phone number to be entered as a private number.

mobile (private): Defines the phone number to be entered as a private
mobile number.

call macro: Allows a macro to be entered.
comment: Allows a comment to be entered.

fax: Defines the phone number to be entered as a fax number.
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user-specified: Defines the phone number to be entered as a user-
defined number.
5. Inthe Type list field, select one of the following options:

internally: Defines the phone number to be entered as an internal
number.

externally: Defines the phone number to be entered as an external
number.

6. Inthe Telephone no entry field, enter the phone number.

Deleting a Contact

Proceed as follows:

¢ Using COMfortel Set

1. Open the page Telephone book and click the Telephone book tab.
2. Click the line with the contact to be deleted.

3. Right-click the line with the contact to be deleted and click Delete rows.
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Entering Comments for a Contact

The comment function is used for entering more detailed information about
a contact, for example, the reachability or the name of the contact partner
for a company.

Proceed as follows:

¢ Using COMfortel Set

1. Open a contact for editing or create a new contact.
2. Inthe Kind list field, select the Comment option.

3. Enter the comment in the Phone number entry field.

Configuring a Call Macro

A call macro can contain numbers as well as certain control characters. This
enables you, for example, to query an answering machine.

Proceed as follows:

¢ Using COMfortel Set

1. Open a contact for editing or create a new contact.
2. Inthe Kind list field, select the macro option.

3. Enter the call macro in the Phone number entry field. Possible entries:
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Up to 40 digits

Digits and the characters * and #

The following commands:
- Waiting time/pause time of 1 second
=  Waiting time/pause time of 2 seconds
<  Waiting time/pause time of 4 seconds
W  Wait for a connection

H Replace/pick up receiver

Accepting Telephone Numbers into Other Menus

Before entering a phone number in a menu (for example, when configuring
a speed dialling key, a scheduled call with dial preparation or call forwarding
for subscribers), you can select the desired phone numbers in the telephone
book. If you have already entered any codes, the phone number from this
telephone book entry is added at the end.

Proceed as follows:

e Using the telephone

After opening a menu for entering phone numbers, proceed as described in
the following.

1. Press the telephone book key.

2. Scroll to the desired contact or enter the first letter of the desired contact
into the keypad.
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The default number is displayed. If there are multiple entries for a
contact, this will be the phone number last dialled or entered.

3. Confirm with OK to accept the phone number in the menu for the phone
number entry.

4. Confirm again with OK.

Note: The name is also accepted — if it is needed in the menu for the
function in question.

Importing the Telephone Book

This function enables you to import a telephone book that had previously
been exported out of another system telephone into the telephone book on
an identical model. Only the names and phone numbers of contacts are
imported. Existing comments and call macros are not imported.

Proceed as follows:

¢ Using COMfortel Set

Requirements:

* Atextfile (*csv) saved on the hard drive, data arranged in rows and
separated (semicolons, comma, tabs or your own character)

1. Open the page Telephone book and click the Import/export tab.
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2.

Click Import.

A dialogue for selecting the separator character opens.

Select the separator to be used to separate the entries into individual
columns in the file to be imported and click OK.

A dialogue for selecting the columns to be imported opens.

Switch in the directory where the file is located. Select the file to be
imported.

Arrange how the individual pieces of data should be distributed across
the existing table columns.

In the lower list field, select one of the following options:

unsynchronised: All previous entries remain unchanged. The data for
the file to be imported is appended to the telephone book unverified.

Synchronise after -Name: If the telephone book already contains a
name that also occurs in the file to be imported, this data set is not
imported. New names are appended to the telephone book along with
the corresponding data (max. four phone numbers).

Synchronise after -Phone number/Text x: If the selected column in

the telephone book (Phone number/Text x) already contains an entry

that also occurs in the assigned area of the file be imported, this data

set is not imported. For new phone numbers, a new contact is created
in the telephone book with the corresponding name.

Click OK.
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Displayed Telephone Number Range for Telephone Book

If you want to prevent too many entries from being displayed in the
telephone book, you can restrict the display of the various phone number
ranges. The following areas can be selected:

* Emergency numbers (emergency numbers configured in the PBX)

e internal numbers (internal numbers configured in the PBX)

* PBX telephone book (telephone book entries/short-code numbers
configured in the PBX)

¢ Local telephone book (telephone book entries you have configured in
the telephone yourself)

* Voice mailbox (the voice mailbox assigned to the telephone)

Proceed as follows:

* Using COMfortel Set (page Settings/functions > Lists under
Telephone book)

¢ Using the telephone (menu settings > lists > phone book)

Importing Outlook Contacts

This function enables Outlook data (2002, 2003, XP, 2007, 2010, 2013) to
be imported.

Proceed as follows:

¢ Using COMfortel Set
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Requirements:

Contacts created in Outlook (2002, 2003, XP, 2007, 2010, 2013)

Open the page Telephone book and click the Import/export tab.
Click Import Outlook contacts.
In the Country code (0049) entry field, enter your own country code.

In the Replace the country code at the beginning of the number by
entry field, enter the code that should replace your own country code
during import.

Under Outlook folders to be imported, click Select. Select the folder
to be imported and click Open.

In the Name allocation in the telephone book list field, select one of
the following options:

Last name, first name: The first and last names saved in Outlook are
accepted into COMfortel Set in a last name, first name format.

Last name first name: The first and last names saved in Outlook are
accepted into COMfortel Set in a last name first name format.

First name last name: The first and last names saved in Outlook are
accepted into COMfortel Set in a first name last name format.
Under Outlook categories to be imported, select or clear the check

box for the Outlook categories to be imported.

If you want to select the check boxes for all the Outlook categories at
once, under Category selection, click all.

If you want to clear the check boxes for all the Outlook categories at
once, under Category selection, click none.
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Click Import.

Assign which data should be imported and how the individual pieces of
data should be distributed across the existing table columns.

In the lower list field, select one of the following options:

unsynchronised: All previous entries remain unchanged. The data for
the contacts to be imported is appended to the telephone book unveri-
fied.

Synchronise according to -Last name, first name: If the telephone
book already contains a name that also occurs in the contacts to be
imported, this data set is not imported. New names are appended to the
telephone book along with the corresponding data (max. four phone
numbers).

Synchronise after -Phone number/text: If the selected column in the
telephone book (x. Phone number/text) already contains an entry that
also occurs in the assigned area of the contacts be imported, this data
set is not imported. For new phone numbers, a new contact is created
in the telephone book with the corresponding name.

Click OK.

Exporting the Telephone Book

You can export the telephone book as a text file (*.csv) using this function.
This file can then be further processed with other programs which provide
*.csv import options (for example, MS Excel).
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Proceed as follows:

Using COMfortel Set

Requirements:

Existing entries in the telephone book

Open the page Telephone book and click the Import/export tab.

Click Export.

A dialogue for selecting the separator character opens.

Select the desired separator to be used to separate each entry into
individual columns and click OK.

A dialogue for selecting the columns to be exported opens.

Select the desired columns and click OK.

A file location dialogue opens.
Select the directory in which you want to save the file.

Enter a name for the *.csv file and click Save (this text is dependent on
the operating system used).

Note: Under Name, if, for example, you use characters that can also be
recognised as control characters during an export to *.csv (for example,
semicolon, comma or tab), these characters will be accepted in the file
unverified. This can lead to problems when reimporting the edited files.
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Redial List

The last 100 phone numbers dialled are saved in the redial list. For more

than 100 phone numbers dialled, the oldest entry is overwritten. The phone
numbers are saved along with number of dialling operations, date and time
of dialling (for multiple dialling operations, the date/time of the last attempt).

Opening the Redial List

Proceed as follows:

* Using the telephone

Requirements:

¢ Atleast one entry in the list

1. Press the redial key.

Short pressure: The redial list is now opened. The entry with the phone
number dialled previously is displayed.

Long pressure: The redial listis now opened. The entry with the phone
number dialled most frequently is displayed.

The following information about the entry is shown on the display:
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redial 01/03—+—— A
Rplcaller] B
+ [MSH] a1 C
L [call target]|———1D
Z 03: 01.01.13 B@E:88 QK

A Consecutive number of entries/number of existing entries

o

Caller

C Outbound MSN used for the (external) call

Important: Only available for operation on the PBXs COMpact 3000
analogue/ISDN/VolP, COMpact 5010 VolP, COMpact 5020 VolIP,
COMpact 4000, COMpact 5000/R, COMpact 5200/R, COMpact 5500R
and COMmander 6000/R/RX.

D Call destination

Note: If the phone number has been assigned a name in the telephone
book of the system telephone, this will be displayed.

E Time of last attempt
F Date of last attempt

G Number of attempts

2. Select one of the following options:
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“Zl Pressing the delete key deletes the entry shown.

Pressing and holding the delete key (2 seconds) deletes the entire
redial list.

4 Pressing the delete key deletes the callback shown.

Important: Only available for operation on the PBXs COMpact 3000
analogue/ISDN/VolP, COMpact 5010 VolP, COMpact 5020 VolIP,
COMpact 4000, COMpact 5000/R, COMpact 5200/R, COMpact
5500R and COMmander 6000/R/RX.

~ Pressing the arrow key scrolls to the next entry.
w Pressing the arrow key scrolls to the previous entry.

Ok Pressing the OK key accepts the entry into dial preparation.

Dialling from Redial List

Proceed as follows:

e Using the telephone

1. Open the redial list.

Note: If you have already picked up the receiver when you press the
redial key, the first phone number entry of the list is dialled immediately.

2. Scroll to the desired entry or press the redial key several times.

3. Pick up the receiver or press the hook key.

The subscriber is called.
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Note: If you want to exit the menu without dialling the phone number
displayed, press the home key.

Deleting Entries in Redial List

Proceed as follows:

* Using the telephone

1. Open the redial list.

2. Press the delete key to the delete the entry shown.

Note: To delete the entire redial list, press and hold the delete key for
approx. 2 seconds and then confirm the action. Alternatively, you can
delete the entire redial list via the function menu using functions >
delete data > redial list.
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Calls to be Recorded for Redial List

If you want to prevent too many entries from being entered in the redial list,
you can configure the listin relation to the calls to be recorded. The following
calls can be selected:

e External calls

e Internal calls

e Door calls

* Other calls

Proceed as follows:

* Using COMfortel Set (page Settings/functions > Lists under Redial
list)
¢ Using the telephone (menu settings > lists > redial list)
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Call List

The calls made (incoming and outgoing) are saved in the calls list of the
telephone along with the phone number of the communication partner as
well as date, time and duration of the call. A maximum of 100 calls can be
saved. For more than 100 calls, the oldest entry is overwritten. A previous
communication partner can called directly from the calls list.

Opening the Call List

Proceed as follows:

¢ Using the telephone

Requirements:

* At least one entry in the list

You can open the calls list by pressing a function key configured for this
purpose.

Alternatively, proceed as described below.

1. Press the Menu key and open the menu Functions > calls list.

2. Select one of the following options:
All calls: Displays all calls.
Outgoing calls: Displays all outgoing calls.

Incoming calls: Displays all incoming calls.
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Select the required mode and confirm with OK.

The following information about the entry is shown on the display:

calls list 01 /03— A
fj;[-: aller] B
o [MSH] a1 C
L [call target]|———1D
[E] »01.01.13 0B:00-08:05 (K

I 1
G F E

Consecutive number of entries/number of existing entries

Note: The latest entry is displayed with consecutive number 1.

Caller (communication partner)

Outbound MSN (for an external outgoing call), external call destination/
exchange line number called (for an external incoming call)

Call destination (communication partner)

Note: If the phone number has been assigned a name in the telephone
book of the system telephone, this will be displayed.

Time of the call
Date of the call
Call type: external outgoing (=), external incoming (z), internal outgoing

(») and internal incoming (4)

Select one of the following options:
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“Zl Pressing the delete key deletes the entry shown.

Pressing and holding the delete key (2 seconds) deletes the entire
calls list.

~ Pressing the arrow key scrolls to the next entry.
w Pressing the arrow key scrolls to the previous entry.

Dk Pressing the OK key accepts the entry into dial preparation for
subsequent dialling.

Dialling from Call List

Proceed as follows:

e Using the telephone

1. Open the calls list.

The call conducted last is displayed.
2. Scroll to the desired entry.

3. Pick up the receiver or press the hook key.

The subscriber is called.

Note: If you want to exit the menu without dialling the phone number
entered, press the home key.
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Deleting Entries in Call List

Proceed as follows:

¢ Using the telephone

1.

Open the calls list.

The call conducted last is displayed.

2. Press the delete key to the delete the entry shown.

Note: To delete the entire calls list, press and hold the delete key for
approx. 2 seconds and then confirm the action. Alternatively, you can
delete the entire calls list via the function menu using functions > delete

data > calls list.

Function Key for Call List
Press the key while the telephone is in the idle state to open the calls list.
In addition the status of the answering machine list is indicated by the corre-

sponding LED.

LED signalling on the key:
Green The list contains entries.

Note: When functions are definded on the second level key (optional,
see Technical Data in the Instructions), LED signalling is not available.

COMfortel 1200 - Firmware V2.2 - COMfortel Set V3.16 - Advanced Information V07 02/2019 1 33



Telephone Book and Lists
Call List

Proceed as follows by assigning the function key:

¢ Using COMfortel Set by selecting Calls list

¢ Using the telephone by selecting calls list

Note: For further information about the general procedures when
assigning function keys, see Function Keys.

Calls to be Recorded for Call List

If you want to prevent too many entries from being entered in the calls list,
you can configure the calls list in relation to the calls to be recorded. The
following calls can be selected:

e External calls without phone numbers

e External calls with phone numbers

* Internal calls

e Alarm calls

* Door calls

e Other calls

Proceed as follows:

¢ Using COMfortel Set (page Settings/functions > Lists under Calls
list)
¢ Using the telephone (menu settings > lists > calls list)
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Caller List

Phone numbers of calls not accepted are saved in the caller list of the
telephone, along with the number of call attempts as well as the date and
time of the call (for multiple call attempts, date/time of the last call attempt).
A maximum of 100 phone numbers can be saved. If more than 100 calls
from various phone numbers come in, the oldest entry is overwritten.

A caller be called back directly from the caller list.

The LED of the message key indicates whether entries are present on the
caller list.

Opening the Caller List

Proceed as follows:

* Using the telephone

Requirements:

¢ Atleast one entry in the list
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You can open the caller list by pressing a function key configured for this
purpose.

In addition, you can also open the caller list using the telephone menu
functions > caller list.

Alternatively, proceed as described below.

1. Press the message key.
The available lists are displayed.

2. Select caller list to open the caller list (this is skipped if the other lists
are empty or not available).
The last received call is displayed.

The following information about the entry is shown on the display:

caller list 01 /03— A
Arlcaller] B
’,J[E:-:t . call tar-ge—t]—“’*——c
L [int. call target]—s—TD
03: 01.01.13 E3: 68 Of
I | |
G F E

A Consecutive number of entries/number of existing entries

Note: The latest entry is displayed with consecutive number 1.

B Caller

1 36 COMfortel 1200 - Firmware V2.2 - COMfortel Set V3.16 - Advanced Information V07 02/2019



Telephone Book and Lists
Caller List

Note: If the phone number has been assigned a name in the telephone
book of the system telephone, this will be displayed.

C External call destination/exchange line number called (for an external
call)

Internal call destination
Time of last attempt

Date of last attempt

G M m ©

Number of attempts

3. Select one of the following options:
“Zl Pressing the delete key deletes the entry shown.
Holding the delete key (2 seconds) deletes the entire caller list.
~ Pressing the arrow key up scrolls to the next entry.
w Pressing the arrow key down scrolls to the previous entry.

Ok Pressing the OK key accepts the entry into dial preparation.

Dialling from Caller List

Proceed as follows:

e Using the telephone

1. Open the caller list.

The last incoming call is displayed.
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2. Scroll to the desired entry or press the message key several times.

3. Pick up the receiver or press the hook key.

The subscriber is called.

Note:

If you want to exit the menu without dialling the phone number displayed,
press the home key.

As soon as a connection (incoming or outgoing) has been established
with the caller, the phone number in question is deleted from the caller
list. Only when operated on the PBXs COMpact 5010 VolP, COMpact
5020 VolP, COMpact 4000, COMpact 5000/R, COMpact 5200/R,
COMpact 5500R and COMmander 6000/R/RX: If this is a group called,
the phone number is also deleted from the caller lists of the other
members of the group. (Can be configured using the configuration
manager on the PBX. Group-wide deletion does not occur if the person
calling back has already deleted his caller list or has been called again
by the same caller on his subscriber number.)

Deleting Entries from the Caller List

Proceed as follows:

* Using the telephone

1. Open the caller list.

The call conducted last is displayed.

1 38 COMfortel 1200 - Firmware V2.2 - COMfortel Set V3.16 - Advanced Information V07 02/2019



Telephone Book and Lists
Caller List

2. Press the delete key to the delete the entry shown.

Note: To delete the entire caller list, press and hold the delete key for
approx. 2 seconds and then confirm the action. Alternatively, you can
delete the entire caller list via the function menu using functions >
delete data > caller list.

Function Key for Caller Lists

Press the key while the telephone is in the idle state to open the caller list.

In addition the status of the caller list is indicated by the corresponding LED.

LED signalling on the key:

Green There are no new entries. All of the entries in the list have
been viewed, but have not yet been deleted.

Green The list contains new entries that have not yet been viewed.

(blinking)

Off The list is empty.

Note: When functions are defined on the second key level (optional, see
Technical Data in the Instructions), LED signalling is not available.

Proceed as follows by assigning the function key:

* Using COMfortel Set by selecting Caller list
* Using the telephone by selecting caller list
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Note: For further information about the general procedures when
assigning function keys, see Function Keys.

Calls to be Recorded for Caller List

If you want to prevent too many entries from being entered in the caller list,
you can configure the list in relation to the calls to be recorded. The following
calls can be selected:

e External calls without phone numbers

e External calls with phone numbers

* Internal calls

e Alarm calls

* Door calls

e (Calls accepted by another subscriber

e Other calls

Proceed as follows:

* Using COMfortel Set (page Settings/functions > Lists > Caller list,
under Caller list)

¢ Using the telephone (menu settings > lists > caller list)
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LED of the Message Key

While in the idle state, the LED of the message key indicates the state of the
list/s available over the message key.

e LED is flashing: The list contains new entries that have not yet been
viewed.

» LED lights up: There are no new entries. All of the entries in the list have
been viewed, but have not yet been deleted.

If the LED signalling is disruptive or bothersome, it can be switched off.

The configuration can be carried out as follows:

* Using COMfortel Set (Page Settings/functions > Lists, check boxes
under Caller list)

¢ Using the telephone (Menu settings > lists > caller list)
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This section describes how to set up and operate the functions on your
telephone. Descriptions are given on what the functions do, how to operate
them and — if possible — how to define these functions on programmable
function keys.

Topics

— Exchange Line Transfer (page 144)

— Call Waiting (page 147)

— Do-not-disturb (page 149)

— Automatic Call Acceptance (page 153)

— Follow-me (page 157)

— Call Deblocker (Incoming) — VIP Numbers (page 160)
— Targeted Exchange Line Access (page 162)

— Targeted VoIP Access Point (page 172)

— Group Functions (page 176)

— Hotel Function (page 186)

— InterCom Announcement/Hands-free (page 192)
— Configuration Switchover (page 202)

— Loudspeaker Announcement (page 205)

— Macro (page 209)

— Pickup (page 213)

— Power Dialling (page 216)

— Room Monitoring (page 220)

— Relays (page 223)

— Calling Line Identity Restriction (CLIR) (page 226)
— Call Forwarding (page 228)

— Call Restrictor (Incoming) — Robinson Numbers (page 243)
— Power Save Mode (page 245)
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— Phone Lock (page 248)

— Text before Answering (page 251)
— Door Functions (page 257)

— Speed Dialling (page 264)
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Exchange Line Transfer

A suitably authorised telephone, for example, the telephone exchange, can
transfer the exchange line access required for an outgoing call to another
internal telephone for a short period of time. This is meaningful, for example,
when this telephone is located in a publicly accessible room and is only
occasionally used for external calls by an employee.

Note: The exchange line transfer function is not available for operation
on the PBXs COMpact 2206 USB and COMpact 4410 USB.

Exchange Line Transfer Sequence

The exchange line transfer proceeds as follows:

* The requesting telephone must initiate an internal call with the
telephone authorised to make the exchange in order to request
exchange line access.

Important:

For an exchange line transfer, the telephone making the transfer needs
the authority level itself to transfer external calls externally.
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The requesting telephone needs at least the official exchange line
authority level for incoming external calls.

* After the function key assigned to exchange line transfer has been
pressed on the telephone authorised for making exchanges, a confir-
mation tone is issued to both internal subscribers and the internal call
must be ended.

* The requesting telephone now has access to the exchange line settings
configured for this purpose on the PBX. These exchange line settings
remain until the first successful, outgoing external call or until the time
limitation has elapsed for initiating the external call.

Note: Configuring the exchange line transfer function is done in the
PBX.

Function Key for Exchange Line Transfer

Important: Only available for operation on the PBXs COMpact 3000
analogue/ISDN/VolP, COMpact 5010 VolP, COMpact 5020 VolIP,
COMpact 4000, COMpact 5000/R, COMpact 5200/R, COMpact 5500R
and COMmander 6000/R/RX.

Press the key during an internal call to transfer the exchange line access to
your communication partner for a single external call. Afterwards, a confir-
mation tone is issued on both internal telephones and the internal call must
be ended.
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LED signalling on the key:

None

Requirements for operating the function:

* Authorisation in the PBX for Transfer of external calls to external

Proceed as follows by assigning the function key:

e Using COMfortel Set by selecting Exchange line call transfer
¢ Using the telephone by selecting ext. line transfer

Note: For further information about the general procedures when
assigning function keys, see Function Keys.
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Call Waiting

If you are already in a call, the call waiting function notifies you using the call
waiting tone when another communication partner is calling.

Call Waiting On/Off
Requirements:

¢ Authorisation in the PBX for Controlling of the PBX using the
telephone

Proceed as follows:

* Using the telephone (function key or menu functions > call waiting)

Function Key for Call Waiting

Press the key to switch call waiting on or off or to switch it over.

In addition the status of the function is indicated by the corresponding LED.

LED signalling on the key:
Green Call waiting is enabled.
Off Call waiting is disabled.

Note: When functions are defined on the second key level (optional, see
Technical Data in the Instructions), LED signalling is not available.
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Requirements for operating the function:

¢ Authorisation in the PBX for Controlling of the PBX using the
telephone

Proceed as follows by assigning the function key:

¢ Using COMfortel Set by selecting Call waiting
¢ Using the telephone by selecting Call Waiting

Note: For further information about the general procedures when
assigning function keys, see Function Keys.

Call Waiting Signalling via Tone

Incoming calls during a call are indicated by a change in the display.

If call waiting signalling via tone is enabled, incoming calls during a call are
also indicated by a tone on the receiver.

Proceed as follows:

¢ Using COMfortel Set (page Settings/functions > Signalling/ringer,
check box call waiting (tone))

* Using the telephone (menu settings > signalling > attention tone)
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Do-not-disturb

The do-not-disturb function offers the option of blocking internal and
external calls as well as blocking group calls on a specific telephone. A
caller hears only a busy signal. An internal subscriber can reach a telephone
with call protection in an emergency using a priority call.

The do-not-disturb function has no influence on outgoing calls, callbacks,
alarm calls, wake-up calls or InterCom calls.

Do-not-disturb Function On/Off

Requirements:

¢ Authorisation in the PBX for Controlling of the PBX using the
telephone

Proceed as follows:

* Using the telephone (function key or menu functions > do-not-
disturb)

Function Key for Do-not-disturb

Press the key to switch the do-not-disturb function on or off or to switch it
over.

In addition the status of the function is indicated by the corresponding LED.
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LED signalling on the key:
Yellow The do-not-disturb function is enabled.

Off The do-not-disturb function is disabled.

Note: When functions are defined on the second key level (optional, see
Technical Data in the Instructions), LED signalling is not available.

Requirements for operating the function:

e Authorisation in the PBX for Controlling of the PBX using the
telephone

Proceed as follows by assigning the function key:

¢ Using COMfortel Set by selecting Do-not-disturb
¢ Using the telephone by selecting do-not-disturb

Note: For further information about the general procedures when
assigning function keys, see Function Keys.

Type of Do-not-disturb

Important: Only available for operation on the PBXs COMpact 3000
analogue/ISDN/VolP, COMpact 5010 VolP, COMpact 5020 VolIP,
COMpact 4000, COMpact 5000/R, COMpact 5200/R, COMpact 5500R
and COMmander 6000/R/RX. On the other PBXs only the Do-not-
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disturb function of the PBX will be supported (see Advanced Information
of the PBX).

Defining the do-not-disturb type function determines how do-not-disturb
works when it is enabled.

All (PBX): The do-not-disturb function is carried out via the PBX. All
incoming calls are rejected and not entered in the caller list on the
telephone.

Reject anonymous: All anonymous calls are rejected.

Only contacts: All calls are rejected except for calls from contacts listed in
the telephone book.

All (telephone): The do-not-disturb function is carried out via the telephone.
All incoming calls are rejected and entered in the caller list on the telephone.

Note:

Parallel to the do-not disturb type, all (PBX), the call deblocker
(incoming) can be enabled so that the VIP numbers registered in the call
deblocker on the PBX are not rejected.

Internal telephone calls are only rejected if the do-not disturb type
function all (PBX) and all (telephone) are used. An internal subscriber
can reach a protected telephone in an emergency with a priority call if
the do-not disturb type function all (PBX) is used. Calls are only regis-
tered in the caller list on the telephone if the do-not disturb type function
all (telephone) is used.
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Proceed as follows:

* Using COMfortel Set (page Settings/functions > Do-not-disturb)

e Using the telephone (menu settings > do-not-disturb > kind do-not-
dist)
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Automatic Call Acceptance

Automatic call acceptance facilitates headset operation at call centres or on
hotlines. An incoming call is automatically accepted after a configured
amount of time. Call acceptance is signalled by an attention tone.

Automatic Call Acceptance On/Off

Note: Switching on automatic call acceptance automatically switches off
the readiness of answering machine in a telephone. On the other hand,
switching on the readiness of answering machine automatically switches
off automatic call acceptance.

LED signalling on the key:
Green: Automatic call acceptance is enabled.

Off: Automatic call acceptance is disabled

Requirements:
* Headset operation enabled
Proceed as follows:

¢ Using the telephone (function key or menu functions > auto call
accept)
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Function Key for Automatic Call Acceptance

Press the key to switch the automatic call acceptance function on or off or
to switch it over.

Note: Switching on automatic call acceptance automatically switches off
the readiness of answering machine in a telephone. On the other hand,
switching on the readiness of answering machine automatically switches
off automatic call acceptance.

In addition the status of the function is indicated by the corresponding LED.

LED signalling on the key:
Green Automatic call acceptance is enabled.

Off Automatic call acceptance is disabled.

Note: When functions are defined on the second key level (optional, see
Technical Data in the Instructions), LED signalling is not available.

Requirements for operating the function:

* Headset operation enabled
Proceed as follows by assigning the function key:

¢ Using COMfortel Set by selecting Automatic call acceptance

¢ Using the telephone by selecting auto call accept
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Note: For further information about the general procedures when
assigning function keys, see Function Keys.

Attention Tone for Automatic Call Acceptance

If the attention tone for automatic call acceptance is switched on, the
automatic call acceptance of a currently incoming call is signalled by an
attention tone. If the attention tone bothers you, you can switch it off. The
volume of the attention tone is dependent on the configured ringer volume.

Proceed as follows:
* Using COMfortel Set (page settings/functions > Headset, check box
Attention tone for automatic call acceptance)

¢ Using the telephone (menu settings > headset > auto call accept >
indicator tone)

Call Acceptance Time for Automatic Call Acceptance

The call acceptance time for automatic call acceptance indicates after how
many seconds an incoming call is automatically accepted.

0 to 30: After 0 to 30 minutes, an incoming call is automatically accepted,
depending on the entry.
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Proceed as follows:

* Using COMfortel Set (page Settings/functions > Headset, list field
Call acceptance time (0-30 secs) for automatic call acceptance)

¢ Using the telephone (menu settings > headset > auto call accept >
call accept time)
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Follow-me

Follow-me is a "internal call forwarding unconditional for subscribers" type
that is configured on the respective destination telephone (instead of on the
forwarding telephone). This provides the option of going from room to room
and taking the calls with you.

Switching Follow-me On/Off

Important: Not available for operation on the PBX COMpact 3000
analogue/ISDN/VolP.

Proceed as follows:

* Using the telephone

Requirements:

¢ Authorisation in the PBX for Controlling of the PBX using the
telephone

e Authorisation in the PBX for CF (groups) / Follow-me

1. Press the Menu key and open the menu functions > follow-me.

Alternatively, press a function key configured for Follow-me.

2. Select one of the following options:
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deactivate all: Disables all of the currently enabled Follow-me func-
tions. (No other action is required.)

switch on: Enables Follow-me for a subscriber.

switch off: Disables follow-me for a subscriber.

Note: For operation on the PBXs COMpact 2206 USB and COMpact
4410 USB, it is not possible to switch off the follow-me function for a
single subscriber. For this reason, the switch off option is not available.
The switch on option, on the other hand, is replaced by the following
step.

3. Select the subscriber whose calls should be rerouted using his name/
number.

Note: Follow-me can also be disabled on the forwarded telephone by
using "Switch off follow-me" for the subscriber's own phone number (for
operation on the PBXs COMpact 3000 analogue/ISDN/VolP, COMpact
5010 VolP, COMpact 5020 VolP, COMpact 4000, COMpact 5000/R,
COMpact 5200/R, COMpact 5500R and COMmander 6000/R/RX) or
"CF subscriber" (for operation on the PBXs COMpact 2206 USB and
COMpact 4410 USB).

4. Press the OK key.
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Function Key for Follow-me

Important: Not available for operation on the PBX COMpact 3000
analogue/ISDN/VolP.

Press the key while the telephone is in the idle state to open the follow-me
menu. This allows you to switch follow-me on or off or to switch it over for an
internal subscriber.

LED signalling on the key:

None

Requirements for operating the function:

¢ Authorisation in the PBX for Controlling of the PBX using the
telephone

e Authorisation in the PBX for CF (groups) / Follow-me

Proceed as follows by assigning the function key:

* Using COMfortel Set by selecting Follow-me
* Using the telephone by selecting follow-me

Note: For further information about the general procedures when
assigning function keys, see Function Keys.
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Call Deblocker (Incoming) — VIP
Numbers

If you would still like to allow specific people to call you despite enabling the
do-not-disturb function, the external numbers (VIP numbers) of these
people can be assigned a call deblocker for incoming calls in the PBX. The
call deblocker which applies to all subscribers can be enabled on your own
telephone as needed. If the call deblocker is enabled, the do-not-disturb
function does not apply to callers who use one of the VIP numbers.

Call Deblocker (Incoming) On/Off

Requirements:

¢ A call deblocker configured on the PBX and assigned to the subscriber

e Authorisation in the PBX for Controlling of the PBX using the
telephone

* Type of do-not-disturb configured to all (PBX)

Proceed as follows:

¢ Using the telephone (function key or menu functions > Call
Deblocker)
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Function Key for Call Deblocker (Incoming)

Press the key to switch the subscriber's call deblocker on or off or to switch
it over.

In addition the status of the function is indicated by the corresponding LED.
LED signalling on the key:

Green The call deblocker is enabled.
Off The call deblocker is disabled.

Note: When functions are defined on the second key level (optional, see
Technical Data in the Instructions), LED signalling is not available.

Requirements for operating the function:

e Unrestricted numbers configured on the PBX and assigned to the
subscriber

e Authorisation in the PBX for Controlling of the PBX using the
telephone

¢ Type of do-not-disturb configured to All (PBX)

Proceed as follows by assigning the function key:

¢ Using COMfortel Set by selecting Call deblocker - incoming (VIP no.)
¢ Using the telephone by selecting Call Deblocker

Note: For further information about the general procedures when
assigning function keys, see Function Keys.
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Targeted Exchange Line Access

Using targeted exchange line access, you can define which MSN (your own
external phone number) is transmitted for an external call and which
exchange line should be used while doing so.

Targeted Exchange Line Access Variants

The PBXs support three different kinds of targeted exchange line access:

Variant A — Function key Exchange line

Important: Only available for operation on the PBXs COMpact 3000
analogue/ISDN/VolP, COMpact 5010 VolP, COMpact 5020 VolIP,
COMpact 4000, COMpact 5000/R, COMpact 5200/R, COMpact 5500R
and COMmander 6000/R/RX.

Targeted exchange line access is carried out and includes the transmission
of a specific MSN.

When this function is defined on a key, the status of the SO port is indicated
by the corresponding LED thereby giving you an overview of key definition.

Variant B — Function key Exchange line

Important: Only available for operation on the PBXs COMpact 2206
USB and COMpact 4410 USB.
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Targeted exchange line access is carried out along with the transmission of
the standard number.

When this function is defined on a key, the status of the S0 port is indicated
by the corresponding LED thereby giving you an overview of key definition.

Variant C — Function key Exchange line MSN

Important: Only available for operation on the PBXs COMpact 2206
USB and COMpact 4410 USB.

Targeted exchange line access is carried out and includes the transmission
of a specific MSN.

Initiating Targeted Exchange Line Access (A — Function Key
Exchange Line)

Important: Only available for operation on the PBXs COMpact 3000
analogue/ISDN/VolP, COMpact 5010 VolP, COMpact 5020 VolIP,
COMpact 4000, COMpact 5000/R, COMpact 5200/R, COMpact 5500R
and COMmander 6000/R/RX.

Proceed as follows:

* Using the telephone
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Requirements:

A function key configured for targeted exchange line access

For targeted exchange line access with the transmission of a specific
MSN: Phone number presentation activated

Press a function key configured for targeted exchange line access.

Dial a phone number.

Important: If you must prefix e.g. an exchange line access number

when entering/selecting a phone number, depends on the exchange line
request (automatic, direct exchange line telephone, internal telephone)
that was configured in the PBX (see Advanced Information of the PBX).

Pick up the receiver or press the hook key.

The subscriber is called.

Note: If another call comes through before you have finished placing the
call, the telephone will reject the targeted exchange line access for your
next call.
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Initiating Targeted Exchange Line Access (B — Function Key
Exchange Line)

Important: Only available for operation on the PBXs COMpact 2206
USB and COMpact 4410 USB.

Proceed as follows:

* Using the telephone

Requirements:

¢ A function key configured for targeted exchange line access

1. Press a function key configured for targeted exchange line access.
2. Dial a phone number without an exchange line access number.

3. Pick up the receiver or press the hook key.

The subscriber is called.

Note: If another call comes through before you have finished placing the
call, the telephone will reject the targeted exchange line access for your
next call.
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Initiating Targeted Exchange Line Access (C — Function Key
Exchange Line MSN)

Important: Only available for operation on the PBXs COMpact 2206
USB and COMpact 4410 USB.

Proceed as follows:

* Using the telephone

Requirements:

¢ A function key configured for targeted exchange line access

* For targeted exchange line access with the transmission of a specific
MSN: Phone number presentation activated

1. Press a function key configured for targeted exchange line access.

2. Dial the exchange line access number 0 and a phone number.

3. Pick up the receiver or press the hook key.

The subscriber is called.

Note: If another call comes through before you have finished placing the
call, the telephone will reject the targeted exchange line access for your
next call.
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Function Key for Targeted Exchange Line Access (A — Function
Key Exchange Line)

Important: Only available for operation on the PBXs COMpact 3000
analogue/ISDN/VolP, COMpact 5010 VolP, COMpact 5020 VolIP,
COMpact 4000, COMpact 5000/R, COMpact 5200/R, COMpact 5500R
and COMmander 6000/R/RX.

Press the key to initiate targeted exchange line access. This allows you to
immediately dial the external number (without an exchange line access
number).

Important: If you must prefix e.g. an exchange line access number

when entering/selecting a phone number, depends on the exchange line
request (automatic, direct exchange line telephone, internal telephone)
that was configured in the PBX (see Advanced Information of the PBX).

In addition the status of the Sy port is indicated by the corresponding LED.

LED signalling on the key:
Red All of the B-channels on the Sy port/bundle are in use.

Yellow At least one B-channel on the Sy port/bundle is available.
Press the key to allocate the line still available.

Off Sy port/bundle is available. Press the key to allocate one of
the available lines.

Note: When functions are defined on the second key level (optional, see
Technical Data in the Instructions), LED signalling is not available.
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Proceed as follows by assigning the function key:

* Using COMfortel Set by selecting Exchange line
* Using the telephone by selecting exchange line

Note: For further information about the general procedures when
assigning function keys, see Function Keys.

Additional settings for this function key are described in the following.

Configuration with COMfortel Set

Your own exchange line — Telephone no

external number of the PBX which is to be transmitted at targeted exchange
line access.

Configuration with the Telephone

Telephone no

external number of the PBX (without exchange line access number and
prefix) which is to be transmitted at targeted exchange line access.
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Function Key for Targeted Exchange Line Access (B — Function
Key Exchange Line)

Important: Only available for operation on the PBXs COMpact 2206
USB and COMpact 4410 USB.

Press the key to initiate targeted exchange line access. This allows you to
immediately dial the external number (without an exchange line access
number).

In addition the status of the S port is indicated by the corresponding LED.

LED signalling on the key:
Red Both B-channels on the Sy port are in use.

Yellow One B-channel on the Sy port is still available. Press the
key to allocate the line still available.

Off Sy port is available. Press the key to allocate one of the
available lines.

Note: When functions are defined on the second key level (optional, see
Technical Data in the Instructions), LED signalling is not available.

Proceed as follows by assigning the function key:

* Using COMfortel Set by selecting Exchange line
* Using the telephone by selecting exchange line
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Note: For further information about the general procedures when
assigning function keys, see Function Keys.

Additional settings for this function key are described in the following.

Configuration with COMfortel Set

B-channel =

Selection of the exchange line for targeted exchange line access.

Configuration with the Telephone

Telephone no

Selection of the exchange line for targeted exchange line access.

Function Key for Targeted Exchange Line Access (C — Function
Key Exchange Line MSN)

Important: Only available for operation on the PBXs COMpact 2206
USB and COMpact 4410 USB.
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Press the key to initiate targeted exchange line access. This allows you to
immediately dial the external number (with an exchange line access
number).

In addition the status of the function is indicated by the corresponding LED.

LED signalling on the key:

Green The MSN on the key is transmitted during the next outgoing
external call.

Off The standard number transmitted during the next outgoing
call.

Note: When functions are defined on the second key level (optional, see
Technical Data in the Instructions), LED signalling is not available.

Proceed as follows by assigning the function key:

* Using the telephone by selecting exchange line MSN menu

Note: For further information about the general procedures when
assigning function keys, see Function Keys.

Additional settings for this function key are described in the following.

Configuration with the Telephone

Telephone no

external number of the PBX (without exchange line access number and
prefix) which is to be transmitted at targeted exchange line access.

COMfortel 1200 - Firmware V2.2 - COMfortel Set V3.16 - Advanced Information V07 02/2019 1 71



Functions
Targeted VoIP Access Point

Targeted VolP Access Point

Using a targeted VolP access point, an external call can be initiated via a
specific VolP account.

Initiating a Targeted VolP Access Point

Important: Only available for operation on the PBXs COMpact 3000
analogue/ISDN/VolP, COMpact 5010 VolP, COMpact 5020 VolIP,
COMpact 4000, COMpact 5000/R, COMpact 5200/R, COMpact 5500R
and COMmander 6000/R/RX.

Proceed as follows:

* Using the telephone

Requirements:

* Configured function key for a targeted VolP access point

1. Press a function key configured for a targeted VolP access point.

The VoIP account is activated for the next call. The account number is
displayed in dial preparation.

2. Dial a phone number.
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Important: If you must prefix e.g. an exchange line access number

when entering/selecting a phone number, depends on the exchange line
request (automatic, direct exchange line telephone, internal telephone)
that was configured in the PBX (see Advanced Information of the PBX).

3. Pick up the receiver or press the hook key.

The subscriber is called.

Function Key for Targeted VolIP Access Point

Important: Only available for operation on the PBXs COMpact 3000
analogue/ISDN/VolP, COMpact 5010 VolP, COMpact 5020 VolIP,
COMpact 4000, COMpact 5000/R, COMpact 5200/R, COMpact 5500R
and COMmander 6000/R/RX.

Press the key to initiate a targeted VolP access point. This allows you to
immediately dial the external phone number.

Important: If you must prefix e.g. an exchange line access number

when entering/selecting a phone number, depends on the exchange line
request (automatic, direct exchange line telephone, internal telephone)
that was configured in the PBX (see Advanced Information of the PBX).

In addition the status of the channels for the targeted VolP access point is
indicated by the corresponding LED.
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LED signalling on the key:

Red All of the channels for the VoIP access point are in use (no
call possible).

Yellow Some of the channels for the VolP access point are in use
(at least one channel for the VoIP access line is still
available). Press the key to allocate the channel still
available.

Off All channels for the VoIP access point are available. Press
the key to allocate an available channel.

Note: When functions are defined on the second key level (optional, see
Technical Data in the Instructions), LED signalling is not available.

Requirements for operating the function:

* A configured VoIP account

Proceed as follows by assigning the function key:

* Using COMfortel Set by selecting VolP account
* Using the telephone by selecting VolP account

Note: For further information about the general procedures when
assigning function keys, see Function Keys.

Additional settings for this function key are described in the following.
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Configuration with COMfortel Set

Account number — Telephone no

Account number of the VolP account

Configuration with the Telephone

Telephone no

Selection of a VolP account.
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Group Functions

In addition to internal subscribers, the PBX can also manage groups. The
internal subscribers can become members of any and all groups. These
groups can be used, for example, to collect the internal subscribers in
certain departments or teams (Support, Marketing, Sales) together.

Membership in a group does not necessarily mean that a subscriber
receives calls sent to the group. A subscriber that is logged out takes on no
group functions. This can be especially important for employees of a support
department, who should not be available to customers around the clock, but
rather rotate in and out of the hotline.

Detailed Information about Group Functions

Important: Not available for operation on the PBX COMpact 3000
analogue/ISDN/VolP.

Note:

If a group (subgroup) has been configured in the PBX as member of a
group (main group) and a subscriber is at the same time member of
these two groups, he will only be considered as a member of the main
group when a call comes in.

Subgroups (i.e. groups that have been configured as members of other
groups) are "permanently logged in as incoming“ and "permanently
logged out as outgoing® in the corresponding main group.

There are three different ways to login:
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Only incoming
When logging into a group as "incoming", the subscriber then finds himself

in the call distribution of the group in question for internal, exchange line and
door calls.

Only outgoing

When logging into a group as "outgoing", the subscriber acquires a number
of characteristics/access rights from the group. These replace his own
characteristics/access rights as an individual subscriber for outgoing work-
related calls. A subscriber can only be logged on in a single group as
"outgoing" even if he is a member of more than one group.

Note: If a subscriber logs into different groups as "outgoing" one after
the other, he will only remain logged in as "outgoing" in the group that he
logged into last.

Incoming and outgoing

When logging into a group as "incoming and outgoing", the subscriber then
finds himself in the call distribution of the group in question for internal,
exchange line and door calls and also acquires a number of additional
characteristics/access rights from the group. These replace his own charac-
teristics/permissions as an individual subscriber for outgoing work-related
calls.

Note: If a subscriber logs into more than one group as "incoming and
outgoing", he will only remain logged in as "incoming and outgoing" in
the group that he logged into last. And in all other groups, he is then only
"logged in as incoming".
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Logging the Telephone In/Out

Proceed as follows:

¢ Using the telephone

Requirements:

e The telephone is a member of a group configured in the PBX

e Authorisation in the PBX for Controlling of the PBX using the
telephone

In order to log a telephone into a group and or out of it, press the function
key configured for group functions.

Alternatively, proceed as described below.

1. Press the Menu key and open the menu functions > group.
2. Select the desired group based on its name/number.

3. Select one of the following options:
logging in: Logs the telephone into the group.

log out: Logs the telephone out of the group.

4. Select one of the following options:
outgoing: Select the call type for outgoing.
incoming: Select the call type for incoming.

incoming & outbnd: Selects the call type for incoming & outgoing.
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Logging Telephone Out of All Groups

Proceed as follows:

¢ Using the telephone

Requirements:

e The telephone is a member of a group configured in the PBX

e Authorisation in the PBX for Controlling of the PBX using the
telephone

In order to log out of all groups, press the function key configured for
logging out of all groups.

Alternatively, proceed as described below.

* Press the Menu key and open the menu functions > log out all grp..

Function Key for Group Function

Press the key for general functions while the telephone is the idle state to
open the menu for logging in or out of a specified group. After making the
selection, you still need to specify the call type (incoming, outgoing or
incoming & outgoing).

Press the defined key to execute the action configured in the key for the
specified group.

In addition the status of the function is indicated by the corresponding LED.
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LED signalling on the key:

Green The telephone is logged into the group for incoming and
outgoing calls.

Yellow The telephone is only logged into the group for either
incoming or outgoing calls.

Off The telephone is logged out of the group.

LED signalling on the key (when defined with a specific group
function only incoming):

Green The telephone is logged into the group for incoming and
outgoing calls.

Yellow The telephone is only logged into the group for incoming calls.

Off The telephone is logged out of the group for incoming calls.

LED signalling on the key (when defined with a specific group
function only outgoing):

Green The telephone is logged into the group for outgoing and
incoming calls.

Yellow The telephone is only logged into the group for outgoing calls.

Off The telephone is logged out of the group for outgoing calls.

Note: When functions are defined on the second key level (optional, see
Technical Data in the Instructions), LED signalling is not available.

Requirements for operating the function:

e Authorisation in the PBX for Controlling of the PBX using the
telephone
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Proceed as follows by assigning the function key:

* Using COMfortel Set by selecting
— Group
— Defined group

¢ Using the telephone by selecting

— group

Note: For further information about the general procedures when
assigning function keys, see Function Keys.

Additional settings for this function key are described in the following.

Configuration with COMfortel Set

Group — Telephone no

Phone number of the group.

Action =

Log out: Press the key to log the telephone out of the group.
Log in: Press the key to log the telephone into the group.
Change logging: Press the key to change the log in status.

direction =
incoming: Select the call type for incoming.

outgoing: Select the call type for outgoing.
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incoming + outgoing: Select the call type for incoming + outgoing.

Configuration with the Telephone

Telephone no

Selection of the group by its name/its number.

log out: Press the key to log the telephone out of the group.
logging in: Press the key to log the telephone into the group.

log over: Press the key to change the log in status.

incoming: Select the call type for incoming.
outgoing: Select the call type for outgoing.

incoming & outbnd: Selects the call type for incoming and outgoing.

Function Key for Logging Out of All Groups

Press the key while the telephone is in the idle state to log the telephone out
of all groups.

LED signalling on the key:

None
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Requirements for operating the function:

* The telephone is a member of a group configured in the PBX

e Authorisation in the PBX for Controlling of the PBX using the
telephone

Proceed as follows by assigning the function key:

¢ Using COMfortel Set by selecting Group functions off
¢ Using the telephone by selecting log out all grp.

Note: For further information about the general procedures when
assigning function keys, see Function Keys.

Display of the Group Status

Important: Only available for operation on the PBXs COMpact 5010
VolP, COMpact 5020 VolP, COMpact 4000, COMpact 5000/R, COMpact
5200/R, COMpact 5500R and COMmander 6000/R/RX.

Press the key in the idle mode of the telephone to display the current group
status of the subscribers (logged out, logged in as incoming and/or
outgoing) on the LEDs of configured speed dialling keys for approx. ten
seconds. For this purpose, the speed dialling keys must be assigned to the
corresponding subscriber numbers. Press the key again during the ten
seconds to cancel the display.
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LED signalling on the key:

Yellow The group status is being queried.

(blinking)

LED signalling on the speed dialling keys assigned to subscriber
numbers:

Red The telephone is logged out of the group.

Green The telephone is logged into the group for incoming and
outgoing calls.

Yellow The telephone is logged into the group for incoming calls.

Yellow The telephone is logged into the group for outgoing calls.
(blinking)

Note: When functions are defined on the second key level (optional, see
Technical Data in the Instructions), LED signalling is not available.

Requirements for operating the function:

Speed dialling keys assigned to the corresponding subscriber numbers

Proceed as follows by assigning the function key:

Using COMfortel Set by selecting Group status
Using the telephone by selecting Group status

Note: For further information about the general procedures when
assigning function keys, see Function Keys.

Additional settings for this function key are described in the following.
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Configuration with COMfortel Set

group log status — Telephone no

Phone number of the group.

Configuration with the Telephone

Telephone no

Selection of the group by its name/its number.
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Hotel Function

The hotel function allows you to use the COMfortel 1200 as a room
telephone when the PBX is used in a hotel.

The PBX provides a variety of functions that may not be suitable or may
even be harmful in relation to room telephone use. Therefore, telephones
configured as room telephones are blocked from not only programming
functions (for example, do-not-disturb, call forwarding) but also from
switching functions and special types of call initiation. This means that
guests can only make and except calls. Furthermore, cleaning personnel
have the option of indicating the status of the room by entering a series of
numbers (cleaned, unclean, blocked).

The advantages of a system telephone compared to using standard
telephones include centrally controlled delete functions when a guest
checks out (data protection) as well as various convenience functions, and
specially configured function keys when necessary. The functions that are
still permitted on room telephones are operated in the exact same way as is
described for normal telephones. With one exception: A function key
assigned to the hotel room function enables the guest to set a wake-up time
as well as query his call charges and his check-in time.

The following functions are still possible:

* Making and excepting internal and external calls

* Deleting data and call charges using the Functions menu command
(this does not affect the call charge counter on the PBX)

* The use of the caller/call/redial list as well as of the telephone book
(parts of the telephone book can be blocked in the telephone)

* Scheduled call/reminders and power dialling
» Call charge query and wake-up time configuration using a function key
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Configuring the Hotel Function

Important: Only available for operation on the PBXs COMpact 4410
USB, COMpact 5020 VolP, COMpact 5000/R, COMpact 5200/R,
COMpact 5500R and COMmander 6000/R/RX.

The hotel function is configured as described in the following.

For operation on the PBXs COMpact 5020 VolP, COMpact 5000/R,
COMpact 5200/R, COMpact 5500R and COMmander 6000/R/RX: Use
the configuration manager on the PBX to activate the hotel function.

Important: Activating is done with an unblocking code that you can
acquire from the Auerswald/FONtevo online shop. For operation on the
PBXs COMmander 6000/R/RX, the number of available hotel
telephones (reception and room telephones) must be activated. For
operation on the PBX COMpact 5000/R, COMpact 5200/R, COMpact
5500R and COMpact 5020 VolP the hotel function only needs to be
activated once.

Use the configuration manager or configuration software on the PBX to
select the telephones that are to be used as reception or room
telephones.

Note:

Itis not possible to use the system telephone as a waiting field reception
and as a reception telephone at the same time.
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For operation on the PBX COMpact 4410 USB, a max. of 1 hotel
reception telephone is possible.

¢ Use the configuration manager or the configuration software on the PBX
to configure the print function.

* On each hotel reception telephone, assign a hotel room key each for
each hotel room telephone to be managed.

Note:

If a check-in or check-out operation is in progress, the hotel reception
telephone is not accessible for incoming calls during this period of time.
It is recommended to configure call forwarding on busy for cases like
this.

Note that the option of entering internal calls into the caller list must be
activated if the hotel reception telephone should inform hotel guests of
why their calls could not go through.

¢ Assign a hotel room key on each room telephone for call charge queries
and for setting up wake-up times.

Note: In order to avoid misunderstandings when querying call charges,
the value configured in COMfortel Set for the cost per call unit must
correspond with the value configured in the PBX.
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Configuring Wake-up Time on Hotel Room Telephone

Proceed as follows:

¢ Using the telephone

Requirements:

* A function key configured for hotel rooms
* Successful check-in

1. Press a function key configured for hotel rooms.
2. Select wake-up time.

3. Select one of the following options:
switched off: Disables wake-up. (No other action is required.)
wake-up once: Switches the wake-up time on for a single wake-up.

wake-up daily: Switches the wake-up time on for daily wake-up.

4. Enter the time and confirm with OK.

Querying Call Charges on Hotel Room Telephone

Proceed as follows:

e Using the telephone
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Requirements:

* A function key configured for hotel rooms
* Successful check-in

1. Press a function key configured for hotel rooms.

2. Select call charges and confirm with OK.

The call charges including check-in date are displayed.

Function Key for Hotel Room on Hotel Room Telephone

Important: Configuring a function key on the room telephone must be
done using COMfortel Set, since configuration using the telephone is
blocked.

Press the key to open the menu for querying call charges and setting up a
wake-up time.

LED signalling on the key:

None

Requirements for operating the function:

* The hotel subscriber activated in the PBX (for a fee), if necessary

* The hotel room telephone function assigned to the telephone
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Proceed as follows by assigning the function key:

* Using COMfortel Set by selecting Hotel room

Note: For further information about the general procedures when
assigning function keys, see Function Keys.

Additional settings for this function key are described in the following.

Configuration with COMfortel Set

Hotel room — Telephone no

Own internal number of the room telephone.
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InterCom Announcement/Hands-free

The InterCom function enables an announcement to one system telephone
or to all system telephones of a group from any internal telephone without
someone having to actively receive a call (for example, in a doctor's office).

If the InterCom destination is one system telephone, this can be
programmed to switch on the microphone in addition to the loudspeaker
(hands-free) so that a person nearby can speak with the caller using this
intercom system.

InterCom Announcement Procedure

InterCom announcement is carried out as follows:

* Depending on the InterCom destination, one system telephone or all
system of a group are called using the InterCom function.

Note: Only the system telephones of the group which are ready for calls
(e.g., not busy) are called. The individual group members need not to be
logged into the group. They are also called when they are logged out of
the group.

* After afew rings, either one system telephone or all system telephones
of the group automatically pick up the call, depending on the InterCom
destination.

* Announcement is executed.
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Note: Announcement is limited to 120 seconds due to security reasons
in order to prevent possible misuse of this function (for example, eaves-
dropping from remote rooms).

* After 120 seconds has elapsed, the connection is automatically inter-
rupted. The connection can be maintained if the InterCom destination is
one system telephone and the receiver is picked up before 120 seconds
has elapsed.

Performing InterCom Announcement

Requirements:

» Existing InterCom authorisation at the InterCom destination/s

* Configured function key for InterCom announcement

Note: InterCom announcement can also be executed from any internal
telephone (see Advanced Information of the PBX).

Depending on the action type configured on the key, proceed as described.

1. Press the function key for InterCom announcement or press and hold
the function key.

The LED on the function key lights up in yellow or green to indicate the
existing call connection.
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2. To end announcement function, press the function key again or
release the function key.

Function Key for InterCom Announce-ment

Press the key while the telephone is in the idle state to dial the subscriber
or group number assigned to the key and initiate the InterCom
announcement. Depending on the action type configured, you need to hold
the key during the announcement (as soon as you release the key again,
the connection is terminated) or switch the key over by briefly pressing the
key (the key is pressed once at the start and once at the end).

In addition the status of the InterCom destination connection is indicated by

the corresponding LED.

LED signalling on the key (when defined with an internal subscriber
number):

Green There is currently an active connection to the InterCom desti-
nation.

Off There is currently no active connection to the InterCom desti-
nation.

LED signalling on the key (when defined with an internal group
number):

Green There is currently an active connection to all InterCom desti-
nations.

Yellow There is currently an active connection to at least one
InterCom destination.

Yellow The InterCom call is sent to the PBX.

(blinking)
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LED signalling on the key (when defined with an internal group
number):

Red No InterCom destination can be reached.

Note: When functions are defined on the second key level (optional, see
Technical Data in the Instructions), LED signalling is not available.

Requirements for operating the function:

» Existing InterCom authorisation at the InterCom destination

* For a group as InterCom destination: at least one group configured in
the PBX

Proceed as follows by assigning the function key:

e Using COMfortel Set by selecting InterCom announcement
* Using the telephone by selecting InterCom OneWay

Note: For further information about the general procedures when
assigning function keys, see Function Keys.

Additional settings for this function key are described in the following.

Configuration with COMfortel Set

Destination of announcement (system telephone or group with system
telephones) — Telephone no

COMfortel 1200 - Firmware V2.2 - COMfortel Set V3.16 - Advanced Information V07 02/2019 1 95



Functions
InterCom Announcement/Hands-free

Internal subscriber number or internal number of the group.

Type of action =l
hold: The key must be held down during the announcement.

Switch over: A short press of the key starts the announcement. Another
short press of the key ends the announcement.

Configuration with the Telephone

Telephone no

Internal phone number.

hold: The key must be held down during the announcement.

Switch over: A short press of the key starts the announcement. Another
short press of the key ends the announcement.

InterCom Hands-free Procedure

InterCom hands-free is carried out as follows:

* A system telephone is called using InterCom hands-free.
* After a few rings, the system telephone automatically picks up the call.
* Hands-free calling is executed.
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Note: Hands-free calling is limited to 120 seconds due to security
reasons in order to prevent possible misuse of this function
(for example, eavesdropping from remote rooms).

* After 120 seconds has elapsed, the connection is automatically inter-
rupted unless the system telephone receiver is picked up during this
time.

Performing InterCom Hands-free
Requirements:

¢ Existing InterCom authorisation at the InterCom destination

¢ Configured function key for InterCom hands-free

Note: InterCom hands-free can also be executed from any internal
telephone (see Advanced Information of the PBX).

Depending on the action type configured on the key, proceed as described.

1. Press the function key for InterCom hands-free or press and hold the
function key.
The LED on the function key lights up in green to indicate the existing
call connection.

2. To end hands-free function, press the function key again or release the
function key.
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Function Key for InterCom Hands-free

Press the key while the telephone is in the idle state to dial the phone
number assigned to the key and initiate InterCom hands-free. Depending on
the action type configured, you need to hold the key during hands-free
operation (as soon as you release the key again, the connection is termi-
nated) or switch the key over by briefly pressing the key (the key is pressed
once at the start and once at the end).

In addition the status of the InterCom destination connection is indicated by
the corresponding LED.

LED signalling on the key:

Green There is currently an active connection to the InterCom desti-
nation.

Off There is currently no active connection to the InterCom desti-
nation.

Note: When functions are defined on the second key level (optional, see
Technical Data in the Instructions), LED signalling is not available.

Requirements for operating the function:

» Existing InterCom authorisation at the InterCom destination

Proceed as follows by assigning the function key:

* Using COMfortel Set by selecting InterCom hands-free
* Using the telephone by selecting InterCOM > IC speakerphone
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Note: For further information about the general procedures when
assigning function keys, see Function Keys.

Additional settings for this function key are described in the following.

Configuration with COMfortel Set

Destination of the announcement + hands-free (system telephone) —
Telephone no

Internal destination number.

Type of action =l
hold: The key must be held down during the announcement.

Switch over: A short press of the key starts the announcement. Another
short press of the key ends the announcement.

Configuration with the Telephone

Telephone no

Internal destination number.

hold: The key must be held down during the announcement.

Switch over: A short press of the key starts the announcement. Another
short press of the key ends the announcement.
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InterCom Permission On/Off
Requirements:

e Authorisation in the PBX for Controlling of the PBX using the
telephone

Proceed as follows:

Using the telephone (function key or menu functions > InterCom
(Auth))

Function Key for InterCom Permission

Press the key to switch the InterCom permission function on or off or to
switch it over.

In addition the status of the function is indicated by the corresponding LED.

LED signalling on the key:
Green InterCom permission is enabled.

Off InterCom permission is disabled.

Note: When functions are defined on the second key level (optional, see
Technical Data in the Instructions), LED signalling is not available.

Requirements for operating the function:

¢ Authorisation in the PBX for Controlling of the PBX using the
telephone
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Proceed as follows by assigning the function key:

¢ Using COMfortel Set by selecting InterCom permission

e Using the telephone by selecting InterCom (Auth)

Note: For further information about the general procedures when
assigning function keys, see Function Keys.
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Configuration Switchover

If multiple configurations have been saved in the PBX, for example, for day,
night, etc., switching over from one configuration to another can be carried
out manually and/or in a time controlled manner.

Configuration Switchover Manually

Requirements:

e At least two configurations set up in the PBX

e Authorisation in the PBX for Configuration switching
Proceed as follows:

* Using the telephone (function key or menu functions > switch config.)

Function Key for Configuration Switchover

Press the key for general functions while the telephone is in the idle state to
open the Configuration menu. After this, you can enable the configuration.

Press the key defined for configurations to enable the configuration that has
been set up.

In addition the status of the function is indicated by the corresponding LED.
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LED signalling on the key (only for defined key assignment):
Green The configuration saved in the key is enabled.

Off The configuration saved in the key is disabled.

Note: When functions are defined on the second key level (optional, see
Technical Data in the Instructions), LED signalling is not available.

Requirements for operating the function:

* At least two configurations set up in the PBX
* Authorisation in the PBX for Configuration switching

Proceed as follows by assigning the function key:

¢ Using COMfortel Set by selecting
— Config. on
— Defined config. on

* Using the telephone by selecting
— switch config.

Note: For further information about the general procedures when
assigning function keys, see Function Keys.

Additional settings for this function key are described in the following.

Configuration with COMfortel Set
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configuration to be activated =

Selection of a configuration (depending on the PBX type).

Identification number

Marks the identification number of a configuration (depending on the PBX
type).

Configuration with the telephone

general: Press the key to open the switch configuration menu.

defined: Press the key to enable the set configuration.

Configuration

Selection of a configuration.
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Loudspeaker Announcement

This function enables loudspeaker announcement over an audio output on
the loudspeaker connected to the PBX unit or an active loudspeaker (for
example, a loudspeaker system in a department store/supermarket). In
addition, a previously specified phone number is called by an internal
telephone. The call connection is immediately established after dialling the
phone number.

Performing Loudspeaker Announcement

Important: Not available for operation on the PBX COMpact 3000
analogue/ISDN/VolP.

Proceed as follows:

* Using the telephone

Requirements:

¢ Authorisation in the PBX for Speaker announcement

¢ A function key configured for loudspeaker announcement

Note: Loudspeaker announcement can also be performed from any
internal telephone (see Advanced Information of the PBX).
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Depending on the action type configured on the key, proceed as described.

1. Press the function key for InterCom announcement/hands-free or
press and hold the function key.

The LED on the function key lights up in green to indicate the existing

call connection.

2. To end announcement or hands-free function, press the function key
again or release the function key.

Function Key for Loudspeaker Announcement

Important: Not available for operation on the PBX COMpact 3000
analogue/ISDN/VolP.

Press the key while the telephone is in the idle state to establish a
connection to the audio output on the PBX. Depending on the action type
configured, you need to hold the key during the audio out (as soon as you
release the key again, the connection is terminated) or switch the key over
by briefly pressing the key (the key is pressed once at the start and once at
the end).

In addition the status of the audio output connection is indicated by the
corresponding LED.

LED signalling on the key:
Green There is currently an active connection to the audio output.

Off There is currently no active connection to the audio output.
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Note: When functions are defined on the second key level (optional, see
Technical Data in the Instructions), LED signalling is not available.

Requirements for operating the function:

* An audio output configured in the PBX
¢ Authorisation in the PBX for Speaker announcement

¢ Authorisation in the PBX for Controlling of the PBX using the
telephone

Proceed as follows by assigning the function key:

* Using COMfortel Set by selecting InterCom audio out
e Using the telephone by selecting InterCom > Audio out

Note: For further information about the general procedures when
assigning function keys, see Function Keys.

Additional settings for this function key are described in the following.

Configuration with COMfortel Set

Destination of the annoucement (audio output) — Telephone no

internal number of the audio output.

Type of action =l
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hold: The key must be held down during the announcement.

Switch over: A short press of the key starts the announcement. Another
short press of the key ends the announcement.

Configuration with the Telephone

Telephone no

Selection of the audio output.

hold: The key must be held down during the announcement.

Switch over: A short press of the key starts the announcement. Another
short press of the key ends the announcement.
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Macro

The macro function enables a function key to be defined with digits and
various consecutive commands, for example, for accessing an answering
machine remotely or programming a function on the PBX.

Macro Execution Procedure

The following describes the procedure based on an example key using the
following command sequence HZ300CW2Z#22#:

* Command H: After pressing the macro key, the telephone switches to
hands-free calling.

Note: If the H command (hang-up/pickup with the hook key) is missing
at the beginning of the macro, the start of macro execution must be
confirmed.

¢ Command Z300: The telephone dials the phone number 300 (for
example, the answering machine).

¢ Command C: The telephone waits for the connection.

¢ Command W2: After the connection has been established, the
telephone waits another 2 seconds.

e Command Z#22#: The telephone dials the DTMF code #22#.
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Important: If you want to end macro execution, press the home key.

Macro execution is ended immediately when an outgoing call is made to
a destination that is busy or when a connection returns that it is busy.
This occurs, for instance, when the other calling party ends the call or
the macro contains a programming code that is not authorised.

Function Key for Macro

Press the key while the telephone is in the idle state to execute a macro. If
the H command (hang-up/pickup with the hook key) is located at the
beginning of a macro, the macro saved in the system is executed immedi-
ately. If this is not the case, you need to first confirm the start of macro
execution.

Proceed as follows:

* Using COMfortel Set by selecting Macro
* Using the telephone by selecting macro

Configuration with COMfortel Set

Macro sign
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Up to 100 characters for a max. of 10 keys, up to 40 characters for
additional keys

The following commands:
Z [digit sequence] Digit sequence selection including * and #

W [digits 1-5] Waiting time/pause time of 1-5 seconds

K Switchover to keypad

M Switchover to DTMF

H Hang-up/pickup with the hook key
Cc Wait for a connection

Note:

If you want to configure a programming function on the PBX as a macro,
enter a pause between the password and programming code sequence.

Pauses cannot be entered at the beginning of a macro.

The maximum pause time is 5 seconds. This restriction does not apply
for the C command (waiting for a connection).

Configuration with the Telephone

macro

Up to 100 characters for a max. of 10 keys, up to 40 characters for
additional keys

The following commands:

Z [digit sequence] Digit sequence selection including * and #
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W [digits 1-5] Waiting time/pause time of 1-5 seconds

K

M
H
C

Switchover to keypad
Switchover to DTMF
Hang-up/pickup with the hook key

Wait for a connection

Note:

If you want to configure a programming function on the PBX as a macro,
enter a pause between the password and programming code sequence.

Pauses cannot be entered at the beginning of a macro.

The maximum pause time is 5 seconds. This restriction does not apply
for the C command (waiting for a connection).

Display Presentation during Macro Execution

This setting specifies if the digits that have just been dialled or the name of
the key are shown in the telephone display during macro execution.

Proceed as follows:

Using COMfortel Set (page Settings/functions > User settings choice
box under Display presentation during macro execution)

Using the telephone (menu settings > user settings > macro display)
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Pickup

Using pickup, you can take a call on your own phone that was originally sent
to another internal telephone.

If the call has already been taken, the call can be taken using same
procedure if the call take-over has been allowed by the subscriber being
called. This function is useful, for example, in the case of answering
machines.

Performing Pickup

Requirements:

¢ Authorisation in the PBX for Pickup

If an internal telephone rings in your proximity, proceed as described in the
following.

1. Press the Menu key and open the menu functions > pickup.

Alternatively, press a function key configured for pickup.

2. Enter the internal phone number of the telephone that is ringing. (In
case of direct exchange access you do not have to dial ** first.)

Note: Alternatively, you can use a phone number for which you have
already configured a speed dialling key. If you want to take call that is
directed to a group, select the pickup for the group number.
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3. Pick up the receiver or press the hook key.

Performing Pickup during Call

Requirements:

¢ Authorisation in the PBX for Pickup

If you are already taking a call and an internal telephone rings in your
proximity, proceed as described in the following.

1. Select pickup and confirm with OK.
You will hear the internal dial tone. The person you had been talking to

hears the hold music.

2. Enter the internal phone number of the telephone that is ringing. (In
case of direct exchange access you do not have to dial ** first.)

Note: If you want to take call that is directed to a group, select the pickup
for the group number.

Once you have finished dialling the phone number, you are connected
to the caller.
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Function Key for Pickup

Pressing the key opens the pickup menu. This allows you to enter the
internal phone number of the telephone that is ringing.

In addition, you can press the key to initiate a call take-over on telephones
or answering machines for which permission has been given (see Advanced
Information of the PBX).

LED signalling on the key:

None

Note: If you often take pickups for specific telephones, you can
configure a speed dialling key for the associated internal subscriber/
group telephone as an alternative to this key. You then see a red blinking
LED indicating that the phone number is being called. You can press the
speed dialling key and after the confirmation, take the call on your
telephone.

Requirements for operating the function:

e Authorisation in the PBX for Pickup

Proceed as follows by assigning the function key:

¢ Using COMfortel Set by selecting Pickup
¢ Using the telephone by selecting pickup

Note: For further information about the general procedures when
assigning function keys, see Function Keys.
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Power Dialling

If the telephone being called is busy, but automatic callback on busy is not
possible, the power dialling function be activated instead. When this is done,
the system telephone attempts to reach the subscriber being called in short
time intervals.

Power Dialling Procedure

Power dialling is executed as follows:

* The system telephone attempts to reach the subscriber being called in
short time intervals (every 30 seconds).

* As soon as the system telephone dials the number of the subscriber, it
switches the loudspeaker.

* The connection is then established when the person being called picks
up the receiver. If he does not pick up the receiver, power dialling is
ended.

* If power dialling is not successful, the system telephone automatically
cancels the function after 10 minutes.

Note: If interruptions occur (for example, calls that are initiated intermit-
tently), this time period is extended accordingly.

21 6 COMfortel 1200 - Firmware V2.2 - COMfortel Set V3.16 - Advanced Information V07 02/2019



Functions
Power Dialling

Performing Power Dialling

If the connection is busy and callback is not possible, proceed as described

in the following.

1. Select Power Dialling and confirm with OK.

Alternatively, press a function key configured for power dialling.

Note: Avoid leaving the telephone once power dialling has been
activated since whenever a number is dialled, the loudspeaker on the

system telephone is automatically switched on.

Cancelling Power Dialling

Requirements:

¢ Power dialling has been initiated
¢ A function key configured for power dialling

If you want to cancel power dialling in progress, proceed as described in the
following.

The telephone is now in the idle state: Select ™ and press the OK key
or press a function key configured for power dialling.

217
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* The telephone is not in the idle state. It is currently attempting to reach
the subscriber in question: Press the hook key.

Attention Tone for Power Dialling

If the attention tone for power dialling has been enabled, the attention tone
signals that the subscriber being called with power dialling is no longer busy
and the loudspeaker has been switched on. The volume of the attention
tone is dependent on the configured ringer volume.

Proceed as follows:
* Using COMfortel Set (page Settings/functions > Signalling/ringer,
check box Attention tone (power dialling))

¢ Using the telephone (function key or menu settings > signalling >
attention tone check box power dialling)

Function Key to Initiate/Cancel Power Dialling

Press the key to initiate power dialling or to cancel an initiated power
dialling.

In addition the status of power dialling is indicated by the corresponding
LED.

LED signalling on the key:

Red Power dialling has been initiated.
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LED signalling on the key:
Off Power dialling is off.

Note: When assigned to the second key level (optional, see Technical
Data in the Instructions), LED signalling is not available.

Proceed as follows by assigning the function key:

¢ Using COMfortel Set by selecting Power dialling

¢ Using the telephone by selecting power dialling

Note: For further information about the general procedures when
assigning function keys, see Function Keys.
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Room Monitoring

The room monitoring function can be used for monitoring a room acousti-
cally, for instance, for monitoring a small child while she sleeps. The internal
telephone in this room must be suitably configured for this purpose.

The configured telephone can then be called by another internal telephone
or by a password-protected external telephone. The connection is estab-
lished immediately and it is possible to listen into the room.

Initiating Room Monitoring

Requirements:

e Authorisation in the PBX for Controlling of the PBX using the
telephone

To enable room monitoring, press a function key configured for room
monitoring.

Alternatively, proceed as described below.

1. Press the Menu key and open the menu functions > room
monitoring.

2. Select switch on.

The microphone of the hands-free component switches on automati-
cally. If the telephone is then called from an internal telephone, the
connection is immediately established and it is possible to listen into the
room.
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Note: How to listen into a room from an external telephone is described
in Advanced Information for the PBX.

Ending Room Monitoring

* Pressthe OK key or the hook key or pick up the receiver and then hang
it up again.

¢ Alternatively, press a function key configured for room monitoring.

Function Key for Room Monitoring

Press the key while the telephone is in the idle state to switch on or off room
monitoring.

In addition the status of the function is indicated by the corresponding LED.

LED signalling on the key:

Red The room monitoring function is enabled.

Red The room monitoring function is executed.
(blinking)

Off The room monitoring function is disabled.
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Note: When functions are defined on the second key level (optional, see
Technical Data in the Instructions), LED signalling is not available.

Requirements for operating the function:

¢ Authorisation in the PBX for Controlling of the PBX using the
telephone

Proceed as follows by assigning the function key:

* Using COMfortel Set by selecting Room monitoring
* Using the telephone by selecting room monitoring

Note: For further information about the general procedures when
assigning function keys, see Function Keys.
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Relays

If the PBX is equipped with one or more relays, they can be switched on and
off independently of the operating mode configured for each telephone.

Relays On/Off

Important: Not available for operation on the PBX COMpact 3000
analogue/ISDN/VolP.

Requirements:

* Authorisation in the PBX for Switching of relay

* Arelay configured in the PBX with relay mode configuration
dependent or PC relay

Proceed as follows:

* Using the telephone (function key or menu functions > relay)

Function Key for Switching Relays On/Off

Important: Not available for operation on the PBX COMpact 3000
analogue/ISDN/VolP.
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Press the key to switch to the configured relay on or off or to switch it over.

In addition the status of the relay is indicated by the corresponding LED.

LED signalling on the key:

Green The relay configured on the key is enabled.

Off The relay configured on the key is disabled.

Note: When functions are defined on the second key level (optional, see
Technical Data in the Instructions), LED signalling is not available.

Requirements for operating the function:

* Arelay configured in the PBX with relay mode configuration
dependent or PC relay
e Authorisation in the PBX for Switching of relay

¢ Operating mode Manual relay configured in the PBX.

Proceed as follows by assigning the function key:

¢ Using COMfortel Set by selecting Relay

¢ Using the telephone by selecting relay

Note: For further information about the general procedures when
assigning function keys, see Function Keys.

Additional settings for this function key are described in the following.

224 COMfortel 1200 - Firmware V2.2 - COMfortel Set V3.16 - Advanced Information V07 02/2019



Functions
Relays

Configuration with COMfortel Set

Relays to be switched =
Relay to be switched (depending on the PBX type).

Identification number

Identification number of the relay to be switched (depending on the PBX
type).

Configuration with the Telephone

Relay

Relay to be switched.
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Calling Line Identity Restriction (CLIR)

Calling line identity restriction (CLIR) enables you to prevent the phone
number from being displayed on the telephone of the called party from case
to case.

Function Key for Calling Line Identity Restriction (CLIR)

Press the key to switch the calling line identity restriction on or off or to
switch it over.

In addition the status of the memo is indicated by the corresponding LED.
LED signalling on the key:

Red Calling line identity restriction is enabled.

Off Calling line identity restriction is disabled.

Note: When assigned to the second key level (optional, see Technical
Data in the Instructions), LED signalling is not available.

Requirements for operating the function:

* CLIR2 feature (case-to-case calling line line identity restriction)
activated at the network provider

* Number presentation activated in the PBX
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Proceed as follows by assigning the function key:

* Using COMfortel Set by selecting Calling Line Identity Restriction
* Using the telephone by selecting call ID restr.

Note: For further information about the general procedures when
assigning function keys, see Function Keys.
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Call Forwarding

Call forwarding allows calls to be forwarded. When this is done, a difference
is made between calls to a specific telephone (call forwarding for
subscribers), to groups (call forwarding for groups) and to connections (call
forwarding for external numbers).

Call Forwarding Variations

PBXs support three different kinds of call forwarding:

Call Forwarding for Subscribers

Important: Not available for operation on the PBX COMpact 3000
analogue/ISDN/VolP.

When call forwarding (CF) for subscribers is used, internal and external calls
to a single telephone can be rerouted to other internal telephones or
external connections. In this way, the subscriber in question or his
replacement can take these calls on another telephone.

Call forwarding for subscribers makes sure that the subscriber in question
or his replacement is always available at his own phone number, even if the
subscriber cannot take a call on his own telephone.
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Important: Call forwarding for subscribers does not function for
incoming group calls on your telephone. If you want to prevent your
telephone from ringing unanswered when calls to the group in which you
belong come through, you need to log yourself out of the group or
configure call forwarding for groups.

Note: If you would like to configure call forwarding for subscribers on the
destination telephone, use the follow-me function.

Call Forwarding for Groups

Important: Not available for operation on the PBX COMpact 3000
analogue/ISDN/VolP.

When call forwarding for groups is used, internal and external calls to a
group can be rerouted to other internal telephones or external connections.
In this way, a person that is not a member of this group and therefore cannot
log in, can receive these calls.

Call forwarding for groups makes sure that someone is always available on
the group number, even if the calls cannot be taken by a member of the
group.

To configure call forwarding for groups, refer to the Operation Advanced
Information for the PBX.
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Call Forwarding for External Numbers

When call forwarding for external numbers is used, calls made to an
external phone number (dialled by an external caller) are rerouted to other
external connections. In this way, these calls can be taken on another
telephone, for example, on a mobile phone if no one can take the call inter-
nally.

Call forwarding for external numbers can be configured for the current
configuration or for the permanent configuration.

Note: If you want to also forward internal calls, use call forwarding for
subscribers or for groups instead of call forwarding for external numbers.
This also allows forwarding to internal telephones.

Kinds of Call Forwarding

As there can be many different reasons for not accepting a call, for example,
the subscriber in question is not present or is on another line, three kinds of
call forwarding are provided:

CF unconditional

The telephone being called does not ring. The call is forwarded immediately.
CF on busy

The call is forwarded immediately but only if the telephone being called is
busy.
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CF on no reply

The telephone being called rings for a certain amount of time. If the call is
not accepted, it is forwarded.

Note:

A different destination can be configured for each of the three kinds of
call forwarding.

If "CF on busy" and "CF on no reply" are enabled at the same time, both
kinds apply. Depending on which case occurs — the telephone is busy or
nobody answers it — the call is forwarded to their respective phone
numbers.

If "CF unconditional" is enabled in addition to the "CF on busy" and/or
"CF on no reply," all of the calls are forwarded immediately. In this case,
the other kinds of call forwarding are overridden, but remain enabled. As
soon as "CF unconditional® is disabled, the other kinds that are still
enabled are again applicable.

Switching Call Forwarding for Subscribers On/Off

Proceed as follows:

e Using the telephone
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Requirements:

Authorisation in the PBX for Controlling of the PBX using the
telephone

For external destination numbers: Authorisation assigned in the PBX for
Configuring CF (sub) to ext. number

To enable or disable call forwarding for subscribers, press the function key
configured for call forwarding (subscribers).

Alternatively, proceed as described below.

1.

2.

Press the Menu key and open the menu functions > Call fwd.:scr.

Select one of the following options:

deactivate all: Disables all currently enabled call forwarding for
subscribers. (No other action is required.)

unconditional: Switches call forwarding unconditional for subscribers
on or off.

on busy: Switches call forwarding on busy for subscribers on or off.
on no reply: Switches call forwarding on no reply for subscribers on or
off.

Select one of the following options:

switch on: Enables call forwarding for subscribers.

switch off: Disables call forwarding for subscribers. (No other action is
required.)
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Note: If you press the telephone book key before entering the desti-
nation number, you can select the desired phone number from the
telephone book.

4. Enter the destination number and confirm with OK.

Important: If you must prefix e.g. an exchange line access number

when entering/selecting a phone number, depends on the exchange line
request (automatic, direct exchange line telephone, internal telephone)
that was configured in the PBX (see Advanced Information of the PBX).

Function Key for Call Forwarding for Subscribers

Press the key to enable, disable and switch call forwarding for subscribers
over.

Exception: A key that is defined to disable call forwarding for subscribers
only disables the currently enabled call forwarding for subscribers.

In addition the status of the function is indicated by the corresponding LED.

LED signalling on the key (not applicable if defined with "deactivate
all"):

Red Call forwarding for subscribers is enabled for the configured
destination.

Yellow Call forwarding for subscribers is enabled for another desti-
nation.

Off Call forwarding for subscribers is disabled.
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Note: When functions are defined on the second key level (optional, see
Technical Data in the Instructions), LED signalling is not available.

Requirements for operating the function:

Authorisation in the PBX for Controlling of the PBX using the
telephone

For external destination numbers: Authorisation assigned in the PBX for
Configuring CF (sub) to ext. number

Proceed as follows by assigning the function key:

Using COMfortel Set by selecting
— Subscriber CF unconditional
— Subcriber CF on busy

— Subcriber CF on no reply

— Switch off all subscriber CF

Using the telephone by selecting
— call fwd.:scr > deactivate all
— call fwd.:scr > unconditional
— call fwd.:scr > on busy

— call fwd.:scr > on no reply

Note: For further information about the general procedures when
assigning function keys, see Function Keys.

Additional settings for this function key are described in the following.
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Configuration with COMfortel Set

w

Destination of the call diversion — Telephone no

Destination number.

Note: Click :] to accept a phone number from the telephone book in
the Telephone no entry field.

Destination of the call diversion — Type of phone number =l

Marks the phone number as internal or external number.

Configuration with the Telephone

Telephone no

Destination number.

Note: If you press the telephone book key before entering the desti-
nation number, you can select the desired phone number from the
telephone book. Alternatively, you can press a configured speed
dialling key to select the destination number.

Important: If you must prefix e.g. an exchange line access number

when entering/selecting a phone number, depends on the exchange line
request (automatic, direct exchange line telephone, internal telephone)
that was configured in the PBX (see Advanced Information of the PBX).
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Switching Call Forwarding for External Numbers On/Off

Important: Only available for operation on the PBXs COMpact 3000
analogue/ISDN/VolP, COMpact 5010 VolP, COMpact 5020 VolIP,
COMpact 4000, COMpact 5000/R, COMpact 5200/R, COMpact 5500R
and COMmander 6000/R/RX. On the other PBXs this function can be set
via programming sequence (see Advanced Information of the PBX).

Proceed as follows:

¢ Using the telephone

Requirements:

* Authorisation assigned in the PBX for Features to be configured by
the network provider (CF, keypad)

To enable or disable call forwarding for external numbers, press the
function key configured for call forwarding (external numbers).

Alternatively, proceed as described below.

1. Press the Menu key and open the menu functions > CF ext.no..

2. Select one of the following options:

current conf.: Switches permanent configuration off and the current
condition on.)
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deactivate all: Disables all currently enabled call forwarding for
external numbers. The prerequisite is that function keys have been
configured for these instances of call forwarding. (No other action is
required.)

unconditional: Switches call forwarding unconditional for external
numbers on or off.

on busy: Switches call forwarding on busy for external numbers on or
off.

on no reply: Switches call forwarding on no reply for external numbers

on or off.

3. Enter the external phone number to be forwarded on the PBX (without
an exchange line access number and with a area code) and confirm
with OK.

4. Select one of the following options:

switch on: Enables call forwarding for external numbers.

For current configuration: Switches the current configuration on and the
permanent configuration off. (No other action is required.)

switch off: Disables call forwarding for external numbers. (No other
action is required.)

For current configuration: Switches the current configuration off and the
permanent configuration on. (No other action is required.)

Note: If you press the telephone book key before entering the desti-
nation number, you can select the desired phone number from the
telephone book.
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5. Enter the destination number (with exchange line access number,
exception: automatic exchange line request was configured in the PBX)
and confirm with OK.

Function Key for Call Forwarding for External Numbers

Important: Only available for operation on the PBXs COMpact 3000
analogue/ISDN/VolP, COMpact 5010 VolP, COMpact 5020 VolIP,
COMpact 4000, COMpact 5000/R, COMpact 5200/R, COMpact 5500R
and COMmander 6000/R/RX. On the other PBXs this function can be set
via programming sequence (see Advanced Information of the PBX).

Pressing the key enables, disables and switches call forwarding for external
numbers over.

Exception: A key defined to disable all instances of call forwarding for
external numbers disables all enabled call forwarding for external numbers.
The prerequisite is that function keys have been configured for these
instances of call forwarding.

In addition the status of the function is indicated by the corresponding LED.

LED signalling on the key (not applicable if defined with
"deactivate all"):

Red Call forwarding for external numbers is enabled in the
public exchange/PBX for the configured destination and
selected configuration.
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LED signalling on the key (not applicable if defined with

"deactivate all"):

Yellow Call forwarding on busy or on no reply for external numbers
has been configured, but it is overridden by an additional
call forwarding unconditional for external numbers.

Yellow Call forwarding for external numbers is enabled in the
public exchange/PBX for another destination or configu-
ration.

Off Call forwarding for external numbers is disabled in the
public exchange/PBX.

Note: When functions are defined on the second key level (optional, see
Technical Data in the Instructions), LED signalling is not available.

Important: When operating the function via the key, the success/failure
of the operation is indicated by a change in colour on the LED. During
the configuration in the public exchange (this takes perhaps from a few
seconds up to a minute), the LED blinks yellow.

Requirements for operating the function:

* Authorisation assigned in the PBX for Features to be configured by
the network provider (CF, keypad)

Proceed as follows by assigning the function key:
e Using COMfortel Set by selecting

— CF unconditional (MSN/DDI)

— CF on busy (MSN/DDI)

— CF on no reply (MSN/DDI)

COMfortel 1200 - Firmware V2.2 - COMfortel Set V3.16 - Advanced Information V07 02/2019 239



Functions
Call Forwarding

— Switch off all CF (MSN/DDI)

* Using the telephone by selecting
— MSN/DDI CF > deactivate all
— MSN/DDI CF > unconditional
— MSN/DDI CF > on busy
— MSN/DDI CF > on no reply

Note: For further information about the general procedures when
assigning function keys, see Function Keys.

Additional settings for this function key are described in the following.

Configuration with COMfortel Set

Your own exchange line — Telephone no

Own external number to be forwarded (without exchange line access
number and with a area code).

w

Destination of the call diversion — Telephone no

External destination number (with exchange line access number, exception:
automatic exchange line request was configured in the PBX).

Note: Click :] to accept a phone number from the telephone book in
the Telephone no entry field.
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Configuration =
Permanent configuration: Call forwarding unconditional for external

numbers is enabled, disabled or switched over in the permanent configu-
ration.

Current configuration: Call forwarding unconditional for external numbers
is enabled, disabled or switched over only in the current configuration.

Note: Call forwarding for the current configuration can only be enabled
if call forwarding for the permanent configuration is disabled.

Configuration with the Telephone

Phone number

External destination number (with exchange line access number, exception:
automatic exchange line request was configured in the PBX).

Note: If you press the telephone book key before entering the desti-
nation number, you can select the desired phone number from the
telephone book. Alternatively, you can press a configured speed
dialling key to select the destination number.

no.to redirect

External phone number of the PBX to be forwarded (without exchange line
access number and with a area code)
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permanent config: Call forwarding for external numbers is enabled,
disabled or switched over in the permanent configuration.

current conf.: Call forwarding for external numbers is enabled, disabled or
switched over only in the current configuration.
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Call Restrictor (Incoming) — Robinson
Numbers

If there are certain persons who you absolutely do not want to call you, their
external phone numbers (Robinson numbers) can be assigned to a call
restrictor for incoming calls in the PBX. The call restrictor which applies to
all subscribers can be enabled on your own telephone as needed. If the call
restrictor is enabled, a caller, who transmitted one of the Robinson numbers,
is rejected.

Call Restrictor (Incoming) On/Off

Requirements:

* A call restrictor configured on the PBX and assigned to the subscriber

e Authorisation in the PBX for Controlling of the PBX using the
telephone

Proceed as follows:

¢ Using the telephone (function key or menu functions > Call Restrictor)

Function Key for Call Restrictor (Incoming)

Press the key to switch the subscriber's call restrictor on or off or to switch
it over.

In addition the status of the function is indicated by the corresponding LED.
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LED signalling on the key:
Red The call restrictor is enabled.

Off The call restrictor is disabled.

Note: When functions are defined on the second key level (optional, see
Technical Data in the Instructions), LED signalling is not available.

Requirements for operating the function:

* A call restrictor configured on the PBX and assigned to the subscriber

e Authorisation in the PBX for Controlling of the PBX using the
telephone

Proceed as follows by assigning the function key:

¢ Using COMfortel Set by selecting Call restrictor - incoming
(Robinson no.)

* Using the telephone by selecting Call Restrictor

Note: For further information about the general procedures when
assigning function keys, see Function Keys.
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Power Save Mode

In power save mode, the display lighting and the LEDs are inactive
(exception: the message LED blinks for missed calls).

After a configurable waiting time and depending on the configuration, power
save mode can be activated automatically during the switchover into a PBX
configuration and/or manually by pressing a key. Power save mode is
deactivated again as soon as an incoming call is signalled or any key is
pressed.

Automatic Activation of Power Save Mode

If automatic activation of power save mode is enabled, the telephone
automatically switches into power save mode when the telephone is not in
use.

The holding time (1 to 999 minutes) indicates how much time after the key
was last pressed before power save mode is activated.

Proceed as follows:

¢ Using COMfortel Set (page Settings/functions > Power save mode,
check box Automated activation and entry field Waiting time (1 to
999 minutes))

¢ Using the telephone (menu settings > power save mode >
autom.activation and menu settings > power save mode > idle time)
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Power Save Mode Activation Depending on Configuration

If configuration-dependent power save mode activation is enabled, the
telephone goes into power save mode during a switchover into a specific
PBX configuration (for example, a night configuration).

Note:

For operation on the PBXs COMpact 2206 USB and COMpact 4410
USB selection of more than one configuration is only possible using the
telephone.

To disable the configuration-dependent activation of power save mode,
you need to select --- in the list field or delete the identification number
of the configuration from the entry field.

Proceed as follows:

Using COMfortel Set (page Settings/functions > Power save mode,
list field Configuration or entry fields Configuration (10 to 9999))
Using the telephone (function key or menu settings > power save
mode > configuration)

Function Key for Manually Activating Power Save Mode

Pressing the key while in the telephone's idle state switches it immediately
into power save mode.
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LED signalling on the key:

None

Proceed as follows by assigning the function key:

e Using COMfortel Set by selecting Power save mode
* Using the telephone by selecting power save mode

Note: For further information about the general procedures when
assigning function keys, see Function Keys.

Power Save Mode Link to Phone Lock

If the power save mode link to the phone lock is enabled, the phone lock is
enabled as soon as the telephone changes to power save mode.

Proceed as follows:

¢ Using COMfortel Set (page Settings/functions > Power save mode,
check box Link to telephone lock)

e Using the telephone (menu settings > power save mode > phone
lock)
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Phone Lock

The phone lock can be used to block the telephone from unauthorised use.
Even after enabling the phone lock, it is possible to receive incoming calls
and to make emergency calls (manual dialling of emergency numbers
entered in the PBX only).

Phone Lock On

Requirements:

* Configured user PIN

Proceed as follows:

¢ Using the telephone (function key or menu functions > phone lock)

1. Enter the user PIN to activate the telephone lock.

Phone Lock Off

Requirements:

¢ Knowledge of the user, subadmin or admin PIN

¢ A function key configured for phone lock
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Proceed as follows:

* Using the telephone (function key)

Function Key for Phone Lock

Press the key on the telephone in the idle state and enter the user PIN to
enable the phone lock.

Press the key again and then enter the user PIN, sub-admin or admin PIN
to disable the phone lock again.

In addition the status of the function is indicated by the corresponding LED.
LED signalling on the key:

Red The phone lock is enabled.
Off The phone lock is disabled.

Note: When functions are defined on the second key level (optional, see
Technical Data in the Instructions), LED signalling is not available.

Requirements for operating the function:

¢ Configured user, subadmin or admin PIN
¢ For enabling the function: Knowledge of the user PIN

¢ For disabling the function: Knowledge of the user, subadmin or admin
PIN
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Proceed as follows by assigning the function key:

* Using COMfortel Set by selecting Phone lock
* Using the telephone by selecting phone lock

Note: For further information about the general procedures when
assigning function keys, see Function Keys.
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Text before Answering

The text before answering function enables the caller to be greeted with an
automatic announcement before accepting the call (charges apply for the
external caller).

Variants for Text before Answering

Text before answering for group

Important: Only available for operation on the PBXs COMpact 5010
VolP, COMpact 5020 VolP, COMpact 4000, COMpact 5000/R, COMpact
5200/R, COMpact 5500R and COMmander 6000/R/RX.

Note: With some PBXs the function is limited to external callers (see
Advanced Information of the PBX).

Switching the text before answering function on is done separately for each
group.
There are two types possible:

¢ Text before answering on busy

The caller hears the announcement for text before answering only if all
of the group members are busy. After this, the caller is automatically
connected to the corresponding queue.

e Text before answering always
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The caller hears the announcement independent of whether the group
members are being called or are busy. If all of the group members are
busy, the caller is automatically connected to the corresponding queue.

Text before answering for external number

Important: Only available for operation on the PBX COMpact 4410
USB.

Switching the text before answering function on is done separately for each
external number.

Text before Answering for Group On/Off

Important: Only available for operation on the PBXs COMpact 5010
VolP, COMpact 5020 VolP, COMpact 4000, COMpact 5000/R, COMpact
5200/R, COMpact 5500R and COMmander 6000/R/RX.

Requirements:

* Function key configured for the text before answering function

¢ A text before answering announcement present on the PBX and
assigned to the group

Proceed as follows:

e Using the telephone (function key)
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Function Key for Text before Answering for Group

Important: Only available for operation on the PBXs COMpact 5010
VolP, COMpact 5020 VolP, COMpact 4000, COMpact 5000/R, COMpact
5200/R, COMpact 5500R and COMmander 6000/R/RX.

Press the key while the telephone is the idle state to switch text before
answering for the configured group on or off or to switch it over.

In addition the status of the function is indicated by the corresponding LED.

LED signalling on the key:

Green The text before answering function for the configured
group is enabled.

Off The text before answering function for the configured
group is disabled.

Note: When functions are defined on the second key level (optional, see
Technical Data in the Instructions), LED signalling is not available.

Requirements for operating the function:

* The telephone is a member of a group configured in the PBX

* The text before answering announcement on the PBX and assigned to
the group

Proceed as follows by assigning the function key:

¢ Using COMfortel Set by selecting Text before answering
¢ Using the telephone by selecting text before answering
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Note: For further information about the general procedures when
assigning function keys, see Function Keys.

Additional settings for this function key are described in the following.

Configuration with COMfortel Set

Group number — Telephone no

Phone number of the group.

Configuration with the Telephone

Telephone no

Selection of the group by its name/its number.

Text before Answering for external number On/Off

Important: This function is only available for operation on the PBX
COMpact 4410 USB.
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Requirements:

* Function key configured for the text before answering function
* Text before answering announcement saved on the PBX
Proceed as follows:

e Using the telephone (function key)

Function Key for Text before Answering for external number

Important: This function is only available for operation on the PBX
COMpact 4410 USB.

Press the key while the telephone is the idle state to switch text before
answering for the configured phone number on or off or to switch it over.

In addition the status of the function is indicated by the corresponding LED.

LED signalling on the key:

Green The text before answering function for the configured
phone number is enabled.

Off The text before answering function for the configured
phone number is disabled.

Note: When functions are defined on the second key level (optional, see
Technical Data in the Instructions), LED signalling is not available.
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Requirements for operating the function:

* Text before answering announcement saved on the PBX

Proceed as follows by assigning the function key:

* Using COMfortel Set by selecting Text before answering
* Using the telephone by selecting text bef. answer menu

Note: For further information about the general procedures when
assigning function keys, see Function Keys.

Additional settings for this function key are described in the following.

Configuration with COMfortel Set

Your own exchange line — Telephone no

external number on the PBX.

Configuration with the Telephone

Telephone no

external number on the PBX.
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Door Functions

A door terminal connected with the interface of the PBX enables the
following functions. Calls to the door can be made from any telephone
(intercom). During a call to the door, the door can be opened (open door)
and a stairwell light controlled by switching a relay (switch on light).

These functions can be executed on the system telephone without initiating
a door call.

Performing Door Functions

Important: Not available for operation on the PBX COMpact 3000
analogue/ISDN/VolP.

Proceed as follows:

* Using the telephone

Requirements:

* The authority level assigned in the PBX for the door terminal

* The relays configured in the PBX for the intercom, opening the door and
the stairwell light

¢ Authorisation in the PBX for Open door

COMfortel 1200 - Firmware V2.2 - COMfortel Set V3.16 - Advanced Information V07 02/2019 257



Functions
Door Functions

In order to operate the door functions, press the function key configured for
door functions.

Alternatively, proceed as described below.

1. Press the Menu key and open the menu functions > door function.
2. Select the desired door based on its name/number.

3. Select one of the following options:
open door/light: Opens the door and switches the stairwell light on.
open door: Opens the door.
light on: Switches the stairwell light on.

talk: Establishes a call connection to the door.

Note: The door function light on switches on the relay of the door
terminal in question separately for the period configured in the PBX.

4. Press the OK key.

Own Telephone Rings (Door Call) — Accept Call and Open Door

Proceed as follows:

* Using the telephone
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Requirements:

* The authority level assigned in the PBX for the door terminal

* Therelays configured in the PBX for the intercom, opening the door and
the stairwell light

¢ Authorisation in the PBX for Open door

Proceed as described further down if you receive a door call.

1. Pick up the receiver or press the hook key.

2. Select open door/light and confirm with OK.

The door is opened. If the relay of the door terminal in question is used
for switching the stairwell light, this is also switched on for the period
configured in the PBX.

The door knocks — open the door without accepting the call

During a call, you can handle an incoming door call generally as you would
an incoming external subscriber. This means that you can accept the call,
reject it or ignore it. In addition, you can, if you do not want to interrupt your
current call, still open the door for the visitor by pressing the door opener.

Proceed as follows:

¢ Using the telephone
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Requirements:

* The authority level assigned in the PBX for the door terminal

* Therelays configured in the PBX for the intercom, opening the door and
the stairwell light

¢ Authorisation in the PBX for Open door

Proceed as described when a door calls.

1. Select open door/light and confirm with OK.

The door is opened. If the relay of the door terminal in question is used
for switching the stairwell light, this is also switched on for the period
configured in the PBX.

Function Key for Door Functions

Important: Not available for operation on the PBX COMpact 3000
analogue/ISDN/VolP.

Press the key for general functions while the telephone is in the idle state to
open the door function menu. After this, you can initiate a door function for
the configured door.

Press the key defined to initiate a call connection with the door (after picking
up the receiver) or to switch on the door opener and/or light.

In addition the status of the function is indicated by the corresponding LED.
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LED signalling on the key (only for defined key assignment):
Green The door opener function is enabled.

The door opener function is enabled and the light is
switched on (only when both functions are configured on
the key).

Yellow The light is switched on.

Off None of the functions configured on the key are enabled.

Note: When functions are defined on the second key level (optional, see
Technical Data in the Instructions), LED signalling is not available.

Requirements for operating the function:

* The authority level assigned in the PBX for the door terminal

* Therelays configured in the PBX for the intercom, opening the door and
the stairwell light

¢ Authorisation in the PBX for Open door

Proceed as follows by assigning the function key:

¢ Using COMfortel Set by selecting
— Door terminal function

— Defined door function

¢ Using the telephone by selecting

— door function
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Note: For further information about the general procedures when
assigning function keys, see Function Keys.

Additional settings for this function key are described in the following.

Configuration with COMfortel Set

Telephone no

Phone number of the door.

Door terminal function =

Open the door & switch on the light: Press the key to switch the door
opener and the light on.

Open the door: Press the key to switch the door opener on.
Light on: Press the key to switch the light on.

Talking: Press the key to initiate a call connection to the door.

Note: The door terminal function Light on switches on the relay of the
door terminal in question separately at the time configured in the PBX.

Configuration with the Telephone
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general: Press the key to open the door function menu for the door
configured.

defined: Press the key to execute the configured door function for the
configured door.

Telephone no

Phone number of the door.

open door/light: Press the key to switch the door opener and the light on.
open door: Press the key to switch the door opener on.
light on: Press the key to switch the light on.

talk: Press the key to initiate a call connection to the door.

Notes: The door terminal function Light on switches on the relay of the
door terminal in question separately at the time configured in the PBX.
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Speed Dialling

The speed dialling function enables a function key to be defined with not
only internal and external phone numbers but also with programming codes
on the PBX. The saved codes can be easily dialled by pressing a key, if
necessary.

Application Options for Speed Dialling Keys

Speed dialling keys can be used in the following ways:

Dialling a phone number

Pressing a speed dialling key immediately dials a saved phone number. If
the receiver is on hook, the saved phone number is first transmitted into dial
preparation.

If a speed dialling key is pressed during a call, a query call is placed and the
saved phone number is dialled immediately.

Dialling part of a phone number

The telephone speed dialling keys to be defined with parts of phone
numbers (for example, telephone provider prefixes). The phone number
parts can then be assembled by pressing multiple speed dialling keys in an
order. The names assigned to the phone numbers are shown one after the
other on the display.
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Assignment overview

Speed dialling keys defined with to internal subscriber and group phone
numbers enable an overview of the current activity status of the subscriber
or group via the corresponding LEDs.

Pickup and call take-over

Speed dialling keys defined with internal subscriber and group phone
numbers enable the pickup function for these subscribers and groups. If the
LED on the key is blinking in red because the saved phone number is being
called, you can take the call on your telephone by pressing the speed
dialling key and then confirming.

If a subscriber allows call take-over (for example, on an answering
machine), you can still take the call on your telephone in the same manner
even after it has already been accepted.

Function Key for Speed Dialling

Press the key while the telephone is in the idle state to transfer a phone
number saved in a key to dial preparation — also additional information.

Exception: If the phone number saved is an internal phone number and is
currently being called, you can carry out the Pickup function on this call.

After picking up the receiver, press the key to dial the phone number saved
in the key.

Press the key during a call to put the active communication partner on hold
and to dial the phone number saved in the key.

In addition, when a subscriber or a group number is defined, the status of
the subscriber or group can be read from the corresponding LED.
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LED signalling on the key (when defined with an internal subscriber

number):

Red
(blinking)

Red

Green
(blinking)

Yellow

Yellow
(blinking)

Off

The internal telephone is now being called. Press the key to
initiate a pickup.

The internal telephone is not reachable (a call is in progress
on the telephone or all of the corresponding voice channels
are in use). Press the key to initiate a call take-over, if
required.

A call is being made from the internal telephone and the call
was not accepted.

The internal telephone is not reachable (do-not-disturb or call
forwarding for subscribers has been configured).

Only for internal VolP subscriber and enabled display of the
registration status: The telephone is not registered on the
PBX.

The internal telephone is available. Press the key to place a
call.

LED signalling on the key (when defined with an internal group
phone number):

Red
(blinking)
Red

Yellow

Off

A logged-in telephone is now being called. Press the key to
initiate a pickup.

Calls are in progress on all logged-in telephones or no
telephone in the group is logged in.

The group is not available (call forwarding is configured for the
group).

The group is available. Press the key to place a call.
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LED signalling on the key (when defined with an external number):

Green A call is being made from the telephone of the external
(blinking) subscriber and the call was not accepted (in as far as the
external number is transmitted).

Note: When functions are defined on the second key level (optional, see
Technical Data in the Instructions), LED signalling is not available.

Proceed as follows by assigning the function key:

¢ Using COMfortel Set by selecting Speed dialling
e Using the telephone by selecting speed dialling

Note: For further information about the general procedures when
assigning function keys, see Function Keys.

Additional settings for this function key are described in the following.

Configuration with COMfortel Set

w

Destination of the call diversion — Telephone no

Destination number.

Note: Click a to accept a phone number from the telephone book in
the Telephone no entry field.
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Destination of the call diversion — Type of phone number =l

Marks the phone number as internal or external number.

Configuration with the Telephone

Telephone no

Destination number.

Note: If you press the telephone book key before entering the desti-
nation number, you can select the desired phone number from the
telephone book. Alternatively, you can press a configured speed
dialling key to select the destination number.

Important: If you must prefix e.g. an exchange line access number

when entering/selecting a phone number, depends on the exchange line
request (automatic, direct exchange line telephone, internal telephone)
that was configured in the PBX (see Advanced Information of the PBX).

Automatic Speed Dialling Pick-up

If automatic speed dialling pickup is enabled, pressing a speed dialling key
while the telephone is in the idle state automatically picks up a call (when
using a headset) or switches the telephone to hands-free calling.
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Proceed as follows:
* Using COMfortel Set (page Settings/functions > User settings, check
box Automatic off-hook for speed dialling)
¢ Using the telephone (menu settings > user settings > speed dial.key)

Display of the Registration Status

If the display of the registration status is switched on, the individual regis-
tration status of the subscribers will be signalled via the LEDs of the speed
dialling keys assigned to internal VoIP subscribers. If the corresponding
VolIP subscriber is not registered at the PBX, its LED will blink yellow.

Proceed as follows:

¢ Using COMfortel Set (page Settings/functions > signalling/ringer,
check box Registration status subscriber)

* Using the telephone (function key or menu settings > signalling >
reg.status scr.)
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Voice Mail and Fax Boxes of the
PBX

This section describes how to configure and operate voice mail and fax
boxes. Moreover, it shows you how to record announcements, execute
remote access, and forward messages, e.g. to a substitute.

Topics

— Voice Mail and Fax Boxes (page 271)

— Readiness of Voice Mail/Fax Boxes (page 284)

— Configuration-Dependent Control (page 287)

— Voice Memos in Voice Mailboxes (page 290)

— Distribution of Messages (page 292)

— Announcements for Voice Mailboxes (page 295)

— Remote Access to a Voice Mailbox (page 301)

— Message Forwarding from a Voice Mailbox (page 306)
— Substitute Function for Voice Mailboxes (page 309)
— Archives for Voice Mail and Fax Boxes (page 313)
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Voice Mail and Fax Boxes

A voice mail/fax box which is assigned to the telephone or to a group can be
operated like a local answering machine.

It saves the voice messages for an individual subscriber or a group and can
be queried any time by the subscriber or the members of the group.

Voice messages and announcements are not stored in the telephone but in
the PBX (in contrast to a local answering machine). The size of a voice mail/
fax box is determined by the PBX, as well as the authorisation to use it. A
voice mail/fax box can be assigned to an individual subscriber or to a group.
Moreover, a subscriber may be granted authorisation for several voice mail/
fax boxes.

Important:

Only available for operation on the PBXs COMpact 5010 VolP, COMpact
5020 VolP, COMpact 4000, COMpact 5000/R, COMpact 5200/R,
COMpact 5500R and COMmander 6000/R/RX.

For some PBX an optionally available module has to be inserted.
COMmander 6000/R/RX: COMmander VMF module

COMpact 5010 VolP: COMpact 2VolP module

COMpact 5020 VolP: COMpact 2VolP or 6VolP module
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Opening the Message List of a Voice Mail/Fax Box

Open the message list of a voice mail/fax box to query, replay, delete, move
messages into an archive or send a telefax as e-mail. If a subscriber is
authorised to query several voice mail boxes, the list VMB used will be
displayed in addition to the list voice mailbox. The list voice mailbox also
contains the fax boxes.

The LED of the message key indicates whether entries are present on the
message list.

Proceed as follows:

* Using the telephone

Requirements:

* Voice mail/fax box which is configured in the PBX and assigned to the
telephone

To open the message list of a voice mail/fax box, press the function key
configured for it or press the Menu key to open the menu Voice mailbox >
functions > VMB open.

Alternatively, proceed as described below.

1. Press the message key.

The available lists are displayed. To the left next to the selection of lists,
the respective numbers of existing messages are displayed.

2. Select one of the following options:

* VMB used (this is skipped if the other lists are empty)
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¢ voice mailbox > name of the voice mail/fax box

The following information about the message is shown on the display:

boice mailbox name] [fau box name]
Rlcaller] —H Dlcaller] 0
A————noo:o0:o0 < oo:on:1s—p——G . [nn pag ea].»._N
,lcall target]—M&—F L,[. all targetl—H&——M
ey  1/3 01.01.13 08:00 Qg ~ 1/3 [p1.01.13 D0B:00 g2,
I I | | [ I I
B Cc D E I J K L

Length of time the message has been replayed

B Type of message type: new message (%4 ), old message already
listened to (244

Note: The new messages are automatically replayed in sequence after
a voice mailbox is opened. The latest message is replayed first.

C Consecutive number of messages/number of existing messages

Note: The latest message is displayed with consecutive number 1.

Date of message
Time of message
Internal call destination

Entire length of the message

I @ M m O

Caller

Incoming/outgoing message

J  Consecutive number of messages/number of existing messages
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Note: The latest message is displayed with consecutive number 1.

Date of message
Time of message
Internal call destination

Number of pages

O z = r X

Caller

3. Select one of the following options:

“Z Pressing the delete key deletes the message.

Holding the delete key (2 seconds) deletes all messages from the
message list.

F  Voice mailbox only:
Pressing the arrow key right starts the replay of the message.
Il Voice mailbox only:

Pressing the arrow key left interrupts the replay of the message
(voice mailbox only).

Holding the arrow key left will go back to the start of the message.
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Pressing the arrow key down scrolls to next (older) message.
Voice mailbox only:
During playback: Skips the message currently being played back.

Pressing the arrow key up scrolls to the previous (more recent)
message.

Voice mailbox only:

During playback: Repeats the previous message or the one currently
being played back.

Voice mailbox only:
Pressing the OK key accepts the entry into dial preparation.
Fax box only:

Pressing the OK key sends the telefax as e-mail to the address
entered in the PBX as recipient of messages when a new voice mail
arrives.

If you want to leave the menu, press the home key.

Listening to Recordings

Proceed as follows:

Using the telephone

Requirements:

Voice mailbox which is configured in the PBX and assigned to the

telephone
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1. Open the message list of the box.
2. Press the arrow key up or down to scroll to the desired recording.

3. Press the arrow key right to start replaying the recording.

Note: You can also pickup the receiver to prevent others present from
listening.

The recording is replayed.

4. Select one of the following options:

“Zl Pressing the delete key deletes the displayed recording.

Holding the delete key (2 seconds) deletes all messages from the
message list.

F Pressing the arrow key right starts the replay of the recording.

Pressing the arrow key right again interrupts the replay of the
recording.

< Pressing the arrow key left will go back to the start of the recording.
m Pressing the arrow key down scrolls to next (older) recording
During playback: Skips the recording currently being played back.

Wi Pressing the arrow key up scrolls to the previous (more recent)
recording.

During playback: Repeats the previous recording or the one currently
being played back.

Dk Pressing the OK key accepts the entry into dial preparation.

5. If you want to leave the menu, press the home key.

Note: You can also access and listen to the recordings remotely.
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Sending a Telefax as E-mail

Received telefaxes can be sent as e-mail to the address entered in the PBX
as recipient of messages when a new voice mail arrives.

Proceed as follows:

e Using the telephone

Requirements:

* Fax box which is configured in the PBX and assigned to it
» Telefax received

1. Open the message box of the fax box.

2. Use the arrow keys A and W to scroll to the desired telefax and
confirm with OK.

The message Telefax has been sent as e-mail is displayed.

3. Confirm the message with OK.

You are back in the message list of the fax box.

Sending a Telefax again

Once sent telefaxes can be sent again.
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Proceed as follows:

* Using the telephone

Requirements:

* Fax box which is configured in the PBX and assigned to the telephone

* Telefax sent

1. Open the message box of the fax box.
2. Use the arrow keys A and WV to scroll to the desired telefax.

3. Press > and confirm with OK.

The message Telefax sent again is displayed. You are back in the
message list of the fax box.

Dialling from the Message List of the Voice Mailbox

Requirements:

* Voice mailbox which is configured in the PBX and assigned to the
telephone

1. Open the message list of the box.

2. Press the arrow key up or down to scroll to the desired recording and
confirm with OK.
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Note:

The number cannot be taken over into dial preparation as long as
switching between messages is performed.

A callback can only be made if the number of the caller has been trans-
ferred.

3. Pick up the receiver or press the hook key.

The subscriber is called.

Note: If you want to exit the menu without dialling the number displayed,
hang up the receiver or press the home key.

Deleting Messages

Proceed as follows:

* Using the telephone

1. Open the message list.

The message received last is displayed.

2. Press the delete key to the delete the message shown.

Note: To delete the entire message list, press and hold the delete key
for approx. 2 seconds and then confirm the action.
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Function Key to Open a Voice Mail/Fax Box

While the telephone is in the idle state, press the key generally assigned for
accessing the function and then pick up the receiver to establish a
connection to the voice mail/fax box. If you have been assigned several
boxes, a list of all boxes will be opened.

Press the defined and assigned key in the idle state of the telephone to set
up a connection to a defined box.

If you press the defined and assigned key during recording by a voice
mailbox, you an take over the call to a voice mailbox or open the assigned
voice mailbox.

Note: Press the function key again to switch from the message entry to
archive or vice versa.

In addition the status of the box is indicated by the corresponding LED.

LED signalling on the key (for general key assignment):

Green There are new messages in at least one box assigned to the

(blinking)  subscriber.

Green There are only messages which have already been listened to
in at least one box assigned to the subscriber.

Off There are no new messages in the boxes assigned to the
subscriber.

LED signalling on the key (for defined key assignment):

Red A new message is being recorded. After pressing the key the
call can be accepted by picking up the receiver.

Yellow The box is full.

(blinking)
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LED signalling on the key (for defined key assignment):

Yellow The fill level of the box has exceeded the warning limit.
Green There are new messages in the box.

(blinking)

Green There are only messages which have already been read/

listened to in the box

Off There are no new messages in the box.

Note: When functions are defined on the second key level (optional, see
Technical Data in the Instructions), LED signalling is not available.

Requirements for operating the function:

* Voice mail/fax box which is configured in the PBX and assigned to the
telephone

Proceed as follows by assigning the function key:

¢ Using COMfortel Set by selecting
— voice mailbox - open
— voice mailbox - open defined

* Using the telephone by selecting
— VMB open

Proceed as follows by assigning the function key:

¢ Using COMfortel Set by selecting
e Using the telephone by selecting
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Note: For further information about the general procedures when
assigning function keys, see Function Keys.

Additional settings for this function key are described in the following.

Configuration with COMfortel Set

Voice mailbox — Telephone no

Phone number of the box whose function shall be switched.

Configuration with the Telephone

Telephone no

Phone number of the box whose function shall be switched.

general: Press the key to open a selection list where the box to be opened
can be selected.

defined: Press the key to open the selected voice mailbox.

282 COMfortel 1200 - Firmware V2.2 - COMfortel Set V3.16 - Advanced Information V07 02/2019



Voice Mail and Fax Boxes of the PBX
Voice Mail and Fax Boxes

Attention Tone for Voice Mailbox

If the attention tone for the voice mailbox is switched on, the attention tone
indicates that there is a new message on the voice mailbox. The volume of
the attention tone depends on the volume set for the ringtone.

Proceed as follows:

* Using COMfortel Set (page Settings/functions > Signalling/ringer,
check box Attention tone (voice mailbox))

¢ Using the telephone (menu settings > signalling > attention tone,
check box voice mailbox)
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Readiness of Voice Mail/Fax Boxes

To enable the voice mail/fax box to accept calls and receive messages,
readiness must be enabled.

Readiness of Voice Mail/Fax Boxes On/Off

Note:You can also switch the readiness of voice mailboxes on and off
via remote access.

Requirements:

* Voice mail/fax box which is configured in the PBX and assigned to the
telephone

Proceed as follows:

* Using the telephone (function key or menu voice mailbox > functions
> VMB readiness)

Function Key for Readiness

Press the generally assigned key to permanently switch the readiness of a
voice mail/fax box to be selected on or off.
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Press the defined and assigned key to switch a previously defined voice
mail/fax box on or off or switch it over.

In addition the status of the function is indicated by the corresponding LED.

LED signalling on the key:
Green Readiness is enabled.

Yellow The readiness of at least one box has been switched off (only
in case of general assignment).

The readiness of the box is switched on, but the permanent
configuration is inactive (only in case of defined assignment).

Off Readiness is disabled.

Note: When functions are defined on the second key level (optional, see
Technical Data in the Instructions), LED signalling is not available.

Requirements for operating the function:

* Voice mail/fax box which is configured in the PBX and assigned to the
telephone

Proceed as follows by assigning the function key:

¢ Using COMfortel Set by selecting
— voice mailbox - readiness

— voice mailbox - readiness defined

* Using the telephone by selecting
— VMB readiness
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Note: For further information about the general procedures when
assigning function keys, see Function Keys.

Additional settings for this function key are described in the following.

Configuration with COMfortel Set

Voice mailbox — Telephone no

Phone number of the box whose function shall be switched.

Configuration with the Telephone

Telephone no

Phone number of the box whose function shall be switched.

general: Press the key to open a selection list where the box to be switched
can be selected.

defined: If you press the key, the selected box will be switched into
readiness mode.
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Configuration-Dependent Control

The readiness of the voice mail/fax box be switched on permanently. In
addition, however, there are alternative options. With the help of configu-
ration-dependent control, the box can be switched via the PBX configura-
tions, e. g. day-night switching.

Configuration-Dependent Control On/Off

Requirements:

* Voice mail/fax box which is configured in the PBX and assigned to the
telephone

* Configurations made in the PBX

Proceed as follows:

* Using the telephone (function key or menu voice mailbox > functions
> VMB config. control)

Function Key for Configuration-Dependent Control

Press the generally assigned key to enable configuration-dependent control
for a voice mail/fax box, which remains to be selected.

Press the defined and assigned key to enable configuration-dependent
control for a previously defined voice mail/fax box.
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In addition the status of the function is indicated by the corresponding LED.

LED signalling on the key:

Green Configuration-dependent control is enabled. The permanent
configuration is inactive.

Off Configuration-dependent control is disabled. The permanent
configuration is active.

Note: When functions are defined on the second key level (optional, see
Technical Data in the Instructions), LED signalling is not available.

Requirements for operating the function:

* Voice mail/fax box configured in the PBX and assigned to the telephone

¢ Configurations made in the PBX

Proceed as follows by assigning the function key:

¢ Using COMfortel Set by selecting
— voice mailbox - config.control

— voice mailbox - config.control defined

¢ Using the telephone by selecting
— VMB config. control

Note: For further information about the general procedures when
assigning function keys, see Function Keys.

Additional settings for this function key are described in the following.
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Configuration with COMfortel Set

Voice mailbox — Telephone no

Number of the box which is to be switched via the function key.

Configuration with the Telephone

Telephone no

Number of the box which is to be switched via the function key.

general: Press the key to open a selection list where the box to be switched
can be selected.

defined: Press the key to enable configuration-dependent control for the
selected voice mailbox.
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Voice Memos in Voice Mailboxes

You can use a voice mailbox to save your own voice memos. Up to 250
voice memos including date, time, and length of the recording can be saved
in the voice mailbox. The recordings are numbered consecutively, with the
last/latest recording assigned the number 1.

You can listen to, edit, and delete voice memos like any other messages.

Function Key for Recording Voice Memos in Voice Mailboxes

Press the key while the telephone is in the idle state to start recording a
voice memo.

In addition the associated LED indicates whether a voice memo is currently
being recorded.

LED signalling on the key:

Green Recording mode

Yellow Connection setup to the voice mailbox
(blinking)

Off The function is disabled.

Note: When functions are defined on the second key level (optional, see
Technical Data in the Instructions), LED signalling is not available.
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Requirements for operating the function:

* Voice mailbox which is configured in the PBX and assigned to the
telephone

Proceed as follows by assigning the function key:

¢ Using COMfortel Set by selecting voice mailbox - voice memo

¢ Using the telephone by selecting VMB voice memo

Note: For further information about the general procedures when
assigning function keys, see Function Keys.

Configuration with COMfortel Set

Telephone no

Phone number of the voice mailbox.

Configuration with the Telephone

Telephone no

Phone number of the voice mailbox.
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Distribution of Messages

The messages in a voice mail/fax box can be distributed to other voice mail/
fax boxes.

Function Key for Distributing Messages

Press the generally assigned key after calling a voice mail/fax box to
distribute messages to another box, which remains to be selected.

Press the defined and assigned key after calling a voice mail/fax box to
distribute messages to a previously defined box. Moreover, you can select
whether you want to move or copy your messages.

LED signalling on the key:

None

Requirements for operating the function:

* Voice mail/fax box which is configured in the PBX and assigned to the
telephone

Proceed as follows by assigning the function key:

¢ Using COMfortel Set by selecting
— voice mailbox - distribute messages
— voice mailbox - distribute messages defined

¢ Using the telephone by selecting

— VMB - distribute messages
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Note: For further information about the general procedures when
assigning function keys, see Function Keys.

Additional settings for this function key are described in the following.

Configuration with COMfortel Set

Voice mailbox — Telephone no

Number of the box to where messages are to be distributed.

move: Press the key to move messages. The messages in the box will be
deleted.

copy: Press the key to copy messages. The messages in the box remain
unchanged.

Configuration with the Telephone

Telephone no

Number of the box to where messages are to be distributed.

general: Press the key to open a selection list where the box to which the
messages are to be distributed can be selected.

defined: Press the key to distribute messages to the selected box.
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move: Press the key to move messages. The messages in the box will be
deleted.

copy: Press the key to copy messages. The messages in the box remain
unchanged.
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Announcements for Voice Mailboxes

For each assigned voice mailbox you can record announcements using the
telephone. You can replay, edit, and delete your own announcements. In
addition to the standard announcement from the voice files, maximally 10
own announcements can be stored per voice mailbox.

Create a New Announcement for a Voice Mailbox

Proceed as follows:

* Using the telephone

Requirements:

* Voice mail/fax box which is configured in the PBX and assigned to the
telephone

1. Press the Menu key and open the voice mailbox > settings > edit
announc. menu.

2. Select the voice mailbox from the list for which you want to record the
announcement.

3. If necessary, scroll to the next empty entry and confirm with OK.
4. Select change and confirm with OK to record an announcement.

5. Enter the name and confirm with OK.
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6.

Confirm again with OK to start recording the announcement.

The recording proceeds.
Record the announcement.

Confirm with OK to end recording the announcement.

Note:

You have the option of listening to the announcement that you have
recorded (by pressing the arrow key right).

Recordings with a recording time shorter than 3 seconds are discarded
by the telephone.

Confirm again with OK to save the recorded announcement in the
announcement list.

Note: If you want to switch on the announcement for the call acceptance
of the voice mailbox, press the OK key when the announcement is
displayed. Select switch on and press the OK key. By switching on
another announcement of the list or selecting switch off and pressing
the OK key you can switch off the announcement for the call acceptance
of the voice mailbox. If no announcement of the list is switched on, the
standard announcement is used for the call acceptance of the voice
mailbox.
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Edit an Existing Announcement for a Voice Mailbox

Proceed as follows:

¢ Using the telephone

Requirements:

* Voice mailbox which is configured in the PBX and assigned to the
telephone

Proceed as follows.

1. Press the Menu key and open the voice mailbox > settings > edit
announc. menu.

2. Select the voice mailbox from the list for which you want to edit an
announcement.

3. Scroll to the desired entry and confirm with OK.
4. Select change and confirm with OK to edit an announcement.
5. Overwrite the name, if necessary and confirm with OK.

6. Confirm again with OK to start recording the announcement.

The recording proceeds.
7. Record the announcement.

8. Confirm with OK to end recording the announcement.
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Note:

You have the option of listening to the announcement that you have
recorded (by pressing the arrow key right).

Recordings with a recording time shorter than 3 seconds are discarded
by the telephone.

9. Confirm again with OK to save the recorded announcement in the
announcement list.

Note: If you want to switch on the announcement for the call acceptance
of the voice mailbox, press the OK key when the announcement is
displayed. Select switch on and press the OK key. By switching on
another announcement of the list or selecting switch off and pressing
the OK key you can switch off the announcement for the call acceptance
of the voice mailbox. If no announcement of the list is switched on, the
standard announcement is used for the call acceptance of the voice
mailbox.

Delete an Existing Announcement for a Voice Mailbox

Proceed as follows:

* Using the telephone
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Requirements:

* Voice mail/fax box which is configured in the PBX and assigned to the
telephone

Proceed as follows.

1. Press the Menu key and open the voice mailbox > settings > edit
announc. menu.

2. Select the voice mailbox from the list for which you want to delete an
announcement.

3. Scroll to the desired entry.

4. Press the delete key and confirm with OK.

Call Information for New Voicemail Messages

If call information is switched on for a new message, the subscriber will be
informed when the call was received before the message is replayed.

Requirements:

* Voice mailbox which is configured in the PBX and assigned to the
telephone

Proceed as follows:

¢ Using the telephone (menu voice mailbox > settings > call infor-
mation)
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Separator Tone for New Voicemail Messages

If the separator tone is switched on for new messages, a tone will be
replayed after each message when listening to several new messages. This
makes it easier to distinguish the individual messages from each other.

Requirements:

* Voice mail/fax box which is configured in the PBX and assigned to the
telephone

Proceed as follows:

* Using the telephone (menu voice mailbox > settings > separator
tone)
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Remote Access to a Voice Mailbox

Remote access is used to access and operate the voice mailbox from an
internal telephone or from an external telephone.

Executing Remote Access to a Voice Mailbox

Proceed as follows:

* Using a character string on an external telephone
* Using a character string on the internal telephone

Requirements:

* Voice mailbox which is configured in the PBX

1. Call the voice mailbox.

The voice mailbox accepts the call. You hear the configured
announcement.

2. Dial *.

Note: If the querying internal telephone is the owner/user of the voice
mailbox, step 3 will be omitted.

3. Enter the user PIN or the PIN for remote access and dial #.

COMfortel 1200 - Firmware V2.2 - COMfortel Set V3.16 - Advanced Information V07 02/2019 301



Voice Mail and Fax Boxes of the PBX
Remote Access to a Voice Mailbox

Remote access is started. You are led through the remote access menu
with the help of various announcements.
4. Execute remote access by entering the following digits.
0: Opens the Help menu.
1. Opens the main menu.
: Replays new messages.
: Replays all of the messages.
: Jumps back to the previous message.
: Repeats the message currently being replayed.
: Jumps to the next message.

: Deletes the message currently being replayed.

0 N o a0 A~ W DN

: Ends replay.
*10: Disables the voice mailbox.
* 11: Enables the voice mailbox.

* 20: Permits recording and exchanging announcements.

Note: The default announcement and your own announcements, if any
have been recorded, will be played back. The following functions are
available while your own announcements are being played back:

# selects the currently heard announcement as active announcement.
4 jumps to the previous announcement.
5 repeats the announcement you have just heard.

6 jumps to the next announcement.
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7 selects the currently heard or free announcement for changing or
recording. Press # to save your announcement or * to cancel the
function.

* 30: Disables message forwarding.

* 31: Enables message forwarding.

* 70: Deletes all messages and voice memos.
*99: Records a voice memo.

Hang-up: Ends remote access.

Note:By dialling 9 while a message is being replayed, the phone number
of the caller will be displayed — provided it has been transferred. By
pressing the# key, you can initiate a callback to the phone number of the
caller.

Remote Access to a Voice Mailbox On/Off

Requirements:

* Voice mail/fax box which is configured in the PBX and assigned to the
telephone

Proceed as follows:

¢ Using the telephone (function key or menu voice mailbox > functions
> VMB remote access)
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Function Key for Remote Access to a Voice Mailbox

Press the generally assigned key to switch the remote access for a voice
mailbox to be selected on or off or switch it over.

Press the defined and assigned key to switch the remote access for a
defined voice mailbox on or off or switch it over.

In addition the status of the function is indicated by the corresponding LED.

LED signalling on the key:
Green Remote access is enabled.

Yellow The remote access to at least one voice mailbox has been
switched off (only in case of general assignment).

Off Remote access is disabled.

Note: When functions are defined on the second key level (optional, see
Technical Data in the Instructions), LED signalling is not available.

Requirements for operating the function:

* Voice mailbox which is configured in the PBX and assigned to the
telephone

Proceed as follows by assigning the function key:

¢ Using COMfortel Set by selecting
— voice mailbox - remote access

— voice mailbox - remote access defined

¢ Using the telephone by selecting
— VMB rem. access
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Note: For further information about the general procedures when
assigning function keys, see Function Keys.

Additional settings for this function key are described in the following.

Configuration with COMfortel Set

Voice mailbox — Telephone no

Number of the voice mailbox which is to be switched via the function key.

Configuration with the Telephone

Telephone no

Number of the voice mailbox which is to be switched via the function key.

general: Press the key to open a selection list where the box to be switched
can be selected.

defined: Press the key to configure remote access for a selected voice
mailbox.
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Message Forwarding from a Voice
Mailbox

Message forwarding enables the voice mailbox to notify you of new
messages.

Message Forwarding from a Voice Mailbox On/Off

Requirements:

* Voice mailbox which is configured in the PBX and assigned to the
telephone

* The destination for message forwarding of the voice mailbox configured
in the PBX

Proceed as follows:

* Using the telephone (function key or menu voice mailbox > functions
> VMB forwarding)

Function Key for Message Forwarding from a Voice Mailbox

Press the generally assigned key to switch the message forwarding for a
voice mailbox to be selected on or off or switch it over.

Press the defined and assigned key to switch message forwarding for a
defined voice mailbox on or off or switch it over.

In addition the status of the function is indicated by the corresponding LED.
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LED signalling on the key:

Green Message forwarding is enabled.

Yellow The message forwarding for at least one voice mailbox has
been switched off (only in case of general assignment).

Off Message forwarding is disabled.

Note: When functions are defined on the second key level (optional, see
Technical Data in the Instructions), LED signalling is not available.

Requirements for operating the function:

* Voice mailbox which is configured in the PBX and assigned to the
telephone

* The destination for message forwarding of the voice mailbox configured
in the PBX

Proceed as follows by assigning the function key:

¢ Using COMfortel Set by selecting
— voice mailbox - message forwarding
— voice mailbox - message forwarding defined

¢ Using the telephone by selecting
— VMB forwarding

Note: For further information about the general procedures when
assigning function keys, see Function Keys.

Additional settings for this function key are described in the following.
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Configuration with COMfortel Set

Voice mailbox — Telephone no

Number of the voice mailbox which is to be switched via the function key.

Configuration with the Telephone

Telephone no

Number of the voice mailbox which is to be switched via the function key.

general: Press the key to open a selection list where the box to be switched
can be selected.

defined: Press the key to configure message forwarding for a selected
voice mailbox.
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Substitute Function for Voice
Mailboxes

If the substitute function is switched on, the caller can be connected with the
substitute instead of leaving a message on the voice mailbox. For this
purpose, the caller dials "1" during the announcement or recording phase.

You have to include this information ("You can reach my substitute by
dialling the digit 1...") into the announcement yourself by recording it via an
own announcement.

Substitute Function for Voice Mailboxes On/Off

Requirements:

* Voice mailbox which is configured in the PBX and assigned to the
telephone

* The substitute function configured in the PBX for the voice mailbox

* Recorded announcement for the voice mailbox (see Advanced Infor-
mation of the PBX)

Proceed as follows:

* Using the telephone (function key or menu voice mailbox > functions
> VMB substitute)

Important: If you must prefix e.g. an exchange line access number

when entering/selecting a phone number, depends on the exchange line
request (automatic, direct exchange line telephone, internal telephone)
that was configured in the PBX (see Advanced Information of the PBX).
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Function Key for the Substitute Function for Voice Mailboxes

Press the generally assigned key to switch the substitute function for a voice
mailbox to be selected on or off or switch it over.

Press the defined and assigned key to switch the substitute function for a
previously defined voice mailbox on or off or switch it over.

In addition the status of the function is indicated by the corresponding LED.

LED signalling on the key:

Green The substitute function is enabled.

Yellow The substitute function for at least one voice mailbox has
been switched off (only in case of general assignment).

Off The substitute function is disabled.

Note: When functions are defined on the second key level (optional, see
Technical Data in the Instructions), LED signalling is not available.

Requirements for operating the function:

* Voice mail/fax box which is configured in the PBX and assigned to the
telephone

¢ The substitute function configured in the PBX for the voice mailbox

¢ Recorded announcement for the voice mailbox (see Advanced Infor-
mation of the PBX)

Proceed as follows by assigning the function key:

¢ Using COMfortel Set by selecting

— voice mailbox - substitute
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— voice mailbox - substitute defined

* Using the telephone by selecting
— VMB substitute

Note: For further information about the general procedures when
assigning function keys, see Function Keys.

Additional settings for this function key are described in the following.

Configuration with COMfortel Set

Voice mailbox — Telephone no
Number of the voice mailbox.
Substitute — Telephone no

Number of the substitute.

Configuration with the Telephone

Telephone no
Number of the voice mailbox.
VMB substitute — Telephone no

Number of the substitute.
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general: Press the key to open a selection list where the box to be switched
can be selected.

defined: Press the key to configure the substitute function for a selected
voice mailbox.
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Archives for Voice Mail and Fax Boxes

Messages which you want to remove from the message list of a voice mail
or fax box without deleting them can be moved to the archive.

Moving a Message into the Archive of a Voice Mail/Fax Box

Requirements:

Voice mail/fax box which is configured in the PBX and assigned to the
telephone

Message existing in the voice mail/fax box

Function key assigned to VMB distr. mess - defined to the number of
the voice mail/fax box

Note: The switching type assigned to the function key must be move. It
is not possible to copy a message to the archive.

Open the message list of the box.
Press the arrow key up or down to scroll to the desired message.

Press the function key assigned to VMB distr.mess - defined.

The message is deleted from the message list and moved to the
archive.
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Opening the Archive of a Voice Mail/Fax Box
Requirements:

* Voice mail/fax box which is configured in the PBX and assigned to the
telephone

* Message existing in the voice mail/fax box
* Function key assigned to VMB open - general or VMB open - defined

1. Open the message list of the box.

2. Press the function key assigned to VMB open - general or VMB open
- defined.

The message list of the box opens.

Note: The symbol in the first line of the box indicates that the archive is
open.

Deleting Messages from the Archive of a Voice Mail/Fax Box

Proceed as follows:

e Using the telephone

1. Open the message list.

The message received last is displayed.
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2. Press the delete key to the delete the message shown.

Note: To delete the entire archive, press and hold the delete key for
approx. 2 seconds and then confirm the action.
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Settings
This section describes how to configure and manage your telephone.

Topics

— Identification (page 317)

— Protection from Unauthorised Access (page 318)
— Display and Backlight (page 325)

— Casing LED (page 329)

— Call Signalling (page 334)

— Ringtones (page 338)

— Call Charges (page 344)

— Receiver and Headset (page 345)

— Menu and Function Keys (page 349)
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Identification

The telephone must be uniquely identified on the PBX.

MSN

In order for the PBX to identify the telephone, the internal number (MSN) for
the telephone must be entered.

Important: Use each of the internal subscriber numbers for only one of
the devices.

Requirements:

¢ Entered internal number in the configuration of the PBX

Proceed as follows:

e Using the configuration manager (page Settings/functions > Basic
settings, entry field Internal number)

¢ Using the telephone (menu settings > def. settings > MSN)
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Protection from Unauthorised Access

In order to prevent important settings from being changed accidentally or by
unauthorised people, the telephone can be protected from unauthorised
access.

When operating the PBXs COMpact 3000 analogue/ISDN/VolP, COMpact
5010 VolP, COMpact 5020 VolP, COMpact 4000, COMpact 5000/R,
COMpact 5200/R, COMpact 5500R and COMmander 6000/R/RX, access
to the telephone is subdivided into four authorisation levels:

* Administrator (access via admin PIN on the PBX)

e Sub-administrator (access via one of the four sub-admin PINs on the
PBX)

e User (access via user PIN assigned to subscriber)

¢ Guests (unprotected access)

The PINs are transmitted from the PBX and cannot be changed in the
telephone itself.

When operating on the PBXs COMpact 2206 USB and COMpact 4410 USB,
access to the telephone is subdivided into two authorisation levels:

e User (access via user PIN)

¢ Guests (unprotected access)

The user PIN is configured in the telephone.
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Configuring User PIN

Important: Only available when operated on the PBXs COMpact 2206
USB and COMpact 4410 USB.

Proceed as follows:

¢ Using the telephone menu

1. Pressthe Menu key and open the menu settings > blocking > change
user PIN.

2. Enter the user PIN and confirm with OK.

3. Enter the user PIN for a second time and confirm with OK.

Note: You can delete the PIN by not entering any PIN in both menus but
by confirming OK.

Configuring a Function Lock

The functions available in the function menu and key definition menu can be
blocked from unauthorised use. The display of these restricted functions in
the selection list requires entering the corresponding PIN after selecting
additional at the end of the selection list.
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Note: A function key defined with a restricted function cannot be used
with out entering a PIN. This means that the administrator can,

for example, enable the switching on/off of a specific call forwarding
configuration via the function key even though the ability to configure any
number of call forwarding configurations is restricted.

Proceed as follows:

e Using COMfortel Set
* Using the telephone

Using COMfortel Set to Configure the Function Lock

1. Open the page Settings/functions > Restrictions.
2. Click the Telephone menu functions tab.

3. Select one of the following options for the function to be blocked.
No restrictions: The function is not blocked.
Guests: Blocks the function in question from guests.
Guests + users: Blocks the function in question from guests and users.

Guests + users + Sub-Admin: Blocks the function in question from
guests, users and sub-administrators.

If you want to restrict all of the functions, select one of the following
options under All - restricted for.

No restrictions: No function is blocked.
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Guests: Blocks all functions for guests.
Guests + users: Blocks all functions for guests and users.

Guests + users + Sub-Admin: Blocks all functions for guests, users
and sub-administrators.

Using the Telephone to Configure the Function Lock

1. Press the Menu key and open the menu settings > blocking >
additional > function lock.

Note: After selecting additional follows entering of the corresponding
PIN.

The === symbol indicates no blocking.
The #== symbol indicates that guests are blocked.
The **= symbol indicates that guests and users are blocked.
The *** symbol indicates that guests, users and sub-administrators are
blocked.
2. Select the function to be blocked.

The menu for restricting the selected function is opened.

3. Enable one of the following options:

' Sub Admin: Blocks the function in question from guests, users and
sub-administrators.
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B user: Blocks the function in question from guests and users.
E'  guests: Blocks the function in question from guests.

B no blocking: The function is not blocked.

4. Confirm with OK to end the configuration for this function.

The modified settings are displayed, and you can select another
function.

5. Confirm again with OK.

Configuring Settings Lock

The settings that can be selected in the settings menu can be restricted from
unauthorised use. The display of these restricted settings in the selection list
requires entering the corresponding PIN after selecting additional at the
end of the selection list.

Proceed as follows:

¢ Using COMfortel Set

e Using the telephone

Using COMfortel Set to Configure the Settings Lock

1. Open the page Settings/functions > Restrictions.

2. Click the Telephone menu settings tab.
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3. Select one of the following options for the setting to be blocked.
No restrictions: The setting is not blocked.
Guests: Blocks the setting in question from guests.
Guests + users: Blocks the setting in question from guests and users.

Guests + users + Sub-Admin: Blocks the setting in question from
guests, users and sub-administrators.

If you want to restrict all of the settings, select one of the following
options under All - restricted for.

No restrictions: No settings are blocked.
Guests: Blocks all settings for guests.
Guests + users: Blocks all settings for guests and users.

Guests + users + Sub-Admin: Blocks all settings for guests, users and
sub-administrators.

Using the Telephone to Configure the Settings Lock

1. Press the Menu key and open the menu settings > blocking >
additional > settings lock.

Note: After selecting additional follows entering of the corresponding
PIN.

The === symbol indicates no blocking.
The *== symbol indicates that guests are blocked.

The **= symbol indicates that guests and users are blocked.
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The *+* symbol indicates that guests, users and sub-administrators are
blocked.
2. Select the setting to be blocked.

The menu for blocking the selected setting is opened.

3. Enable one of the following options:

Ef  Sub Admin: Blocks the setting in question from guests, users and
sub-administrators.

B user: Blocks the setting in question from guests and users.
B  guests: Blocks the setting in question from guests.

' no blocking: The setting is not blocked.

4. Confirm with OK to end the configuration for this setting.

The modified settings are displayed, and you can select another setting.

5. Confirm again with OK.
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Display and Backlight

Language of the Telephone

This setting specifies the language used on the telephone display.

Note: To open the language menu, you can also press the Menu key,
# and 0 in that order.

Proceed as follows:

¢ Using COMfortel Set (page Settings/functions > Basic settings, list
field Display language)
* Using the telephone (menu settings > def. settings > language)

Display Backlight

The display backlight on the telephone can be adapted according to
individual work place requirements.

automatically: As soon as a key is pressed, the receiver is picked up or the
telephone is called, the backlight is switched on (brightness max.) and
remains in this state afterwards for short transitional period. Otherwise, the
backlight remains on a standby level (brightness min.).
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Permanently switched on during a call: In addition to the times available
in the automatically selection, the backlight remains switched on for the
entire duration of a call and afterwards for a short transitional period.

Proceed as follows:

* Using COMfortel Set (page Settings/functions > Display, list field
Display backlight)

¢ Using the telephone (menu settings > display > display light)

Brightness

Requirements:

* Enabled display backlight
Proceed as follows:

* Using the telephone (menu settings > display > brightness (min) or
brightness (max))

Note: Press the right or left navigation key to configure the desired
brightness on the display.
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Adjusting Contrast

Proceed as follows:

¢ Using the telephone

1. Pressthe Menu key and open the menu settings > display > contrast.

2. Pressthe arrow key left = orright * to configure the desired contrast
and confirm with OK.

Switching the Inverse Display View On/Off

If the inverse display view is switched on, the text on the display is light-
coloured and the background is dark.

Proceed as follows:

¢ Using COMfortel Set
* Using the telephone

Using COMfortel Set to Switch Inverse Display View On/Off

1. Open the page Settings/functions > Display.

2. Select or clear the Inverse display view check box.
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Using the Telephone to Switch Inverse Display View On/Off

1. Press the Menu key and open the menu settings > display > inverse
view.

2. Select or clear the inverse view check box and confirm with OK.

Showing of Names Only

If showing of only names for lists/calls is switched on, only the name of the
call partner (if known) is displayed for incoming external calls and in caller,
calls and redial lists.

If showing of only names for calls/lists is switched off, the phone number and
the name of the call partner are shown alternately.

Proceed as follows:

* Using COMfortel Set (page Settings/functions > Display, check box
For lists/calls show names only)

¢ Using the telephone (menu settings > display > lists/calls)
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Casing LED

Configuring the Casing LED

The casing LED provides information about the telephone's operating mode
and missed calls.

If you find the LED signalling disruptive or bothersome, it can be switched
off. A variety of settings are possible:

LED Signalling during Configuration: Show Alerting, Calls and
Entries in the Caller List

Red The telephone is on a call.
Red (blinking) New entries in the caller list are present.

Red (flashing) The telephone is being called.
+ alternating
pauses)

Off The telephone is neither being called, nor is it on a call,
and there are no new messages.

LED Signalling during Configuration: Show Alerting and Calls
Red The telephone is on a call.

Red (flashing) The telephone is being called.
+ alternating
pauses)

Off The telephone is neither being called, nor is it on a call.
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LED Signalling during Configuration: Always off
Off LED is switched off.

Proceed as follows:

¢ Using COMfortel Set
e Using the telephone

Using COMfortel Set to Configure the Casing LED

1. Open the page Settings/functions > Signalling/ringer.

2. Inthe list Casing LED, select one of the following options:

Show Alerting, Calls and Entries in the Caller List: Indicates alerting,
calls and entries in the caller list.

Show Alerting and Calls: Indicates alerting and calls.

Always off. Switches off LED signalling.

Using the Telephone to Configure the Casing LED

1. Press the Menu key and open the menu settings > signalling >
message LED.

2. Select one of the following options:
Call,message: Indicates alerting, calls and entries in the caller list.

Call, acc.call: Indicates alerting and calls.
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Always off. Switches off LED signalling.

3. Press the OK key.
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Date and Time

Time Format

This setting specifies the format in which time is depicted on the display.

HH.MM: Selects the time format in the order of hour, minute separated by a
point.

HH:MM: Selects the time format in the order of hour, minute separated by a
colon.

Proceed as follows:

¢ Using COMfortel Set (page Settings/functions > Display, list field
Time format)

* Using the telephone (menu settings > display > time format)

Date Format

The date format selected here is displayed, for example, in the caller and
calls lists.

DD.MM.YY: Selects the date format in the order of day, month, year
separated by points.

DD/MM/YY: Selects the date format in the order of day, month, year
separated by slashes.
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DD-MM-YY: Selects the date format in the order of day, month, year
separated by hyphens.

YY-MM-DD: Selects the date format in the order of year, month, day
separated by hyphens.

Proceed as follows:

¢ Using COMfortel Set (page Settings/functions > Display, list field
Format of the date)

* Using the telephone (menu settings > display > date format)

Adjustment from winter and summer time

The time is converted automatically from winter time to summer time and
vice versa (GMT +1:00 or GMT +2:00) on the appropriate dates.

This feature can be switched off and on.

Proceed as follows:

* Using the telephone (menu settings > def.settings > auto CET/CEST)
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Call Signalling

The system telephone can signal incoming calls as follows:

* Ring signal (the telephone rings with a configured ringtone)
e Display message (text)

* Display backlight

» Display backlight with flashing signal

Ring Signal

If the ring signal is enabled, calls are acoustically signalled by a ring signal.
If you don't want your environment to be disturbed by the ringer on the
telephone, you can switch off the ring signal.

This function is different than the do-not-disturb function on the PBX in that
calls are still possible. However, they are no longer signalled acoustically
but rather visually.

Proceed as follows:

¢ Using COMfortel Set (page Settings/functions > Signalling/ringer,
check box Ring signal)

* Using the telephone (menu functions > call signal/light)
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Function Key for Ring Signal

Press the key to switch the ring signal on or off or to switch it over.

Press the key during an incoming call to switch the ring signal on or off for
this call or to switch it over.

In addition the status of the function is indicated by the corresponding LED.
LED signalling on the key:

Off The ring signal is enabled.
Red The ring signal is disabled.

Note: When functions are defined on the second key level (optional, see
Technical Data in the Instructions), LED signalling is not available.

Proceed as follows by assigning the function key:

* Using COMfortel Set by selecting Ring signal
* Using the telephone by selecting ringer tone

Note: For further information about the general procedures when
assigning function keys, see Function Keys.
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Flashing Display Backlight for Call Signalling

If you don't want your environment to be disturbed by the ringer on the
telephone, you can signal calls instead by having the display backlight flash
(in addition to the other visual signals). Depending on the brightness in the
room, this can be a highly noticeable visual signal.

Warning: Certain blinking frequencies can possibly trigger
epileptic seizures. Those suffering from or in danger of
epileptic seizures should therefore avoid using this function.

Proceed as follows:

* Using COMfortel Set (page Settings/functions > Signalling/ringer,
check box Call signal/light)

¢ Using the telephone (menu functions > call signal/light)

Function Key for Call Signalling by Flashing Display Backlight

Press the key while in the telephone's idle state to switch call signalling by
the flashing display backlight on or off or to switch it over.

In addition the status of the function is indicated by the corresponding LED.

LED signalling on the key:
Off Call signalling by a flashing display backlight is disabled.
Red Call signalling by a flashing display backlight is enabled.
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Note: When functions are defined on the second key level (optional, see
Technical Data in the Instructions), LED signalling is not available.

Proceed as follows by assigning the function key:

¢ Using COMfortel Set by selecting Call signal/light
¢ Using the telephone by selecting call signal/light

Note: For further information about the general procedures when
assigning function keys, see Function Keys.
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Ringtones

Determining Different Types of Calls

There are 8 different ringtones available to differentiate between call types.

The ringtones can be assigned to different kinds of calls, callers or call desti-
nations. You can make the assignments depending on what information you
think is the most important. Configure the settings as follows:

* If you want to differentiate between the different kinds of calls by using
different ringtones, configure the corresponding settings using the
telephone or using COMfortel Set. The following kinds of calls are
available for this:

— Alarm calls

— External calls

— Internal calls

— Call for group (a call directed to a group)

— InterCom calls

— External callback calls

— Internal callback calls

— Scheduled calls

— Door calls

— Call deblocker calls (calls enabled despite do-not-disturb)

— Wake-up calls
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— Others

* You can differentiate between callers by using different ringtones. Enter
the phone number of the subscribers to a local telephone book and
assign a unique ringtone to each respective subscriber (the prerequisite
for this function is that the caller transmits his phone number).

e If you want to be notified, using different ringtones, which of your

external numbers the caller dialled, configure the corresponding
settings using COMfortel Set.

Important: Only available for operation on the PBXs COMpact 3000
analogue/ISDN/VolP, COMpact 5010 VolP, COMpact 5020 VolIP,
COMpact 4000, COMpact 5000/R, COMpact 5200/R, COMpact 5500R
and COMmander 6000/R/RX.

* If you want to be notified, using different ringtones, which of your groups
is being called by the caller, configure the corresponding settings using
COMfortel Set.

As external, internal and door calls can be affected by more than one of
these four settings, these call types are signaled based on a predetermined
sequence (priority list). When this is done, the caller is always identified first.
If no specific ringtone has been configured for the caller, the external
number or group number dialled by the caller is checked. If no specific
ringtone has been configured for this either, the ringtone of the call type is
used.

Priority List for External Calls

1. The ringtone defined in the telephone book, in as far as the caller can
be identified as a telephone book entry

COMfortel 1200 - Firmware V2.2 - COMfortel Set V3.16 - Advanced Information V07 02/2019 339



Settings
Ringtones

2.

For the ringtone configured for the call type call deblocker, in as much
as the caller can be identified even when he has do-not-disturb enabled
as a part of a call deblocker

For a ringtone configured for a certain external number, in as much as
the phone number was dialled by the caller

For the ringtone configured for a certain group number, in as much as
the group is called

For the ringtone configured for a certain call type group calling, in as
much as a non-specified group is called

For the ringtone for the call type external calls

Priority List for Internal Calls

1.

The ringtone defined in the telephone book, in as far as the caller can
be identified as a telephone book entry

For the ringtone configured for a certain group number, in as much as
the group is called

For the ringtone configured for a certain call type group calling, in as
much as a non-specified group is called

For the ringtone for the call type internal calls

Priority List for Door Calls

1.

2.

The ringtone defined in the telephone book, in as far as the door
terminal can be identified as a telephone book entry

For the ringtone for the call type door call
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Configuring Ringtones

You have the option of assigning the several call types each a specific
ringtone using the telephone.

In addition to making call type-dependent assignments, COMfortel Set can
also be used to configure which ringtone to assign to each of 10 separate
external numbers or groups depending on the number.

Proceed as follows:

¢ Using COMfortel Set
* Using the telephone

Using COMfortel Set to Configure Call Type-dependent Ringtones

1. Open the page Settings/functions > Signalling/ringer.
2. Click the Ringtones (call type-dependent) tab.

3. Select the desired ringtone from the list field of call types in question.

Using COMfortel Set to Configure Number-dependent Ringtones

1. Open the page Settings/functions > Signalling/ringer.

2. Click the Ringtones (number-dependent) tab.
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3.

In the Group number 1 to Group number 10 entry field, enter the
phone numbers of the group and select the desired ringtone from the list
field.

In the external numbers 1 to external numbers 10 entry field, enter
each of your external numbers and select the desired ringtone in the list
field.

Important: Only available for operation on the PBXs COMpact 3000
analogue/ISDN/VolP, COMpact 5010 VolP, COMpact 5020 VolP,
COMpact 4000, COMpact 5000/R, COMpact 5200/R, COMpact 5500R
and COMmander 6000/R/RX.

Using the Telephone to Configure Call Type-dependent Ringtones

1.

Press the Menu key and open the menu settings > signalling >
ringtone.

Select the desired call type.

You hear the currently configured ringtone. The associated name is
shown in the display.

Press the arrow key up or down to select the desired ringtone.
You hear the displayed ringtone to see if you like it.

Select the desired test volume by pressing the plus/minus key and
confirm with OK.
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Note: At this point, you can only change the volume during testing. To
change the volume of the actual ringtone, press the plus/minus keys in
the idle state of the telephone.

You now have option of configuring the ringtone for another call type.

Ringer Volume Automatically

You can increase and decrease the ringer volume on the telephone
automatically. The telephone starts to ring at the volume you configured and
increases/decreases this every 5 seconds by one level until it reaches the
maximum/minimal volume.

Constant ringer volume / steady: Selects a steady volume during the
entire calling phase.

Increase the ringer volume automatically / autom.increase: Selects an
automatic increase in the volume during the calling phase.

Reduce the ringer volume automatically / auto-reduction: Selects an
automatic decrease in the volume during the calling phase.

Single tone / single ringtone: Selects a single quiet tone instead of the
ringtones configured.

Proceed as follows:

¢ Using COMfortel Set (page Settings/functions > Signalling/ringer,
list field Ringer volume)

* Using the telephone (menu settings > signalling > ringer volume)

COMfortel 1200 - Firmware V2.2 - COMfortel Set V3.16 - Advanced Information V07 02/2019 343



Settings
Call Charges

Call Charges

To calculate call charges, the currency of the country as well as the cost per
call unit must be configured in COMfortel Set.

Currency

Proceed as follows:

¢ Using COMfortel Set (page Settings/functions > Basic settings, entry
field Currency (max. 3 characters))

Cost per Call Unit

You can enter up to 4 digits, for example, 6 for 6 cent.

Note: If you configure your telephone as room telephone, the value for
cost per call unit should match the value configured in the PBX.
Otherwise misunderstandings might occur regarding final invoice
because the value configured in the PBX is used for calculating the cost
of calls.

Proceed as follows:

¢ Using COMfortel Set (page Settings/functions > Basic settings, entry
field Cost per call unit (1-9999 currency subunits))
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Receiver and Headset

Receiver Volume

Whenever necessary, the microphone volume of the receiver can be
increased or decreased.

Note: Press the right or left navigation key to configure the desired
microphone volume.

Proceed as follows:

* Using the telephone (menu settings > def. settings > receiver
volume)

Headset Operation On/Off

If you have connected a headset to your system telephone and selected it,
you can switch between receiver and headset operation.

The telephone detects the connection of a headset and, in this case, the
telephone switches the headset operation on. The telephone detects the
disconnection of a headset and, in this case, the telephone switches the
headset operation off.
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Proceed as follows:

e Using the telephone (function key or menu functions > headset)

Function Key for Headset Operation
Press the key to switch headset operation on or off or to switch it over.

In addition the status of the function is indicated by the corresponding LED.

LED signalling on the key:
Green Headset operation is enabled.

Off Headset operation is disabled.

Note: When functions are defined on the second key level (optional, see
Technical Data in the Instructions), LED signalling is not available.

Proceed as follows by assigning the function key:

* Using COMfortel Set by selecting Headset
* Using the telephone by selecting headset

Note: For further information about the general procedures when
assigning function keys, see Function Keys.
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Headset Ringing

During headset operation (headset switched on), three types of call
signalling are possible:

1. Ringing through the loud speaker (as for receiver operation)
2. Ringing through the loud speaker + the headset
3. Ringing through the headset

For the second and third operating mode, headset ringing must be switched
on as described here. For the third operating mode, the ringer must also be
switched off.

Proceed as follows:

¢ Using COMfortel Set (page Settings/functions > Headset, check box
Headset ringing)

* Using the telephone (menu settings > headset > headset ringer)

Headset Volume

Whenever necessary, the headset volume can be used to adjust the micro-
phone amplifier on the connected headset upwards (if your communication
partner cannot understand you) or downwards (if speech is distorted).

Proceed as follows:

e Using the telephone (menu settings > headset > headset volume)
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Note: Press the right or left navigation key to configure the desired
microphone amplifier.
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Menu and Function Keys

Restricted Menu Selection

You can adapt the function menu to your own needs. If you want to only use
some of the functions available, you can hide the remaining functions in
order to shorten the menu selection. Hiding applies only to the function
menu. If the functions in question are also available over a different path,
for example, via the key definition menu or an already defined key, this
remains available.

Proceed as follows:

e Using the telephone (menu settings > user settings > menu
definition)

Exchanging or Moving Function Keys

The definition of individual function keys can be exchanged or moved.

Proceed as follows:

¢ Using COMfortel Set

1. Open the page Function keys > Exchange/move.

2. Click the function key field that you want to move or exchange.

COMfortel 1200 - Firmware V2.2 - COMfortel Set V3.16 - Advanced Information V07 02/2019 349



Settings
Menu and Function Keys

The field is selected.

3. Click one of the following options:

Exchange: Exchanges the selected function key after clicking the target
field.

Move: Moves the selected function key after clicking the target field.

4. Click the target field to which the selected function key should be moved
or with which the function key should be exchanged.
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Service and Maintenance

This section describes useful service functions, among other things. This
includes deleting, saving and restoring data in the case of a malfunction and
the need to exchange the telephone or PBX.

Topics

— Firmware Update (page 352)

— Selecting a PBX (page 359)

— Initiating PBX Synchronisation (page 360)
— Deleting Data (page 361)

— Diagnostic Functions (page 364)
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Firmware Update

When firmware is updated, errors are corrected and new features are
installed. To do this, the device establishes a connection to a server in order
to download the most current firmware (the device settings remain intact).
Except for the charges for the required server connection, the update is free
of charge.

Firmware Update Options

There are different options for handling firmware updates:

Manual Firmware Update via COMfortel Set

During this update, a firmware file (*.rom) is uploaded into the telephone
using COMfortel Set thereby saving the new firmware in the telephone.

Instant Firmware Update via the Update Server

During an instant update, the firmware update is initiated automatically. After
a connection to the update server is established, the server sends the latest
firmware to the telephone. For this, the PBX requires Internet access. The
PBX establishes the server connection to the server.
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Initiating Manual Firmware Update

Proceed as follows:

¢ Using COMfortel Set

Requirements:

* Anexisting PC connection configured correctly in COMfortel Settoa PC
interface on the PBX or another connected system telephone

¢ Knowledge of the required PIN

¢ The firmware file (*.rom) saved on the hard drive

Note: You find the required firmware file on the Internet (Auerswald:
www.auerswald.de/service, FONtevo: support.fontevo.com).

1. Open the menu Service > Write firmware into the telephone....
A file selection dialogue opens.

2. Select the firmware file (*.rom) you want and click Open (this text is
dependent on the operating system used).
The Connection routes dialogue with the devices connected via the
interface configured above opens.

3. Select the telephone on which you want to save the firmware and click
OK.
The PIN entry dialogue opens.

Note: For operation on the PBXs COMpact 3000 analogue/ISDN/VoIP,
COMpact 5010 VolP, COMpact 5020 VolP, COMpact 4000, COMpact
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5000/R, COMpact 5200/R, COMpact 5500R and COMmander 6000/R/
RX access to the telephone is only possible via the 6-digit PIN assigned
in the PBX. You need to first select which PIN you want to enter based
on the authority level: the Admin PIN, one of the subadmin PINs or the
user PIN that belongs to the telephone.

4. Enter the associated PIN and click OK.

The firmware is saved on the telephone. This may take a while.

Further steps:

* In order to use the new features after a firmware update you usually
require a new version of the configuration software COMfortel Set as
well as a new version of the Advanced Information. You can find both
on the Internet (Auerswald: www.auerswald.de/service, FONtevo:
support.fontevo.com).

* In order to use the new features after a firmware update of the
telephone, an update of the PBX firmware is often necessary (see
Advanced Information of the PBX).

Initiating Instant Firmware Update via Update Server

Important: Only available for operation on the PBXs COMpact 3000
analogue/ISDN/VolP, COMpact 5010 VolP, COMpact 5020 VolIP,
COMpact 4000, COMpact 5000/R, COMpact 5200/R, COMpact 5500R
and COMmander 6000/R/RX. On the other PBXs a manual firmware
update can be performed instead.
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Proceed as follows:

* Using the telephone

Requirements:

¢ The PBX connected to broadband Internet access
¢ The address of the update server configured in the PBX

* A DNS server, Gateway and, if necessary, an HTTP proxy server
configured in the PBX

1. Press the Menu key and open the menu settings > synchronisation
> firmware update.

2. Confirm with OK.

The firmware update and a reboot are performed. After this, a message
appears in the display indicating whether the update was successful.

3. Confirm with OK.
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Further steps:

Once you have carried out the firmware update, you can distribute the
new firmware version from this telephone to all the other system
telephones COMfortel 1200/1400/1600/2600 connected to the PBX. If
there are system telephones of a different model, an additional manual
firmware update has to be done.

In order to use the new features after a firmware update you usually
require a new version of the configuration software COMfortel Set as
well as a new version of the Advanced Information. You can find both
on the Internet (Auerswald: www.auerswald.de/service, FONtevo:
support.fontevo.com).

In order to use the new features after a firmware update of the
telephone, an update of the PBX firmware is often necessary (see
Advanced Information of the PBX).

Distributing Firmware

A new version of firmware can be distributed from a system telephone to all
of the other system telephones COMfortel 1200/1400/1600/2600 connected
to the PBX.

Proceed as follows:

Using the telephone

Requirements:

Existing new firmware on the distributing system telephone
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Press the Menu key and open the menu settings > synchronisation
> distr. firmware > immediately.

Press the OK key.

The firmware is distributed. During the distribution process, Server
Mode is displayed on the display panel of the distributing system
telephone. It is not possible to use the system telephone during this
process.

Saving Firmware as File on PC

Proceed as follows:

Using COMfortel Set

Requirements:

An existing PC connection configured correctly in COMfortel Settoa PC
interface on the PBX or another connected system telephone

Knowledge of the required PIN

Open the menu Service > Read firmware from the telephone....

A file location dialogue opens.
Select the directory in which you want to save the file.

Enter a name for the *.rom file and click Save (this text is dependent on
the operating system used).
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The Connection routes dialogue with the devices connected via the
interface configured above opens.

4. Select the telephone whose firmware you want to read and click OK.

The PIN entry dialogue opens.

Note: For operation on the PBXs COMpact 3000 analogue/ISDN/VoIP,
COMpact 5010 VolP, COMpact 5020 VolP, COMpact 4000, COMpact

5000/R, COMpact 5200/R, COMpact 5500R and COMmander 6000/R/
RX access to the telephone is only possible via the 6-digit PIN assigned
in the PBX. You need to first select which PIN you want to enter based
on the authority level: the Admin PIN, one of the subadmin PINs or the

user PIN that belongs to the telephone.

5. Enter the associated PIN and click OK.

The firmware is read out the telephone and saved on the PC. This may
take a while.
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Selecting a PBX

The configuration of the telephone is dependent on the PBX that it is run on.
In order to preconfigure a telephone for operation in another PBX (for
example, for service calls), configure the system to be valid ahead of time.
Ignore the error message and configure the desired presettings using the
COMfortel Set. If you select another PBX instead of COMpact 3000
analogue/ISDN/VolP, COMpact 5010 VolP, COMpact 5020 VolP, COMpact
4000, COMpact 5000/R, COMpact 5200/R, COMpact 5500R and
COMmander 6000/R/RX (or vice versa), the existing configuration is irrevo-
cably deleted.

Proceed as follows:

* Using the telephone
1. Press the Menu key and open the menu settings > synchronisation
> select PBX.

2. Select the desired PBX.

The telephone restarts.

Note: If the wrong PBX is selected, this is detected and an error
message is displayed. If the setting for a wrong PBX is made on purpose
for service reasons, the error message must be ignored.

COMfortel 1200 - Firmware V2.2 - COMfortel Set V3.16 - Advanced Information V07 02/2019 359



Service and Maintenance
Initiating PBX Synchronisation

Initiating PBX Synchronisation

If necessary, you can initiate a complete data synchronisation with the PBX.

Proceed as follows:

* Using the telephone

1. Press the Menu key and open the menu settings > synchronisation
> sync. with PBX.

2. Press the OK key.

Data synchronisation is performed with the PBX.
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Deleting Data

You have the option of deleting individual pieces of data saved in the
telephone. This includes resetting the telephone back to factory settings as
well as deleting charges and personal data.

Restoring Factory Setting

Proceed as follows:

¢ Using the telephone

1. Press the Menu key and enter #201 via the keypad.

2. Confirm with OK to confirm the action.

Note: When operated on one of the PBXs COMpact 3000 analogue/
ISDN/VolP, COMpact 5010 VolP, COMpact 5020 VolP, COMpact 4000,
COMpact 5000/R, COMpact 5200/R, COMpact 5500R and COMmander
6000/R/RX, the PINs remain because the PINs of the PBX are used.
When operated on one of the other PBXs the user PIN will be deleted.

Further steps:

* Put the telephone back into operation. If necessary, refer to the Instruc-
tions.

* Create a new configuration or reinstall the previously saved configu-
ration in the telephone.
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Deleting Charges

The total charges accumulated since the last operation are displayed in the
Information menu. In order to view the charge expenses accumulated
during specified time intervals, you can delete the total charges accumu-
lated from time to time. If you want to prevent anyone from seeing the
charges for your last call, you can also delete that entry.

Proceed as follows:

* Using the telephone

1. Press the Menu key and open the menu functions > del.call charge.

2. Select one of the following options and confirm with OK.
most recent call: Deletes the charges of the last call.

call charge total: Deletes all of the charges accumulated so far.

Note: Neither the total charges recorded in the PBX nor the call data
records are affected by the delete operation.

Deleting Personal Data

You can delete your personal data, for example, phone numbers, messages
and settings based on the function.

Proceed as follows:

e Using the telephone
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1. Press the Menu key and open the menu functions > delete data.

2. Select one of the following options and confirm with OK.
all: Deletes all of the data listed here.
caller list Deletes all of the entries in the caller list.
calls list: Deletes all of the entries in the calls list.
function keys: Deletes all of the function keys that are not blocked.

phone book: Deletes all of the entries in the telephone book on the tele-
phone.

redial list: Deletes all of the entries in the redial list.
scheduled call list: Deletes all of the entries in the scheduled call list.
TAM list: Deletes all of the entries in the answering machine list.

TAM voice memo: Deletes all of the entries in the list of voice memos.

COMfortel 1200 - Firmware V2.2 - COMfortel Set V3.16 - Advanced Information V07 02/2019 363



Service and Maintenance
Diagnostic Functions

Diagnostic Functions

Diagnostic functions can be used to carry out the following tests:

* Line check (BERT)
* Determining the services available in the PBX

Performing Line Check (BERT)
Proceed as follows:
* Using the telephone

Requirements:

¢ Internal phone number (not used by any telephone) additionally
configured in the PBX at the associated S, port

1. Press the Menu key and open the menu diagnosis > ISDN > line test.

2. Select one of the following options:
internal: Performs the line check over the PBX.

external: Performs the line check over the public exchange.

Important: To test a line over the public exchange, the external line to
be tested must be a classic ISDN connection. A line check via analogue,
VolIP or NGN lines will result in an error message, which does not mean
that these connections are defective.
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3. Only when the option external is selected: Under destination number,

enter your own external number, including provider area code, through
which the telephone can be reached.

Important: If you must prefix e.g. an exchange line access number

when entering/selecting a phone number, depends on the exchange line
request (automatic, direct exchange line telephone, internal telephone)
that was configured in the PBX (see Advanced Information of the PBX).

4. Under MSN/name outb. enter the additionally configured internal
number and confirm with OK.

5. Select one of the following options and confirm again with OK.

1 min: The line check (Bit Error Rate Test) is carried out in compliance
with ITU-T 0.150 and 0.151 for one minute.

15 min: The line check (Bit Error Rate Test) is carried out in compliance
with ITU-T 0.150 and 0.151 for 15 minutes.
The line check (BERT) is carried out.

Afterwards, a message is displayed which shows if the line check was
successful or if errors were found. The limit of error is 1076.

Determining the services on the PBX

Proceed as follows:

* Using the telephone

COMfortel 1200 - Firmware V2.2 - COMfortel Set V3.16 - Advanced Information V07 02/2019 365



Service and Maintenance
Diagnostic Functions

1. Press the Menu key and open the menu diagnosis > ISDN > supp.
serv. test.

2. Confirm with OK.

The services test is started. All available services in the PBX are then
marked by B .
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